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-----------------Preface 

This book shows you the methods you can use to transfer 
information between Microsoft Word1 Multiplan} Chart1 and 

File. You will learn many advanced features of the programs that 
make your work easier when you combine the packages~ and the 
paperwork that you produce with your Macintosh will look better 
and take less time. 

If you use two or more Microsoft applications~ you can pass 
data from one program to another. Because you can use the same 
information} you don1t have to retype it each time you want to run 
a different program. 

The Microsoft documentation} however~ does not cover in any 
detail the methods for transferring information among programs~ 

even though most users find this capacity to be one of the best 
features of the programs. This book contains many tricks and hints 
that will help you move data quickly and efficiently. 

Who Should Read 
This Book 

Businesses} both large and small1 use the Macintosh for such 
traditional computer tasks as accounting} personnel record-



keeping, and inve ntory. Multiplan, Word, Chart, and File are 
excelle nt programs for these kinds of business computing, and 
Microsoft's Business Pack (the four programs sold together) is a 
popular method for meeting most of a user's program needs. 

In business, you often need to create memos, reports, and 
presentations based on the data you keep in your computer. You 
often combine data from many sources to produce paperwork 
like quarterly reports, status memos, and financial presentatio ns. 
This book will he lp you take data from all four of the M icrosoft 
programs and produce professional documents. 

Although the book covers Word, Multip lan, File, and Chart, 
you will find the information useful even if you on ly own two of 
the programs. The in-depth coverage of passing data between the 
programs will he lp you to better understand the concepts used in 
the programs, and the examples in t he second half of the book 
will show you many novel applications. 

This book w ill also he lp you if you own some of theM icrosoft 
applications and are not sure whether you wantto buy more. The 
business capabilities of each program are covered in depth, espe­
cially as they relate to t he other programs. By evaluating these 
capabi liti es, you can determine your needs for the other 
programs. 

While this book goes into detail about some of the features of 
the Microsoft applicatio ns, you may want to read more about 
individual applications. Osborne/McGraw-Hill's Macintosh edi­
t io ns of Microsoft Word Made Easy by Paul Hoffman and Multi­
p lan Made Easy by Walt Ettlin give you step- by-step introductio ns 
to these two products. 

Hardware and Software 
Requirements 

The Microsoft applications described in this book run on any 
Macintosh. You can use a 128K Macintosh with a si ngle disk drive, 
but 512K (or larger) and a second disk drive are recommended. If 
you have a great deal of data, a hard disk or a network (such as the 
Macintosh Office) will be very he lpful. This book covers all ver­
sions of the Microsoft programs at the date of printing. 



Organization of the Book 
Part I of the book shows you each of theM icrosoft applications in 
detail and covers all of the methods for passing data between 
them. Chapter 1 is an overview oft he programs and the concepts 
used in connecting them. Chapters 2 through 5 cover Word, 
Multiplan, File, and Chart, respectively. Chapter 6 gives you 
details about how to make your data and text look better with 
MacPaint and MacDraw. 

Part II shows many finished examples that you can create by 
passing data between the programs. These practical business and 
scientific models include reports and memos covering a wide 
variety of data. 

Part Ill contains the appendices. Appendix A covers how to 
use Word, Multiplan, Chart, and File to their fullest extent on a 
variety of Macintosh hardware, and how to use other Apple 
software such as the Switcher with the Microsoft applications. 
Appendix B discusses many other programs (such as Microsoft's 
Excel and lotus' Jazz) that can handle the data you produce with 
theM icrosoft applications. 

When you are finished with the book, you will know how to 
make the task of producing paperwork with your Macintosh less 
time-consuming. You will also be using Microsoft applications 
more efficiently and creatively. 

Paul Hoffman 
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________________ Connecting 
The Applications 

The six chapters in Part 1 review some important Macintosh 
concepts and familiarize you with theM icrosoft products and 

how they relate to one another. Chapter 1 is an overview of the 
Macintosh concept and the design elements that go into all soft­
ware for the Macintosh. Each of the remaining five chapters 
discusses how one Microsoft program can be integrated with the 
others. Chapter 2 discusses Word, whil e Chapter 3 talks about 
Multiplan. The topicofChapter4 is File, and the topic of Chapter 5 
is Chart. Chapter 6 discusses both MacPaint and MacDraw. 

1 
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____________________________________ ()ve~iew 

·-~ Microsoft Word Multiplan 

X 
Before the Macintosh, personal 

computers could exchange data 
between applications programs in only 
limited ways. The Macintosh's ad­
vanced integration capability has pro­
vided new opportunities for develop­
ing fully integrated applications 
programs. Microsoft took advantage 
of this powerful feature to integrate 
Word, Multiplan, Chart, and File. Using Microsoft File> Microsoft Chart 

your Macintosh, you can transfer data among these programs to 
enhance your business productivity. This book explores some of 
the possibilities open to you to get the maximum efficiency from 
these Microsoft products and your Macintosh. 

The Macintosh Concept 
Apple designed the hardware and software oft he Macintosh well 
aware of the problems that microcomputer users faced. The other 
microcomputers in the world (including Apple's) required time 
to learn to use them. In addition, information created by one 
program could not easily be used in others. As the Macintosh 

~ 
Macintosh 

3 
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design progressed, Apple decided to give software companies 
such as Microsoft an easy method for making their software easy 
to use and integrate-a standard user interface. 

The Standard User Interface 

Every program performs a different task, and the computer user 
must learn how to use each one. If the instructions differ from 
program to program (as they often do), learning to use each 
program is a long and tedious job. The more programs you buy for 
your computer, the more commands you are forced to remember. 

Apple decided that the best way to reduce this learning time 
was to design a standard user interface that was easy for every 
software manufacturer to include in its programs. A user interface 
is the method by which software communicates with the user; in 
the case of the Macintosh, the user interface includes the menus, 
scroll bars, and mouse. Each time a program tells you something, 
or you tell the program something, you communicate through 
the user interface. 

You may take the Macintosh's standard user interface for 
granted, but if you've used other microcomputers, you know how 
helpful it is. For example, your word processing program might 
require you to press the1 key to quit the program and the 2 key to 
get help, while your spreadsheet program might require the 1 key 
to get help and the9 key to exit. When you run each program, you 
have to remember which key does what. 

With Macintosh software, you tell a program what to do by 
pressing the Mouse button on a menu title, dragging the mouse 
down to the option you want to execute, and releasing the Mouse 
button. 

All Macintosh programs have menus that are used in the same 
way. For example: 

In addition, many programs, including all of the Microsoft pro­
ducts, also allow you to use command keys to specify some of 



their operations. Holding down the command key (~) while 
pressing another key is often easier than selecting functions from 
the menus. 

All this means ease of use. For example, if you use Word for 
word processing and you buy Multiplan to do spreadsheet calcu­
lations, you will already know how to use many of Multiplan's 
features, since they are invoked the same way in Word. 

The standard user interface goes well beyond the use of 
menus and command keys, but it is not important to enumerate 
all of its advantages here. You should remain aware of it, though, 
so you will appreciate how it helps you learn to use applications 
programs quickly. 

The Clipboard 

Quickly learning to use many applications programs is fine, but 
there is still another major hurdle in using software: getting your 
programs to share data. If you cannot use the results from your 
database program in your spreadsheet program, you haven't used 
your time efficiently. 

Apple designed a method that allows any program to read and 
write data used by any other program. The Clipboard is an area of 
the disk that a program can use to read and write information. If 
you quit a program when there is information in the Clipboard 
and then run another program, the second program can read the 
information from the Clipboard and use it. In this way, programs 
can pass along almost any type of data. 

The Clipboard is discussed in depth later in this chapter since it 
is central to integrating theM icrosoft products. As you learn more 
about the Clipboard, remember that it is useful not only for 
Microsoft applications, but for all applications that run on the 
Macintosh. Appendix B discusses other manufacturers' programs 
that can read and write information in the Clipboard. 

Document Files I . . ~ 
Chad document Word document 

I . 

O verview 5 

n 
~ 

Clipboard File 

Applications programs store data on 
disk in documents. A document file 
may contain text (for a word process- Multiplan document File document 
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ing program such as Word) or pictures (for a drawing program 
such as Chart). However, most programs store data in formats that 
only they understand, so that a database program cannot read the 
text in a normal word processing document. 

Microsoft Word, File, Chart, and Multiplan each have their 
own internal formats for their documents. Word and File, though, 
can write documents in text-only mode, which means that the 
documents they create can be read by ot~er programs. A text­
only document is often not useful to the program that created it, 
since it does not contain any of the special information that the 
program needs to know to perform enhanced operations. For 
example, if you save a Word document in text-only mode, it does 
not contain any information about boldface or underlined char­
acters or special tab sett ings. 

The purpose, then, of text-only documents is to allow a p ro­
gram to write data that can be read by other programs at a later 
time. This is sim ilar in concept to the Clipboard, but text-only 
documents are more convenient than the Clipboard if you are not 
going to use the data immediately. 

Methods for sav ing text-only documents are discussed in 
more detail later in this chapter. Both Word and File store their 
text-only files on disk with this icon: 

iJ -. 
'w'ord text-only 

Multiplan and Chart can write files in a format known asSYLK 
files. These are specially formatted text (ASCI I-representation) 
files that can be used for telecommunication and for transferr ing 
data from some applications (usually from Microsoft) on other 
computers. Although these are text fil es, Word and File cannot 
use the information in a SYLK file. 

The Microsoft Products 
The four Microsoft programs have 
many uses, and some oft heir capabili-

~ 
Microsoft Word Multiplan 

~ 
Microsoft File Microsoft Chart 



t ies overl ap. In addition, each program uses different kinds of 
data, so you need to be aware of how to format your data to move 
it easily from program to program. 

The followin g sections give you an overvi ew of the purpose, 
scope, and type of output of the four Microsoft programs. The 
main featu res o f these programs are discussed in more detail later 
in the book. As you read t hese sections, th ink about different uses 
that you may find for the programs in your norm al work. Because 
each of the programs has many functions, you may trigger new 
ideas about w hat it can do for you. 

Word 

The largest single use of microcomputers is word processing. 

Overview 7 

Because the M acintosh includes a word processing program, Microsoft 'w'ord 
M acWrite, many M acintosh users work with word processing 
before any other application. 

In most aspects, Microsoft Word is a superset o f M acWrite, 
meaning that it performs all of the operations of M acWrite in a 
similar manner, but it has many other advanced features that 
make it a better cho ice than M acWrite for serious business use. 

Consider these features: 

• You can see and edit many parts of a document at the same 
t ime, or you can see and edit more than one document on 
the screen. This makes cross-referencing much easier and 
allows you to see immediately how changes in o ne part o f a 
document affect other parts. 

• The merge capability of Word lets you prepare a form letter 
into which you can insert names, addresses, and other 
information from a mailing list. You can use a File database as 
the source of the mailing list or prepare it in Wo rd. Word's 
merge feature is more advanced than the merge features 
available o n almost all other word processors, in that you 
can include info rmation in the middle of paragraphs and the 
program will reformat the text. 

• The tab styles in Word make tables in reports appear more 
professional and easier to read. You can take tables from 
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Mult;plan 

Multiplan and File and make some of the columns right­
justified (for whole numbers) or centered (for text head­
ings). 

• Most reports have different sections that are formatted dif­
ferently (such as the title and table of contents pages, main 
text, and appendixes). With Word you can format each sec­
tion (called a division) in the style you want. 

• Typing the main text of reports is easier in Word than it is in 
MacWrite, even though they use similar techniques. With 
Word's glossaries, you can avoid typing repetitive phrases by 
using abbreviations and expanding the abbreviations with 
the press of a single key.lfyou don't want to take your hands 
off the keyboard to use the mouse, you can use command­
key combinations. You can also select blocks oftext easily in 
Word. 

You will use Word not only for entering text, but also for showing 
information and resu Its from the other Microsoft programs. 
Word, like MacWrite, can read both text and pictures from the 
Clipboard. Data and charts from File and Multiplan can be used as 
is or enhanced with Word's text-formatting capabilities. Drawings 
from Chart (and, to a lesser extent, from MacPaint and MacDraw) 
can be shown and given elaborate labels in Word. 

Multiplan 

Multiplan allows you to easily perform calculations on numeric 
data and immediately view the results. For example, you could 
instantly figure out your company's total income by combining 
the income from many different sources or determine its future 
value by using growth equations on current income figures. 

Multiplan can work on many kinds of data. For instance, if a 
table contains columns showing sales by department and rows 
representing a period of months, you can perform calculations on 
both the columns and rows, as well as get cumulative totals. You 
can also use Multiplan to perform complex calculations on data 
and see the results of each step of the calculations; this helps you 
check that your equations are valid and in the correct order. You'll 



find that Multiplan speeds up calcul ations so you can easily exper­
iment with hypothetical data. 

When used by itself, Multiplan generates tables th at you view 
by scrollin g around the Multiplan window. You can save parts of 
the Multiplan w indow in the C lipboard or as text-only docu­
ments. This allows you to use Word to format and edit the results. 
And, of course, you can transfer data from your Multiplan spread­
sheets into Chart, graph it, analyze it, and copy the results into 
your Word document. You can also copy Multiplan data directly 
into your File database. 

File 

Most compan ies handle a great deal of numeric data. This data 

Overview 9 

may be re lated to cas h flow (such as costs and income) or concern Microsof~ File 
the company's services or goods (such as inventory). It is common 
to keep customer lists and sales analyses in databases as well as 
personnel records. Any individual comp any has many different 
needs fo r the informatio n it keeps. 

File provides a fair amount of flexibility in how it displays the 
data in your database. You can specify the exact method for 
displaying your records or have Fil e generate reports with totals of 
numeric data. File will also handl e non-numeric data (often called 
text or string data), such as names and addresses, in your 
databases. 

A database can become very large, holding thousands o f 
pieces of informatio n. Instead of having to wade through the 
entire database each time you want to look at a few speci fi c pieces 
of in form ation, you can ask File to find the data for you. For 
example, you can ask Fil e to look through a customer database for 
all people living in Massachusetts. If you want to see w ho in this 
gro up has the largest outstanding invoice, you can sort the in for­
mation in order of amount owed. File selects and sorts informa­
tion to help you fin d what you are looking for; you requ est e ithe r 
operation with on ly o ne command. 

You can use Fi le to generate many types of reports. You can 
select records, sort them, and putt hem on the Cl ipboard, or save 
records in a text-only document for other programs to read. You 
can also write a fu II report that summariz es the data and save the 
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report in a text-only file. Thus, you can use File to collect data and 
format it for other programs, or you can use File to summarize 
large amounts of data and use that summary in other programs. 

Chart 

Computer graphics have become popular in the business com­
munity in the last few years since graphs with a professional 
appearance are easier to analyze and have more visual impact 
than a table of numbers. Graphics software turns a set of numbers 
into a graph or picture that shows what the data" means." 

Chart will produce a wide variety of drawings from the set of 
data you enter. You can customize the charts by adding labels and 
special identifying marks. The data can be entered either while 
running Chart orfrom the Clipboard. You can also scale the size of 
the drawing. 

You will find that there is a tradeoff between the graphic 
depiction of numeric data and the subtleties that become hidden 
by turning numbers into pictures. For example, a pie chart 
showing that each of four divisions of a company earned about 
the same amount may help someone who is looking at the overall 
picture (that each division performed nearly as well) , but it could 
hinder someone trying to tell how the divisions differed (a five 
percent difference would probably not show up in the chart). You 
will probably find that you often label Chart's drawings with the 
data that generated them. The combination of numbers and 
pictures is the best way to depict numeric data clearly. 

Since you can generate the data for Chart in other programs 
(such as Multiplan and File), you will find that it is most often used 
in conjunction with the other Microsoft products. When you use 
Chart with Word, you will most often pass information from Chart 
to Word through the Clipboard. 

Using the Clipboard 
And the Scrapbook 

rn 
~ 

rn 
~ 

Clipboard File Scrapbook File 

The easiest way to transfer information 
from one Microsoft application t o 



another is with the Clipboard. In fact, the Clipboard is the easiest 
way to transfer information between almost any two Macintosh 
applications. Apple designed the Clipboard so that it is useful to 
almost any program; Microsoft took advantage of its features to 
make it especially easy to transfer data from one Microsoft appli­
cation to another. 

This section discusses some of the concepts basic to the Clip­
board and Scrapbook. Being familiar with these concepts will 
make you more proficient at integrating the functions of the 
Microsoft applications. Even if you think you know a great deal 
about the Clipboard, you should at least skim this section. 

Clipboard Concepts 

Basically, the Clipboard holds data. The data can be put in the 
Clipboard by almost any Macintosh program, and data from the 
Clipboard can be used by many programs as well. Programs that 
draw pictures (such as Chart, Mac:Paint, or MacDraw) can put 
pictures in the Clipboard; programs that use numeric data and 
text (such as File, Multiplan, and Word) can put numbers and text 
in the Clipboard. The Macintosh and your applications programs 
will properly distinguish between these types of information 
when you read the data from the Clipboard to another program. 

When you use the Microsoft applications, it is important to 
remember that the Clipboard is used for handling data in the 
program as well as for handling data that will be used by other 
programs. For example, you might use the Clipboard in Multiplan 
to copy part of a spreadsheet from one Multiplan document to 
another, and then use it to copy a different part of the spreadsheet 
to Word. 

Data moves to and from the Clipboard with three commands: 
Cut, Copy, and Paste. 

Cut 3CH -+ 
Copy 3CC 

rn 
~ 

Clipboard Fill' 

-+ Paste 3CU 

Any application that uses the Clipboard, including all of the 
Microsoft applications, always uses these three commands in 

Overview 11 

n 
~ 

Clipboard Fil4? 
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exactly the same way. The commands are usually under the Edit 
menu and almost always use the same three command-key 
combinations as shortcuts for the commands. For example, 
Word's Edit menu looks like t his: 

Search Character 

Undo Typing 3€2 

Clear ai:B 
Show Clipboard 
Show Glossary 

Table 1-1 summ arizes the commands and their command-key 
equivale nts. 

The Cut and Copy commands move information to the Clip­
board. Before moving information, however, you must tell your 
applications program which data you want to move. For example, 
you must select text in your document to put it on the Clip board. 
This is done with selection commands, which you use to select the 
data before giving the Cut o r Copy command. When you select 
information, it usually becomes highlighted (the background 
becomes black instead of white). Table 1-2 shows the items that 
you can select in theM icrosoft applications. 

Cutting selected data removes it from your document and 
inserts it in the Clipboard; copying data leaves it in your docu­
ment and makes a copy of it in the Clipboard. You will never lose 
data if you copy it. 

To insert information that is in the Clipboard into your doc­
ume nt, use the Paste command. The Paste command will insert 
the inform ation in one of these ways, depending on what is 
selected: 

• If there is nothing se le cted in your document, the data in the 
Clipboard will be inserte d at the insertion point. (O n e 
exception: File igno res the insertion point if the data in the 
Clipboard consists of records and instead inserts everything 
at the e nd of the datafile.) 



Table 1-1. 
The Clipboard Commands----------------

Command Key Adion 

Cut COMMAND-X Removes selected data from 
your document and puts it in 
the Clipboard 

Copy 

Paste 

Table 1-2. 

COM MAN D-C 

COMMAND-V 

Copies the selected data from 
your document into the Clip­
board, leaving the data in the 
document 

Copies the contents of the 
Clipboard into your document 

Items That Can Be Selected 
in the Microsoft Applications ---------------

Program 

File 

Chart 

Multiplan 

Word 

Item 

A field (or part of a field) 
One record 
Many records 

A data value 
A group of data 
Text in the Chart window 
A label in the Chart window 
An entire chart (with labels) 

A cell 
Any rectangle of cells 

Any amount of text 
An in-l ine picture (full picture only) 

• If you have made a selection, the data from the Clipboard 
will replace the selected data. This is like deleting the 
selected information first and then pasting the new informa­
tion in its place. 

Overview 13 
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Orig inal 
contents 

Cl ipboard 

Original 
contents 

Cli pboard 

~ Cu t or Copy~ 

Paste 

New 
contents 

Clipboard 

Original 
contents 

Clipboard 

Figure 1-1. -------------------------­
The Clipboard holds only one item at a time 

After a Paste command, the same data re mains in the Clip­
board. You can give anothe r Paste command somewhere else in 
your application, o r even leave the application, and the Clipboard 
will contain the same data. You will see many uses for this feature 
as you read the fo ll owing chapters. 

So far you have seen how to move data to and from the 
Clipboard, but what is in the Clipboard at any given time may be 
unclear to you. The Clipboard has a limitat ion that somewhat 
restricts its usefulness, but at the same time, makes it more predict­
able: There is always only one item in the Clipboard at a time 
(unless, of course, there are no items at all). This is an absolute rule 
that will never be vio lated. 

What it means is that if you store some data on the Clipboard, 
select some other data, and give the Copy command, the first 
iterps are lost from the C lipboard forever. You can think of the 
C li pboard as a tape recorde r: if you record over anothe r record­
ing, the original will be lost. However, you can copy the recording 
as many times as you want without losing it. Figure 1-1 illustrates 
this concept. 



It is important to remember whether or not you have anything 
important on the Clipboard before you give a Cut or Copy com­
mand.lfyou give a command and the Clipboard contains needed 
data, you usually can't get it back. 

(Actually, some programs provide an Undo command that 
allows you to reverse the effects of your last command, for exam­
ple, if you cut or copy information to the Clip board and wipe out 
the old contents. However, each program's implementation of 
the Undo command is different. For example, File won't allow you 
to undo a Cut command if you selected one or more records. In 
other words, don't rely on an Undo command: learn its effects 
first.) 

It would be useful, of course, to know what is on the Clipboard 
before you use a Cut or Copy command that wipes out its con­
tents. For this reason, each Microsoft application has a Show 
Clipboard command in the Edit menu that lets you see the con­
tents of the Clipboard. For safety's sake1 you shou ld probably give 
the Show Clipboard command before giving a Cut or Copy com­
mand. It is also useful to give the Show Clipboard command 
before giving a Paste command, just to be sure that you are 
inserting the correct material. 

Search Character 
Undo Typing 3€2 

Cut 3€H 
Copy 3€C 
Paste 3€U 
Clear 3€8 

Scrapbook Concepts 

There will be many times when you will want to hold more than 
one item in the Clipboard. For instance, you may want to save one 
part of a Multiplan spreadsheet for use in Chart and another part 
for use in Word. Since it is impossible to keep two items on the 
Clipboard, you need some way to juggle them. 

Overview 15 
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The Scrapbook is like an extension of the Clipboard, in that 
you move data to and from the Scrapbook through the Clip board. 
The Scrapbook can hold many items in separate " pages"; like a 
book, each page has a number. The only way to put information 
into the Scrapbook, or get information out of the Scrapbook, is 
through the Clipboard. 

Since the Scrapbook is a Macintosh desktop accessory, you can 
access it whi le you are running any application. While you are 
using the Scrapbook, the Scrapbook transfer program will pre­
vent your other program from operating (you'll notice that most 
of the menu items for your application are dimmed). 

To transfer the information that is in the Clipboard to the 
Scrapbook, first pull down the Apple menu (the menu at the left 
of the menu bar) and select Scrapbook. 

File Edit Search 

Calculator 
Key Caps 
Control Panel 
Puzzle 

A window will open on top of the screen you were working with. 
This window wi ll probably show the data in the first page of the 
Scrapbook. 

0 Scrapbook 

I think I'll remove this sent ence. 

1 /2 TEXT 

If there is nothing in the Scrapbook, the window will contain a 
message such as "Empty Scrapbook" . 



Next, give the Paste command from the Edit menu. This pastes 
the informat ion in the Clipboard into the Scrapbook (not into 
your document). just as with the normal Paste command, the 
information in the Clipboard remains the same after the Paste 
command. The Scrapbook now contains a copy of the Clipboard. 

Scrapbook 

This i s new stuff from the Clipboard. 

1 I 3 TEXT 

It is now easy to see how the pages in the Scrapbook are 
organized. The message in the lower left, which previously said 
" 1/2", now says " 1/3". The first number is the page of the Scrap­
book, and the second number is the total pages in the Scrapbook. 
Pasting a new page in the Scrapbook always inserts the data at the 
current page. Any pages that are after the current data are 
renumbered with a higher page number. You can view th e pages 
by clicking the left and right arrows or dragging the thumb in the 
scroll bar. 

Getting information out of the Scrapbook is just as easy as 
putting it in. If you give the Copy command while the Scrapbook 
is open, the current page is copied into the Clipboard, replacing 
the current Clipboard contents. The Cut command also transfers 
informatio n to th e Clipboard, but it removes the page fro m the 
Scrapbook at the same time. Use the Cut command to move data 
that you no longer want in the Scrapbook. Figure 1-2 shows how 
info rmation is moved into and out of the Scrapbook. 

As you can see, the Scrapbook e liminates the Clipboard's 
major drawback. If you find that you often lose information by 
accidentally wiping out data in the C lipboard that you meant to 
save, you should use the Scrapbook more often. Cleaning out 
old data from the Scrapbook is simply a matter of using the Cut 
command while the Scrapbook is open. 

Overview 17 
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Scrapbook 1 

1¢ O mmm:m::HO ¢1 
1 I 2 

Scrapbook 

Original 
contents 

Clipboard 

Scrapbook 1 

1¢ O:mmm:mmO ¢1 
1 /2 

Scrapbook 

Original 
content s 

Clipboard 

Scrapbook 1 

1¢0::::::::::::::mo ¢1 
1 I 2 

Scrapbook 

Original 
contents 

Clipboard 

Paste 

Cut 

Copy 

Clipboard 
Conten t s 

1¢ O m::mm::::i!CJ ¢1 
1 I 3 

~ Scrapbook 

Original 
contents 

Clipboard 

Scrapbook 2 

1¢ O :mm:m:::mCJ ¢1 
1 I 1 

~ Scrapbook 

Scrapbook 1 

Clipboard 

Scrapbook 1 

1¢ o mumm:mo ¢1 
1 I 2 

Scrapbook 

Scrapbook 1 

Cl ipboard 

Figure 1-2. - -------------- - - - - -----­
Passing data to and from the Scrapbook 



The Scrapbook and Clipboard 
On Disk 

The in formation in the Clipboard and Scrapbook is kept on disk in 
files called Clipboard Fil e and Scrapbook File. These files are 
usually kept in the System fo lder on the disk. When you put data 
in the Clipboard or Scrapbook, there must be e nough room on 
the disk to hold the new data. If you don't have mu ch room o n a 
disk, you may not be ab le to put a large selection into the Clip­
board. Of course, copying lots of data into the Scrapbook, or not 
clearing out o ld data, can fill up a disk as well. 

If you use some of the methods described in Appendix A for 
saving space on disks or using other types of disks, the Clipboard 
or Scrapbook files may e nd up on other disks. If you are using the 
Microsoft disks in their normal fashion (that is, booting off the 
master disks), the Maci ntosh will t ransfe r the Clipboard and 
Scrapbook fil es as you start each application. If you are using 
other disks for booting, see Appendix A for hints about moving 
the Clipboard and Scrapbook files as you boot each application. 

Storing Data 
In Text-Only Files 

The Clipboard and the Scrapbook are the most convenient 
methods for transferring information between the Microsoft 
applications. There are times, however, when using the Clipboard 
is inconvenient or even imposs ible. In these cases, you should 
save your data in a text-only file. 

Most applications have two forms of documents that they can 
read: normal, or preferred, documents and text-only doc­
uments. Some applications, such as MacPaint and Chart, can read 
only preferred documents. When an application reads a pre­
ferred document, it can get all of the special information that the 
program normally saves, such as formatting or special data att rib­
utes. A text-only document, on the other hand, does not contain 
formatting o r special informatio n. For this reason, data read from 
a text-only docume nt e nds up with no special features and will 
probably look very plain next to output from a preferred doc­
ument. 

O verview 19 

Diskette 

iJ -. 
Word text-only 
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You will use text-only documents when you are transferring 
information from a Microsoft application to a non-Microsoft 
application. For instance, you may be using a database manage­
ment system (DBMS) other than File. Most DBMS's available for 
the Macintosh can read data from text-only documents; so inte­
grating the other Microsoft products with a non-Microsoft DBMS 
is fairly easy if you use text-only files. 

You may be able to use data from the Clipboard instead of 
text-only files with some non-Microsoft applications. However, 
these programs may expect the data to be in a different format 
than Microsoft's, so you wi ll often get more predictable resu lts 
using text-only files. 

Only Word and File can write text-only files.Ifyou want to pass 
the text-only version of a Multiplan file to another program, you 
must follow these steps: 

1. Select the part of the spreadsheet you want to save. 
2. Copy it to the Clipboard with the Copy command in the 

Edit menu. 
3. Quit Multiplan and run Word. 
4. Paste the data fromtheC iipboardwith the Paste command 

in the Edit menu. 
5. Save the data with the Save Only command in the Fi le 

menu. C heck the Text Only button before saving the file. 

Figure 1-3 summarizes the methods you can use to pass informa­
tion between the M icrosoft applications. 

Format of Text-Only Files 

Although it is not necessary to understand the internal format of 
text-only files, it is, fortunately, quite simple. Knowing how to 
make your own text-only files wi ll be useful if you use Word or if 
you need help integrating M icrosoft applications with non­
Microsoft applications. 

Basically, the information in Microsoft text-only fi les looks 
very similar to the information you see on the screen when you 
run an application. The vertical lines that separate the columns in 



your application are replaced by tab characters in your text-only 
file. A tab character is the character that you create when you hit 
the TAB key on the keyboard. Each line ends with a carriage-return 
character. 

For instance, if you save four records that each have three 
fields from a File database in a text-only file, each row of informa­
tion in the file will have a tab character between the first and 
second columns and another tab character between the second 

Word File Multiplan 

Cl i pboerd Clipboard 

Overview 21 

Chert 

Word & & Clipboard 
Text-only Text-only 

Clipboard 
File Cl i pboerd & Cl i pboerd 

Text-on ly 

Multiplen Cl i pboerd Clipboard 

Chert Clipboard Clipboard Clipboard 

figure1-3. ------------------------­
Passing info rmation between Microsoft applications through the 
Clipboard and text-only fi les 
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and third columns. The character after the third column is a 
carriage-return character. 

With this information you can create your own text-only files if 
necessary. For instance, you can type a table in Word by separating 
each column with the TAB key. If you save this file as text-only, you 
can use it in any place that a text-on ly file is required. Other word 
processing programs on the Macintosh, such as MacWrite, can 
also create and use these files. 

~ 
~ 

How the Microsoft 
Programs Relate 

Multiplan.H~lp Fil~ .H~lp 

This chapter has presented an over-

view of how you can transfer informa- [Ja. [?j?·.· 
tion between Word, Multiplan, File, lJ.il 
and Chart. The next step is to recog- Chart.H~lp Word.Hl'lp 

nize the types of data you will be han-
dling. Since the programs can handle a wide variety of data, the 
information that you pass between the programs will also vary. 

Remember that the meaning and content of the data that you 
transfer between programs depends on you, not on the programs 
or the method you use for transferring the information between 
them. For instance, if you use Multiplan for what-if calculations, 
the information that you pass to Chart is the result of your assump­
tions, not of real data. This turns Chart into a what-if tool too. 
Simi larly, if your File mailing list contains computed fields that are 
used in your Word form letters, you are real ly using Word as a 
word processor that can compute. 

Although this may seem esoteric, it is essential for getting the 
most out of the Microsoft applications. The applications are just 
tools for your projects. The fact that you can transfer data back 
and forth between the applications is not as important as the way 
that they read each other's data. 

The next four chapters cover each of the program's capabili­
ties. These chapters have many goals. First, if you already use the 
program, the information will help you focus on the features that 
you will use in combination with the other programs.lfyou don't 
already have the program, you can see what sort of tasks it 



performs so you can follow the rest of the book. Each chapter also 
contains general examples of how the application can be used 
with the others. There is also a chapter on MacPaint and MacDraw 
to show how these versatile tools can enhance the presentation of 
data from the other programs. 

Overview 23 
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___________________________________ VVord 

Businesspeople spend a great deal of time communicating 
with co-workers, managers, and clients. While written reports 

and memos often must substitute for face-to-face discussions, 
many people find the writing process to be the most frustrating Microsoft 'w'ord 
part of their work. 

For example, your monthly sales report might include 
information from several sources: actual month-to-date figures 
that your assistant collects daily in a simple spreadsheet model; 
the budgeted sales that were prepared six months ago in a dif­
ferent spreadsheet model; and the shipping department's list of 
the number of returned products by category. The text of your 
report needs to include these exact figures. Furthermore, since 
you didn't make budget, you decide that a graph comparing 
this month's sales to the first quarter's sales would visually dem­
onstrate the progress of your department. In this example, 
much of the information you need for your report already 
exists-but it's in different places and different formats. Gather­
ing and presenting it in a single document could be a tedious 
process. In addition, the mechanics of writing are time consu­
ming: typing complex names and phrases over and over, look­
ing up addresses and proper spellings, and locating a document 
that used the exact phrasing you need to insert-all these tasks 

25 
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Word document 

make writing more difficult than it has to be. 
Microsoft Word-especially combined with Multiplan, File, 

and Chart-can help take some of the pain out of writing in a 
number of ways. Some of Word's features are advancements 
over basic word processing programs -for example, Word 
makes entering and moving text simpler, allows you to see var­
ious parts of your report at once, and even lets you work with 
other documents you've written. In addition, Word lets you 
incorporate data from the other Microsoft applications directly, 
saving you time in transcribing spreadsheet data, creating 
tables, and presenting charts. Since most of your work with 
Multiplan, File, and Chart results in information that will be 
transmitted to other people, you will find that the ability to 
transmit data to Word and include it in memos and reports wi ll 
greatly simplify the writing process. 

These features make Word the central program of the 
Microsoft applications. Being the central program does not 
mean that it is the most important of the applications, though, 
only that it will be used most often to show the results of the 
other programs. You will also use Word with the other pro­
grams. As you will see later, you can use Word to add a few 
explanatory sentences to a graph from Chart, to a spreadsheet 
from Multiplan, or to data from File. 

Features 
For Writing Reports 

Most of the examples in this book will show you how to 
transfer data to Word from other Microsoft applications. First of 
all, though, you should become familiar with Word's special 
report-writing features, since you will probably be using this 
application the most. The following section focuses on the fea­
tures o.f Word that are different from MacWrite. 

Split-Screen and Multi-File 
Editing 

If you are writing a long report, you will probably want to refer 
to earlier sections. You may also want to look at an old memo 
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or report but don't have a copy of it, or you may want to 
transfer text from one document to another. Word gives you 
these capabilities. 

The split bar, at the top of a Word window, is used to see 
two views of a document as you edit it. 

., 

, 
By dragging the split bar down the screen you get two separate 
views of a file (see Figure 2-1). Each view of the file can be 
scrolled with its own scroll bar and thumb. (By the way, this is 
very similar to the split bars in Multiplan, as you will see in 
Chapter 3.) 

r • File Edit Search Character Paragraph Document 

January 11, 1985 

Chris Richford, Vice President 
Manufacturer's Bank of the Northeast 
1000 First A venue 
Millerton, CT 06492 

Dear Ms. Richford : 

I am pleased to send you the latest update on the results of our expanded 

Sincerely, 

Figure 2-1. 
Two views of one fil e 

Thomas Mead, Controller 
National Generators 
1275 Oak Glen Industrial Park 
Oak Glen, CT 064 10 

., 

:: • 
' 
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Alignment -
+® Left 
"'0 Center 
+ 0 Right 
.j; 0 Decimal 

Word also allows you to e dit as many as four separate files at 
once in separate windows. To do this, simply give the Ope n 
command from the File menu. Each fi le opens a separate win­
dow that can be sized and moved around. To switch from win­
dow to window, you simply click in the window that you want 
to work in. Figure 2-2 shows two fil es being edited at once; the 
top window is active. 

These two features of Word make the typical writing job 
much easier. Since many business writing tasks involve either 
reviewing or revising material that was previously written, be ing 
able to see the original materi al as you write and lift sections 
from it makes w ritin g new re ports and memos much quicker. 

Advanced Table-Making 
With Tabs and Leaders 

Tabs 

,Leader- n OK 
®Blank 
0 ......... ( Cancel 

0 ----- Position: 

0 -- I 

D 
l 

I 

Creating tables is another tedious 
writing chore that often slows you 
down. You can create tables much 
faste r with Word than with MacWrite 
and have mu ch more flexibility in 
the way you show data, because 
Word's handling of tab characters is 

mu ch more advanced than MacWrite's. The major improve­
ments are new types of tabs and leade r characters; they are 
described here and shown again later in the chapter. 

The re are four types of tabs in Word: left, right, centered, 
and d ecimal. You are probably familiar with left and decimal 
tabs from MacWrite. In Word you use a right tab to align the 
last digit of a number to the right of the tab stop. A centered 
tab centers the text around the tab stop. 

The tab is set here -->1 

This is a left-aligned tab 
This is a center-aligned tab 

This is a right-aligned tab 

Decimal tabs: 
$9327.44 

12 .0 

The tab is set here -->1 
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• File Edit Search Character Paragraph Document 

§0 Sample 1 

January 11, 1985 

!if£~l~IJ:~::~~s~:~~r~east I 
n,..,. ,.. J..Ae o; ,.. ,..,r,... .. A . 10 

Page 1 1¢ [ ] iiiiiiiiil!iii!iiiiiiiiiii!iiiiiii!iliiHiiiiiiiiiiiiiiiiiii!iiiiiii:iiiiiiiiiii:i:iiiiiiiii:i:i:i:iii:::m::::m::m::m:mm:::i!Hiiiiiiiiii!:i:Wii!iii:i:ii\iiid 0 12 
Hepon 1 

From: Sandra Phillips 
To: Thorn Mead 
Re: Summary of annual figures 
Date: January 4, 1985 

Here are some preliminary figures on the company; I'U have complete totals 
early next week. 

t 1 7 <;()() () () () 

Figure 2-2. ---------------------- ----­
Editing two different files at once 

Using decimal tabs makes tables of numbers muc h easier to 
read, especially if the numbers are summ ed at the bottom of 
the table. Center tabs are useful in column headings. 

In addition, you can use leader characters to fill the space 
between text and tab stops to create easy-to-read tables. For 
instance, many tables of contents have a line of dots, called 
leader characters, between the chapter titles and page numbers. 
Word lets you use leaders of dots, dashes, or und erlines. If you 
don't specify a leader character, Word assumes you want 
blanks. The following table shows the three types of leaders: 

Leaders: 
Dots .......... ............. l 23 
Dashes--- ----- -1 2 3 
Underlines __ l2 3 

Using leader characters can make a table with wide columns 
much clearer, since the reader is not straining to match up the 
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i ---
Standard Glossary 

columns. Although dots are the most commonly used leader 
characters, you can experiment with dashes and underlines to 
find the leader that is the most readable for your purpose. 

Glossaries 

Particular words, names, and phrases will probably recur through­
out your business writing. For instance, the name of your com­
pany or certain phrases and people's names may appear dozens 
of times in a report. Typing these each time you use them is 
tedious and prone to error, especially in the case of long names 
and complex spellings. 

Word's glossary feature lets you type in an abbreviation and 
then replace it with a full spelling of the word by pressing 
COMMAND-BACKSPACE. You specify the abbreviations and what 
they stand for with the Show Glossary command in the Edit 
menu. You can create a glossary for each report or type of 
report you write. 

Suppose that you are writing a report about a company 
named International Generators, Inc., and its new product, the 
Model NSTURBO. You could make an entry in the glossary 
equating 11 ig" with "International Generators, Inc." and 11 nS" 
with 11 NSTURBO." You can then simply type "ig" or 11n5" fol­
lowed by COMMAND-BACKSPACE, and Word replaces " ig" w ith 
"International Generators, Inc." and "nS" with "NSTURBO." 

Multi-Column Output 

Word can format your text into two or three columns on a 
page. If you are preparing a company newsletter or flyer, this is, 
of course, much simpler than using scissors and glue. To specify 
multi-column output, select the Division layout command in 
the Document menu. The two choices you see in the lower­
right corner are 

Number of Columns: I• 
Column Spacing: Fl 0=.5=,=, 9 

Although Word will print multi-columns, they will not show 
on the screen. You have to print your document to see how it 



looks. Figure 2-3 shows part of a page that is formatted with 
two columns. 

Mail merge 
Word's mailmerge feature lets you create custom form letters 
and memos, inserting variable text and data wherever you spec­
ify. Because you can directly access the databases that you have 
already created with File, Word gives you great fl ex ibility and 
speed in creating form documents. As this capability is a very 
powerful business produ ctivity tool, you' ll look at it in detail in 
t his section. 

I . -+ I ~ 
'w'ord document File document 

Word's merge feature is fairly simple. Your main document is 
the letter or memo you want to send and has special place 
ho lders (fields) for the parts that change from letter to letter 
(like the recipient's name and address). Your datafile contains 
the information that Word puts into the f ields in the main doc­
ument; all the fields for each letter are on one line of the data­
file. You can create your datafile in Word, but if you are work­
ing with many variables, you w ill find it much more convenient 
to take information directly from your File databases. 

Your main document tells Word which file is the datafile. 
When you print your fi le with the Print Merge command in the 
File menu, Word reads the first record from the datafile, su bsti­
tutes the fields into your main document, formats your letter, 
prints it, reads the next record from the datafile, and so on. You 
can have as many as 256 fields in a letter, as long as each field 
matches the information in the datafile. 

If you include fie lds in the middle of a paragraph, Word will 
reformat the paragraph with the new information in it. (Few other 
programs will reformat the paragraph after putting in the new 
information.) Thus, i f a field called Amount contains two-, t hree-, 
or four-digit numbers, Word adjusts the spacing for each and 
reform ats t he paragraph if necessary. For examp le, if 

Word 31 
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Klcerpts from a Proposal for 
Bant Fundina 

L. Introduction 

National Generators has the 
opportunity over the next five 
years to take a commanding lead 
in our established markets and to 
penetrate a new market, the 
construction industry, where our 
products will be particularly 
attractive. This report is intended 
to provide an overview of the 
company"s business development 
strategies along with a description 
of those areas for which we 
require funding. 

National Generators can 
become the premier producer or 
electrical generation equipment for 
the entertainment and exposition 
industries. Our portable yet sturdy 
generators have acquired a solid 
reputation in these fields. As the 
number of outdoor concerts, large 
conventions, and other events that 
use portable generators continues 
to increase each year, we will be 
better able than our competitors to 
satisfy the demand for reliable 
equipment. 

While accelerating efforts 
aimed at our eJisting base of 
industrial users, we propose to 
enter the construction industry. 
We have already begun developing 
a small, quiet generator for this 
market. Research is also under way 
to design a larger, more efficient 
generator for heavy construction 

Figure 2-3. 
Word printing in two columns 

projects that can replace several 
smaller ones. 

!!.. Martel Analysis 

National Generators 
currently has a 42\ share or the 
markets we now serve. Our nearest 
competitor, Regional Outdoor 
Electricity, has 34\, with the rest 
divided among other 
manufacturers. We believe that 
our superior products wilJ ensure 
that we will increase our share of 
sales to the entertainment and 
exposition industries. Some of our 
competitors wilJ be unable to 
match our new technology, and we 
will pick up their business. 

OVer the nell five years, we 
anticipate gaining 15\ of the 
market for generators in the 
construction industry. I Two 
important trends favor our 
planned new products over any 
now available or known to be 
coming on the market. Anti-noise 
pollution legislation restricts the 
level or noise at urban construction 
sites, while OSHA legislation 
protects workers from damage to 
their hearing caused by 
equipment. 

Ill. Eipan1ion Costs 

t Based on trends and growth in the 
construction industry, detailed in 
U.S. Department of Labor 
projections for 1985-1990. 



one record of your datafile contains the number 1553, Word 
w ill reformat a paragraph containing the sentence "You sti ll 
owe us $1553, which we wou ld like you to send immediately." 

You can include the fields in you r main document in any 
order you want; the order of the fields in the datafile is 
unimportant. 

Setting Up Your Letter 

There are two types of special text in a Word main document. 
Field names are the names you give the fields in the datafile; 
instructions are special commands that tell Word what to do. All 
special text in Word is enclosed in double-angle brackets; for 
example: 

«DATA Payment 1 Data» 

These are typed as OPTION- \ and OPTION-SHIFT- \ . 

The first instruction you need to know is the DATA instruc­
tion, which tells Word where the datafile is. This instruction 
appears at the beginning of your main document. For example, 
if your datafile were called "Payment 1 Data," your main docu­
ment wou ld begin with 

«DATA Payment 1 Data» 

The fi les of most letters contain on ly a DATA instruction and 
fie ld names in addition to their text. Figure 2-4 shows a simple 
letter that informs customers of the balance due. The fields are 
"company", " name", "address", "city", "state", "z ip", "amount", 
and " last-payment". Note that you can use a field more than 
once in your main document; the field " name" is used twice in 
this letter. 

As Word reads through your datafile, it fi lls in the fields in 
the main document to produce a letter. Figure 2- 5 shows a 
sample letter produced by the main document in Figure 2-4. 

Setting Up Your Datafile 

[i . 
. I . 
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1he first record in a datafile is the 
header record, which lists the field 
names in the order in which they 'w'ord document File document 
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,. * File Edit Search Character Para 

«DATA Payment I Data» 

«Company» 
«name» 
«address» 
«City», «State» «Zip» 

August 15, 1985 

Our records show that your outstanding balance is $«amount», and that we 
have not received any payment from you since «last-payment>>. If there is a 
disagreement about this, please feel free to call us about it. 

Sincerely, 

Sharon Myers 
National Manufacturing 

., 

Figure2-4. -------------------------------------------------------­
Example of a main document 

Industrial Mining Co. 
Michael Townsend 
P. 0. Bo1 4110 
Cambridge, MA 02139 

Dear Michael Townsend: 

August I~. 198~ 

Our records show that your outstanding balance isS 127.53, and that we 
have not received any payment from you since 7/21/84. If there is a 
disagreement about this, please feet free to call us about it. 

Sincerely, 

Sharon Myers 
National Manufacturing 

Figure 2·5. 
Sample letter fro m main document in Figure 2-4. 



appear in all of the records. This record is followed by your 
data records. The format of the header record is simply a list of 
the field names separated by commas. For instance, the first 
record in the Payment 1 Data file for the main document in Figure 
2-4 would be as follows: 

company, name, address, city, state, zip, amount, last-payment 

The data in the file can be separated by either commas or tab 
characters (a file using tabs is called tab-delimited). Since File 
saves a tab-delimited file for you, the following discussion 
assumes that your file is tab-delimited. 

It is often a good idea to create the main document in Word 
before saving your data from File, so you can be sure that you 
are including all the data you want. Use the following steps to 
create the datafile for a Word merge document from a File 
database: 

1. Be sure that the fields in the form match the fields in 
your main document. If you do not want to use some fields in 
your main document, you can put them in the hide area. 

2. Decide the format you want for each field. If you want 
numbers to be entered in your main document as numbers, 
you must use the General format and not include commas. If 
you select Dollar, Percent, Decimal, or Scientific, or use com­
mas, the numbers will be passed to Word as formatted text. 
(You will see shortly why it is advantageous to pass numeric data 
as numbers, not formatted text.) 

3. Use the Find command in the Organize menu to select 
the records you want to include. If you want, you can also sort 
the records; this may be useful for different reasons, for exam­
ple, saving postage costs by sorting and then bundling mail by 
ZIP code. 

4. Be sure that the Form window is closed. Give the Save 
Records As . .. command in the File menu. You will see the fol­
lowing dialog box: 

Saue 1\ecurds As: 

@ Normal 
0 TeHt (Microsoft Print Merge) 

Hard Disk 

C ~u cm ll 
[ Cancel ] 

Eject 

Or iiH~ 
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Enter the file name you want (this will be the same as the name 
you gave in the DATA instru ction in your main document). Be 
su re to click t he Text (Microsoft Print Merge) button; then click 
t he Save button. 

Fil e will save the header record using the names that you 
spe cify in the form. Note that if the names in the form contain 
spaces, the results will be unpredictable when you merge the 
file; so be sure that the form uses the names you specify in the 
main document. 

Your File data will be saved in a format compatible with the 
rules fo r Word. (The datafil e th at Fil e creates is a text-only file, 
so you can also use it with applications programs from other 
manufacturers.) However, Fil e will not save any of the fo rmat­
ting of th e text fie lds (su ch as bold or underline sty les and any 
font information) . Also, File will not save pictu re fields. 

Up to this point, you have seen how to set up a datafile 
containi ng the header record. However, if you are using d ata 
from a source that cannot write o ut the header record, you can 
use a separat ed datafile. A separated datafile is actually two 
files: one containing only the header record, and one contain­
ing only the data. If you use a separated datafile, the DATA 
instruction must te ll Word whe re both files are. You simply give 
both n ames, which are separated by a comma. Thus, if your 
header record is in the Payment 1 Head file and the data is in 
Payment 1 Data, the Data instruction in your main document is 
changed to 

«DATA Payment 1 Head, Payment 1 Data» 

Using a separated datafile might be useful to you in two 
situat io ns: if you are usi ng a database manager other than File 
to create the data, or if you are saving File records on the Clip­
board instead of a text-only fil e. If you are using a non­
Microsoft product to create t he data, a separated datafile allows 
you to avoid creating a unique header record. 

The re is no advantage to using the Clipboard to create your 
d atafile when using Fil e. Other database management systems, 
however, may not be able to write out th e text-only file. The 
fo llowing steps show how to use File to create the datafile fro m 
the Clipboard; other programs are pro bably similar: 



1. Select the records in File by clicking in the record 
number bar. You can select a group of records either by drag­
ging in the record number bar or by selecting the first record in 
the group you want to select and then shift-clicking the last 
record in that group. 

2. Give the Copy command in the Edit menu. After you 
have copied the records into the Clipboard, you can check 
what you have done by giving the Show Clipboard command in 
the Edit menu. This wi ll t ell you how many records you just 
copied. 

3. Quit File. If you have selected a large number of records, 
you may see this dialog box: 

IE Sauing large clipboard 

[81 Saue Formatted Ualues 

D Saue Unformatted Ualues 

(Cancel) 

Be sure to click the OK button. 
4. Run Word by clicking on its icon. This will open up a 

new file window. 
5. Paste the contents of the Clipboard into the window with 

the Paste command from the Edit menu. 
6. Save this fil e as the datafile you specified in your main 

document. 

Integrating Information 
From Other Files 

So far you have seen how to use the merge feature of Word to 
produce form letters and memos. You can also use the merge 
INCLUDE instruction to read inform ation from another file. 

The INCLUDE instruction causes Word to insert the contents 
of a fil e into your output. You can use it to include new infor­
mation in your output without having to change your main 
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document. Suppose, for example, that you send a weekly status 
report to many people. The report is in a file called WEEKLY 
MEMO and contains fields for the recipient's name and mail­
stop, a standard heading, and some information that changes 
from week to week. You could alter the WEEKLY MEMO file 
each week before you merge it, but this would be tedious. A 
better method is to use the INCLUDE instruction. 

The format of the INCLUDE instru ction is similar to the DATA 
instru ction: INCLUDE followed by a file name. For instance, if the 
text that changes is stored in a file called New Weekly Info, your 
INCLUDE instruction would look like this: 

«<NCLUDE New Weekly In fo» 

Figure 2-6 shows the Weekly Memo fil e. 
The file that you include can be any text file. As in the case 

of the memo in Figure 2-6, it might be a text fi le that you 
created in Word. It could also be a text-only fil e created by File 

,.. eJ File Edit Search Character Paragraph Document 
., 

«DATA Company Mailing Data» 
«name» 
«department>> 
«mailstop» 

Weekly status report 

«INCLUDE New Weekly Info» 

If you have any questions, please call Melissa Embers at x3- ll 02. 

Figure 2-6. -------------------------­
Example of the INCLUDE instruction 



or Multiplan. For example, if you created a table of weekly sales 
figures in Multiplan that you want to include in a memo, create 
the table in the other program (File or Word) and save the text­
only version in a file with the same name as that in the 
INCLUDE instruction. 

Other Merge Instructions 

A unique feature of Word that makes your letters look even 
more personalized is conditional insertion. Word allows you to 
check the values of fields in each record and insert different 
text depending on the values of the fields. For instance, if the 
Amount field is over 1000, you can insert a sentence describing 
the dire consequences of not paying promptly. Or your File data­
base might include a field called Regular Customer that 
contains "Y" or "N"; you can use this to decide what type of 
salutation to include in the letter. In other words, you can 
compare a numeric field to a value specifi ed in your main doc­
ument, or you can test a text field against a specified string. 

The main document in Figure 2- 7 contains an IF instruction 
used with a text field. The IF instruction checks the value of the 
"sales- rep" field and prints one of two possible sentences, 
depending on whether "sales-rep" is "none" or some other 
value (the sales rep's name). 

The IF instru ction can also be used to check whether there 
is anything in the field or not. For example, the following 
instru ction determines whether there is any value in the 
"owner" field: 

This prints out the contents of the "owner" field if it exists, or 
the phrase " Store Owner" if it does not. 

You can also use the IF instruction with integer fields to test 
whether a number is greater than, less than, or equal to a field 
va lue. Such a test cou ld be used, for example, with a field 
"cust-years," the number of years a customer has been with 
your firm. If" cust-years" is greater th an a certain amount, you 
might include the following sentence in a letter: 

«IF cust -year s>5» We value your long-standing relationship.<<ENDIF» 
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h Document 
., 

«DATA Payment 2 Data» 

«COmpany» 
«name» 
«address» 

August 15, 1985 

«City», «State» «Zip» 

Our records show that your outstanding balance is $«amount», and that we 
have not received any payment from you since «last-payment». «IF sales­
rep="none"»Our accounts receivable manager, Holly Watson, will call you 
about this.«ELSE»Your sales representative, «Sales-rep», will call you about 
this.«ENDIF» 

Sincerely, 

Figure 2-7. --------------------------­
Example of the IF instruction 

This brings up a few salient points about the interaction of 
File and Word. Remember from before that the formatting you 
use for number fields is important. You must use the General 
format with no commas if you want to use the IF test on a 
number. Also remember that you can hide fields in File that 
you do not want to save in the new dataset, the set of data you 
are creating. As an alternative, you can include these fields in 
the datafiles and simply not use them in your main documents 
if that is easier than hiding, saving, and then un-hiding them. 

The merge feature has a number of options that you can 
use; these are listed in Table 2-1. Three-SET, ASK, and NEXT­
may be new to you. The SET and ASK instructions allow you to 
enter information when you print. The SET instruction sets a 
field once for all letters, while the ASK instruction prompts you 
for a new value for each record. You can also create your own 
prompts with the SET and ASK instructions. 

The NEXT instruction is used for reading a number of 



Table 2-1. 

Merge Instructions in Word -------- -------

Instruction 

ASK 

DATA 

IF ... ENDIF 
or 

IF .. . ELSE 
... ENDIF 

INCLUDE 

NEXT 

SET 

Use 

Has Word prompt you to fill in a field when 
each letter is printed 

Identifies the datafi le 

Conditionally inserts text if a field in the 
datafile has a particular valu e. You can use the 
=, >, and < operators for numeric fields or the 
= operator for string fields 

Inserts another Word file into the main document 

Has Word read the next record in the datafile 

Sets the contents of a field or has Word prompt 
you for the value once at the beginning of 
printing 

records from a file into one letter; it is usefu l o nly for reading 
groups of related records together. For example, if a File data­
base has a pair of records for each client (such as highest and 
lowest bids on a job), and t hose records were sorted so that 
each set was a properly ordered pair in the datafile, you would 
use the NEXT instruction to read the second record into the 
letter. 

Further Applications 

As you can see, the merge capability of Word has wide-ranging 
applications. Some other examples are 

• Sending letters that suggest clients upgrade their current 
position (for example, purchase more insurance or a bet­
ter model, o r make a bigger investment). These would use 
complex IF instructions with lists of the different current 
positions and the next steps. 

• Targeting parts of letters by ZIP code. For instance, you 
can use known attributes of certain ZIP codes or ranges of 
ZIP codes to trigger messages about the nearest sales office. 
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• Inter-office memos that include information based on the 
interests of the person receiving the memo. Your File data­
base could include yes/no check items relating to the 
committees on which the person serves and include 
information about only those committees. 

Pasting Drawings From Chart 
Word acts just like MacWrite when 

~ you paste a picture from the Clip-
~ board into a memo or report. Using 

'w'ord document the Clipboard is the only way to 
include drawings from Chart in a 

Word document, so you should be familiar with some of the 
considerations of using Chart drawings in Word. 

Microsoft Chart 

Both Word and MacWrite consider each picture to be a 
paragraph; each paragraph must start and end on a new line. 
Thus, you cannot wrap text around the sides of a Chart draw­
ing. You can, however, move the picture around in your Word 
document and shift it left or right on the lines that it occupies. 
When you select a paragraph, Word highlights it; when you 
select a picture, Word surrounds it with a box: 

To move a picture up or down, you can change the number 
of lines before or after the picture by selecting the picture and 
giving the Formats ... command in the Paragraph menu. You 
see the following dialog box: 

Porogroph Formats 

left Indent: 1~1 line Spacing: I auto I n OK ]) 

First line: ~ Space Before: 11 li \ ( Cancel ) 

Right Indent:~ Space Rfter: I o li I 
II@ Left 0 Right I I D Keep with neHt '11 
II 0 Centered 0 Justified D Keep lines together 



Change the number of lines before or after to add the correct 
amount of white space to the picture. 

You move the picture left or right by dragging on either of 
its sides. For instance, to pull the picture to the right, point at 
the right border. Now click and drag the picture to the desired 
position. 

You can also resize the picture by dragging on one of the 
squares and stretching in any direction. However, you will 
notice that this often distorts patterns and letters in an unnatu­
ral fashion. 

Instead of resizing the picture in Word, you can have Chart 
save the picture on the Clipboard in various sizes. When you 
select the drawing and give the Copy command in the Edit 
menu, Chart prompts 

Copy Chart to Clipboard 

® As Shown on Screen 
0 As Shown when Printed 

OK Cancel 

Choose to save the picture as it would be printed. Chart then 
saves the picture proportioned for printing. 

The trick to getting the picture larger or smaller is to use the 
Page Setup command in the File menu before copying the pic­
ture to the Clipboard. Chart uses the size of paper that you 
select to determine how big to make the drawing and in what 
proportion for printing. For example, A4 paper is bigger than 
81/2 X 11-inch paper, legal size is bigger than A4, and so on. 
You can experiment by copying a number of different-sized 
charts through the Clipboard to the Scrapbook, quitting Chart, 
ru nning Word, and then pasting them into a Word document 
and printing it out. (In fact, because of a bug in many versions 
of Word, you must copy the drawings to the Scrapbook first.) 

You will notice two things: the text labels almost always 
look incorrect, and pie graphs do not look round. You can fix 
the text labels by reading the drawing into MacPaint or Mac-
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Draw first and removing all of the misproportioned labels and 
adding new ones. If the drawing is bigger than the MacPaint 
window, you will have to paste it in pieces, which is tedious. 
Unfortunately, there is nothing you can do about the un­
circular pie graphs. 

Formatting Tables 
From File and Multiplan 

Microsoft File 

Multiplan 

Microsoft \\lord 

As you have seen, pasting in the 
graphs from Chart into Word docu­
ments does not give you a great deal 
of leeway for creativity. When read­
ing data from File or Multiplan, how-

ever, you can use many of Word's features to make your tables 
clearer and easier to read. 

Note that you can get correctly formatted File output (that 
is, with tab characters between fields) from saving as text-only 
or from the Clipboard. You can also read File reports that you 
saved to disk as text-only. However, you can only read Multi­
plan tables from the Clipboard; remember that Word can not 
read a SYLK-formatted file, and Multiplan cannot generate a 
tab-delimited file. 

You do not need to use the same tab settings throughout a 
table. You can center headings above columns even if the 
columns are right- or left-aligned. The labeling row (or any 
other row) may have different tab settings from the rest of the 
table. 

Figure 2-8 shows some of the advanced features you can 
achieve by reading from a Multiplan spreadsheet. This table 
uses 

• right-aligned tabs for the numbers 

• leader characters for ease of reading 

• a different font for the caption 

• boldface type for emphasis 

• underline to indicate summation 

• extra tab characters for indentation. 



As you can see, you can use many different features to make 
what started out as a simple three-column spreadsheet into an 
interesting report. 

Word Input 
To Other Applications 

Word 45 

Microsoft Chart 
You can transfer data from Word to 
other Microsoft applications as well 
as to programs by other manufac­
turers. However, since Word is a 
word processing program, this use is 

Microsoft \>lord 

limited, but important nonetheless, as this section demonstrates. 

Planning Ahead for Labels 

When you are writing a report that includes input from another 
Microsoft application, you probably want the information they 

Appl e Computer, Inc. 
Annuel Report for 1983 

Conso l idat ed Stat ement s of Income 

(Dollars in thous ands) 1983 
Net sales .. ... ................... .. .............. ... .... ...... ........ .. ... 9_81,769. 
Costs and expenses 

Cost of sales ............................................. -505, 765 
Research and deve1opment... ............... 60,040 
Marketing and dis tribution ............... 229,96 1 
General and adminstra tive .................. -51 .364 

.8.5.3.1 3Q 
Operating income ...... .. .... .................................... 129,639 
Interest, net. .. ............. ... .......................................... .!.2.i.8.3. 
Income before taxes on income .................... 146, 122 
Provision for taxes on income ............... .. ......... Q.9,,408. 
Net income ........................ .................... 76, 716 

1982_ 
5_8.3,06 1 

288,00 I 
37,979 

119,945 
31 •. 92 7 

i.8..Q .. 8.5.£ 
102,209 
H .5.Q3_ 

116,772 
5.5.,466 

61,306 

Microsoft File 

Multiplan 

., 

Figure 2-8. ---- --------- ------------­
Multiplan chart embellished by Word 
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I -
. 

Word text-only 

share to be the same. Mistakes can be introduced when you 
copy the data, or the information may be changed as you ana­
lyze it. For instance, while you are writing a report, you may 
realize that the names you gave to the fields in a database are 
not accurate within the meaning of the report. If you had writ­
ten the report first, you could copy the labels from the report 
and paste them into File or Multiplan before copying the data 
back into Word. Or you could just edit the labels in your 
report, but they would then not match the data. Thus, if you 
are generating labeled columns of File or Multiplan data that 
will be used in your report, it is probably best to generate the 
data after you write the report. 

Quick Data Entry 

You can also use Word to generate data for the other programs 
while you are writing. If you write out a series of numbers with 
tab characters between them and then save the series to the 
Clipboard, you can paste these into File, Multiplan, or Chart as 
data. 

This is often useful if you are calculating results as you write. 
For example, assume that you have just written about some data 
that you received from an outside source, such as a telecom­
munications database. Instead of having to quit Word, run the 
other application, and re-enter the numbers (potentially caus­
ing transcription errors), you can select the numbers in your 
Word document and copy them to the Clipboard. When you 
run the other application, you can paste them in and perform 
the calculations. 

If you are using Word for this type of quick data entry, be 
sure that you use tab characters between the values, not spaces. 
Also be sure that you do not use any other characters, such as 
dollar signs. Either of these may cause unpredictable results. 

Text-Only Word Files 

Even though you can transfer data to the other Microsoft appli­
cations through the Clipboard, you cannot transfer information 
through text-only files. This is because the other Microsoft 



applications can only read SYLK files (except in the case of Print 
Merge, as mentioned earlier). However, many other programs 
can read text-only files produced by Word. Appendix B covers 
many of these programs and the valuable functions that you 
can perform with them. 

Word, as the central program for presenting information, 
can perform many more tasks than simply adding text to the 
input of other programs. Using Word as your information gath­
erer will help you organize your thoughts about the other 
information that you are compiling in your documents. 

Word's merge capabilities can take mailing-list data from File 
and produce top-quality letters. It can also read complex pic­
tures generated by Chart to enhance your documents. When 
formatting tables and reports from File and Multiplan, Word 
helps shape the information in those tables to be more attrac­
tive and understandable. And, to a limited degree, Word can 
produce text that can be used by the other programs. 
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_______________ Multiplan 

M any people still think of personal computers as "number ~-··. 
crunchers" and assume that their main function is mak-

ing calculations. This view is quite limited, of course, but it is 
also true to a great extent-you should not underestimate the M<Jltiplan 
power of your Macintosh for processing numbers. 

Multiplan is one of the most popular applications programs 
for the Macintosh because of the ease with which you can 
make calculations or experiment with different assumptions : 
you can change some of the data or equations, and Multiplan 
will immediately recalculate all the results. 

Your Multiplan results can be transferred directly to Word as 
a table of numbers, or you can graph them in Chart for easy 
comparison and analysis before including them in your report 
or memo. In addition, you can pass data directly from Multiplan 
to your file database, or you can bring in data from Chart and 
File and use it in advanced math functions from within Multi­
plan. Using Multiplan as your central calculator for data from 
the other applications makes it a very powerful tool. This chap­
ter discusses some of the possibilities for using Multiplan, Chart, 
and File as integrated software and tells you how to set up your 
data to avoid common pitfalls. 
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SeUing Up Yo ur 
Multiplan Spreadsheets 

Multipl an o rganizes data in rows and columns to form a spread­
sheet. Each intersectio n of a row and colu mn is a eel/. Cells may 
co ntain labels, num bers, o r formulas. 

Figure 3-1 shows a co mmon spreadsheet fo rmat with these 
typical features : 

• Labels are pl aced alo ng the top and left sides of the 
spreadsheet. 

• Columns are often used for perio ds of time, whil e rows 
s how categories of items. 

• Derived cells (the resul ts o f formul as) are pl aced below or 
to the right o f the data on whi ch they are based. 

Although most spreadsheets are more complex than the 
one s hown in Figure 3-1, the fo rmat is usu ally the same. This 
figure will be used throughout this chapte r. 

W he n you perform calculat io ns in a spreadsheet, you make 
assumptions about the valid ity and completeness of you r data. 
Yo u also make assumptio ns about the a bility o f cells to be com­
pared. In othe r words, two items th at you are adding may seem 
similar but still be very diffe re nt; add in g th em may yield mis­
leading results. 

Fo r example, the fo llowing spreadsheet lists the number of 
salespeople in a company: 

Columns 2, 3, and 4 contain data by region, and the number on 
the right is the total, as the label states. But what if some sales­
people be lo nged to more than one region; wo ul d the total be 
correct? 

Reme mber, the results d isplayed in a derived cell are on ly as 
valid as the assumptions you made about the data when you set 
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Figure 3-1. --------------------------­
Typical Multiplan spreadsheet 

up the formu la. If the calcul ation is based o n faulty assump­
tions, the information in the derived cell may not be valid. This 
situation can have a dom ino effect late r if you transfer t he cal­
cu lated data between programs and e ither perform furthe r cal­
cu lations on it or change some of your assumptions. 

Reme mber that once a computed cell is passed to another 
program through the C lipboard, the cell will look li ke data in 
the other program and wi ll not change if you change the data 
upon w hi ch it was based. When you are setting up spreadsheets 
to be transferred to othe r programs, you may find it conve nie nt 
to put the cells that contain data (numbers) in a separate sec­
tio n of the spreadsheet from those that have derived ( calcu­
lated) results, to identi fy those values that may have to be 
changed. 

When you pass data from Multiplan to ot her programs such 
as File or C hart, you must keep in mind the structure of the 
data. If you are making database records in Fi le, you shou ld 
consider whet her you rea lly want a record to contain both data 
and a computed cell su ch as the total, since Fil e can create its 
own compu ted fields that will change as the data changes. (As 
you will see late r in the chapter, the use of computed cells in a 
Fi le database is he lpful in some situat ions. 

If you are using both Mu ltip lan and File, you should also 
conside r which program should store your data. Mu ltiplan is 
meant fo r dynamic, changing data, w hile Fi le is better fo r static 
data, and it is easier to e nte r dat a into File t han it is into Mu lti­
plan. In general, most of your data that wi ll not change (su ch as 
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previous sales records) should be entered into File databases 
and then transferred to Multiplan spreadsheets. 

Summary Data 
Since Multi plan allows you to summarize data, you can make a 
spreadsheet of the summaries by copyi ng them into a different 
area of a spreadsheet o r a new spreadsheet (linked to the 
original). 

For instance, the company described in Figure 3-1 records 
the sales fi gures fo r each of its products in an individual spread­
sheet. Once the sales for each produ ct are entered by region 
and quarter, it calculates the total of all the products sold in 
each region and quarter to produce a summary spreadsheet 
li ke that in Figure 3-1 . 

Using Multiplan to 
Compute File Data 

Multi plan's compu tati on abilities can sometimes be used to fi ll 
in fo r defici encies in the other Microsoft applications. For 
example, although File can sum a group of fi e lds, it cannot find 
the max imum value in t he group. Figure 3-2 shows a spread­
sheet similar to Figure 3-1, except that the summary inform a­
tion is the region or quarter with the highest sal es. 

The equations in the summary columns and rows are very 
simi lar to the equ ations fo r the totals. Instead of the SUM() 
fun ction, the MAX( ) function was used. For instance, the fo r­
mula for the row summaries is 

:MAX(RC[-4):RC [-1 )) 

The "grand maximum" is the maximum of the matrix (you can 
also use the maximum of either the bottom row or the right 
column). 

Passing this array to File to create a database can be very 
useful; however, Fil e can only find t he maximum of a column 
of numbers, not of a group of fields in a record. Instead, you 
can use Multiplan to set up records that in clude t he maximu m 
for a group of fi e lds. This should only be done for historical 
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Figure 3-2. - -------------------------­
Spreadsheet showing maximums 

data that does not change; remember that once the data has 
been transferred to File, the computed field (in this case, the 
maximum) will not be changed if you change a data field in the 
Fil e record. 

Multiplan Summary 
Functions 

Table 3-1 lists the functions that can be used to summarize 
groups of cells. 

If you are passing data and summary cells to File, remember 
not to use Multiplan calculations in your spreadsheet that can 
be performed by File's calculated fi e lds. This will help prevent 
the problem of static data in your database appearing dynamic. 
Thus, a row in a Multiplan spreadsheet that computes the product 
of two cells should not be passed to File; instead, set up your File 
database to have a calculated field that finds the product of the 
two cells passed from Multiplan. 

When mixing data and summary cells, the Multiplan func­
tions to avoid are AVERAGE, NPV, and SUM. These can be repli­
cated with the standard math operators in Fil e, since File can 
add, subtract, multiply, and divide the val ues of fi e lds in a 
record. In fact , you shouldn't pass any calculations from Multi­
'\)~an that use only these simple operators. 

There will be times when you will want to write out sum­
mary cells without their underlying data, and in these cases, 
you should feel free to use all of Multiplan's summary func­
tions. For example, Figure 3-3 shows a spreadsheet of su mmary 
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Table 3-1. 
Summary Functions ------------------

Function 

AVERAGE( Iist) 
COUNT( list) 
MAX(Iist) 
MIN(Iist) 
NPV(rate, list) 
STDEV( Iist) 
SUM( list) 

AND( list) 
OR(Iist) 

Mathematical 

Average 

Purpose 

Counts elements in list 
Maximum 
Minimum 
Net present value 
Standard deviation 
Sum 

Logical 

Checks for all values true 
Checks for any value true 

Spreadsheet 

INDEX(area, subscri pts) 
LOOKUP(number, table) 

Picks a value 
Picks a value 

data that you can pass to File or Chart without worrying about 
confusing data and computed cells. The four columns use cal­
culatio ns from the data portion of the spreadsheet and the 
functions MAX, MIN, AVERAGE, and STDEV. 

The logical functions are very useful for checking a list of 
cells that you have used as indicators. For instance, the example 
below is an inventory spreadsheet in which each row shows the 
stock levels of a product in a particular warehouse. 

Cells containing formulas that compare ex isting stock levels ana 
the lowest acceptable levels of stock could be included in a 
portion of the spreadsheet 10 rows lower than the data rows. 
The contents of the cells beginning at row 11, in column 2, 
might be compared with t he formula 

:R[- 10)C>125 



This will evaluate to TRUE if there is enough stock (greater than 
125 units). 

The other columns could each compare ex isting stock w ith a 
minimum acceptable level. You could then produ ce a summary 
cell in column 6 that would contain the t ext "OK" o r " Low" 
depending on t he level of st ock. To do this, you would use 
M ult iplan's AND fun ction. The AND funct ion returns TRUE 
only if every value in the list o f cells is TRUE. T he formul a in cell 
R2C5 would be 

=IF(AND(R[+ 1 O)C[-3):R[+ 1 O)C[-1 ]), ""Ok'' ,""Low"") 

The result would be passed to File as a text fi eld t hat indi­
cated i f any o f the items needed restocki ng. To f ind all t he 
warehouses that needed restocking, you could simply select all 
the records having "Low" in that field. 

The OR function returns TRUE if any of the values in the 

cells are TRUE. If you expect an entire row or column of logical 
values to be FALSE, you can use the O R fu nction to tell you i f 
any cells had a value other than FALSE. 

The LOOKUP function is an excellent method for changing 
data from one form to another. I f you want to tu rn numeric 
values into text, for examp le, you can input a table of t he t ext 
equivalents of t he values and use the LOOKUP function to p ick 
valu es out of the table (the logical funct ions w ill return on ly 
one of two values). 

For instance, you might want a text cell to contain "Sm all" if 
another cell contains 0 t hrough 29, "Medium" if it contains 30 
through 75, and " Large" i f it contains 76 or more. To get the 
text equivalent fo r t he value in cell R3C1, use the formula 

: LOOKUP(R3C 1 ,R 1 C 1 O:R3C 1 1) 

2 4 
. ...... .. . . : l:i.i9.~ .......... J~.\1 .. .. .. .... . fw~.r:~CJ~ .... .. :?.t.~ .. P~Y. · ... .. 
J.~:- ~4 .... : .. ... . ... . ~? .. : . ... .. .. .. ~0 .... ... . .. ~."V;l .. : .t?:?nP!?~? .. 
~.!'?:-;~? . ... : . ... .. .... ~? .. : .. . ....... ~~ . . ..... . .. ~.? ,4,. J. ~.·.1.4~~9~ .. 
~.~:-~~ . .. . : ....... . .. ~ 1 .. : ... . . . .. . . ~9 ....... ... ~.? ,4 .. J. ~ .. ~0~7~ 1 .. 
~.~:-~~ .... : ... ... .... ~? .. : ........ .. ?? .......... ~.:? '~·. J. ~.·.1 .7~7~? .. 
P.~:+-....... ; .......... ~? .. ; ........... 1.~ ..... . ... . 9.1. ,4 .. :.1. 9 .. ~4~?~7 .. 

Figure 3- 3. - ---------- --- - - - - - ­
Spreadsheet with only sum mary data 
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~ 

This refers to a table in R1C10 through R3C11, which looks like 
this: 

Other Multiplan 
Functions 

0 Small 
30 Medium 
75 Large 

Since File and Chart do not have any advanced math functions, 
you may find yourself wanting to use Multiplan's math func­
tions to calculate values in your database or graphs. And 
although you come up against the familiar problem of static 
versus dynamic data, it is not hard to use Multiplan to perform 
these calculations. 

Table 3-2 lists the functions that work on individual values 
or on limited sets of cells. These functions, with the power( ") 
operator, can be used to compute derived cells that you pass to 
File or Chart. 

The mathematical functions are very helpful if you are using 
Multiplan and File for scientific data. You might use the SQRT 
function in business if you are performing least-squares averag­
ing. The text functions can be used in combination with the 
LOOKUP function for producing formatted text fields based on 
values. 

Seeing Results in Chart 
When you transfer data from Multi­

h,, ~ & plan to Chart through the Clipboard, 
~ ~ you will find it importantto pay atten-

Multip lan Microsoft Chart tion to whether you are passing simple 
rows or columns or arrays of various 

types of data because Chart handles them very differently. 

Transferring Rows 
Or Columns 

Chart document Chart provides a quick way to look at the relationship between 
numbers in your Multiplan file by making them into a graph. To 



Tablel-2. 
Multiplan Math Functions --------------

Function Purpose 

ABS(number) 
ATAN(number) 

Mathematical 

Absolute value 
Arctangent 
Cosine COS( number) 

EXP(number) 
FIXED(number, digits) 
INT(number) 
LN(number) 
LOG10(number) 
MOD(dividend, divisor) 
PI() 
ROUND(number, digits) 
SIGN(number) 
SIN(number) 
SQRT(number) 
TAN( number) 

e raised to a power 
Truncates 
Integer portion 
Natural log 
log base 10 
Remainder of division 
3.14159 
Rounds a real number 
Positive or negative 
Sine 
Square root 
Tangent 

Logical 

FALSE( ) 
IF(expr., true-val, false-val) 
ISERROR(value) 
ISNA 
NOT(expr.) 
TRUE() 

DOllAR(number) 
LEN(text) 
MID(text, start, length 
REPT(text, number) 
VALUE(text) 

False value 
Chooses two values 
True if error 
True if #N/ A 
Inverse 
True value 

Text 

Dollar representation 
length 
Substring 
Repeats 
Changes to number 

Spreadsheet 

COLUMN() 
DELTA() 
ITERCNT() 
NA() 
ROW() 

Column number 
Changes between recalculations 
Iteration count 
Value liN / A 
Row number 
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transfer a row or a co lumn of data to be formed into a graph, 
simply select the data and copy it to the Clipboard with the Copy 
command in the Edit menu. For instance, to select the data for the 
first quarter, position the cursor over cell RC2 (whose value is 
12,593) and drag down to R7C2: 

The keyboard shortcut for copying the selection to the Clipboard 
is COMMAND-C. 

When you run Chart, simply give the Paste command from the 
Edit menu (keyboard shortcut: COMMAND-v). Chart will open a 
series window for the new data: 

1 12593 ::: 
2 8300 

:il 
3 7231 
4 10173 
5 42 19 

Choose a chart type and then click the "Plot Series" button. For 
instance, if you use the default chart type (Column type 1), you 
will see 



Untitled 

Series 7 :03 :57 PM 

You can also make drawings from Multiplan rows. To see the 
sales for the Pacific region, select 

I 2 I 3 I 4 I s I 6 

{ "t au~:spcand M!~' :rhird n!lllfi UUf!h 'ilitNt\:h; i :(q: 
. : ...... ... !L~R9 .. : .. .. .... 1 ~ .~gs .. : ..... ... 1 ~ .~~9 .. : .. ..... . 1 ~L~R~ .. :~ .5~ .. 1.1.~. 

Paste this into Chart and plot the series: 

Series 7 :OS :20 PM 

18000 

16000 

14000 

12000 

10000 
y 

8000 

6000 

4000 

2000 

0 
2 3 4 

X 

Be sure that you do not include a column label with the 
Multiplan data. If you accidentally include it, Chart will assume 
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~ 
Chart document 

that all of t he data is text data and will make a useless series 
window. For example, copy column 2 including the "First Quar­
ter" label: 

When you paste this into Chart, your data looks like this: 

§0§ Series 7:06:20 PM ~ 
Order:~ ~ 
D Plot Series 

This is clearly not what you wanted. 
Of course, you should also be sure not to include any com­

puted cells in the Mu ltiplan selection, since the derived values are 
not related to the other valu es and the drawings w ill misrepresent 
the data. 

Transferring Rows 
And Columns (Arrays) 

Chart handles two-dimensional Multip lan data fairly well, al­
though beginning users sometimes cannot make their graphs 
show what they want. If your Multiplan data includes one set of 
labels and one set of data, Chart works as you might expect. 
However, if you have more than two rows or colum ns of data, an 
array, you need to explain to Chart how to plot all the data 
together. 

The simplest case of transferring arrays from Mu ltiplan to 



Chart invo lves a column of data and a block of rows. For instance, 
copy colu mns 1 and 2 (not including the totals) to the C lipboard: 

When you paste this select ion into C hart, it opens up one series 
window: 

Pacific 
Southwest 

Mountain 
Central 

South 

Plotting this with the default chart type will yie ld 

Ser ies 7 :07 :12 PM 

14000 

y 

Paci fic Southwest Mountain Centr al South Nor theast 
X 
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If you are using o nly one series of data (as you are here), a slightly 
more att ractive plot is Column ty pe 2: 

Series 7 :07 1 2 P11 

14000 

12000 

10000 

8000 
y 

6000 

4000 

2000 

0 
Pacific Southwest Mountain Central South Northeast 

X 

If you select two-dimensional data that is not one series, Chart 
will split the data into separate series windows. To p lot these in the 
same order as their respective columns, you must plot the left­
most column first, then the one to its right, and so on. 

To see how this works, copy columns 1, 2, and 3 to the 
Clipboard: 

~ 1"·"'9" 1· ~ou· ~ -4~ .· '=·,.:.. .. 
·: .. :.uth .... ·.:-.:t :::,300 1t.,8~5 

r k·unt ~m 7 ,231 1 4 ,.293 
C.;.r,tral 10,173 14,872 

·: .. :outh · 4 ,21 '? . ·? ,q;?4 
r-l•:•rthn; t '? ,311 1 1 ,554 

Quit Multiplan, run Chart, and give the Paste command. Two 
series windows wi ll appear. The first will have the d ata from 
columns 1 and 2, and the second will have the data from column 3. 
The title on the fi rst window will have a time of a few seconds less 
than the second window. The two windows look like this: 

Series 7:08:36 PM 
Order: laRJ 
0 Plot Series 

X .l y ! 
~----~~~------~--~-pacific i 1 2593 i 

Southwest l 8300 j 
Mountain i 7231 ' 

Central ! 10173 1 
South ! 4219 ; 

Northeast i 9311 l 
i i 



To plot the two columns side by side, click in the "Plot Series" 
button in the first window (the one with the plot labels). The 
Order box will read "1". Next, click in the barely visible part oft he 
second window to bring it to the top. Click the "Plot Series" 
button in the second window; its order box wi ll read "2". Click on 
the graph to bring it to the top: 

Series 7 :08 :36 PM 

18000 

16000 

14000 

12000 

10000 
v 

8000 

6000 

4000 

2000 

0 
Pacific Southwest Mountain Central South Northeast 

X 

Notice that even though the "X" column in the second window 
contained numbers, not labels, Chart knew that this data was 
related to the data in the first window and kept the labels at the 
bottom of the chart. 

If you had selected columns 1 through 5, Chart would have 
brought up four windows: the first with the labels and the first 
column of data, and the other three with only data. Again, the 
order in which you plot the data will determine the order in which 
the columns in your graph appear. Of course, if you choose a 
different type of graph, the order may not be important. You can 
change the order of the columns after you have plotted them by 
editing the numbers in the Order boxes. 

Since Multiplan does not let you select two columns that are 
not contiguous, you may have a hard time making the charts you 
want. For instance, you may want to make a graph of the data in 
Figure 3-1 that contains just the locations and the totals columns. 
Since you can't select just these two columns from the spread­
sheet, you should first copy the two columns to a pair of adjacent 
columns in an unused portion of the spreadsheet and then select 
them. 

If you pay attention to the type of data that you give Chart, the 
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series windows that it presents will not surprise you. All of the 
graph styles in Chart can show two-dimensional data (except pie 
charts) . You should experiment with different types and orienta­
tions of graphs before you produce a final drawing. 

Chart reveals one unfortunate feature when you paste a 
spreadsheet from Multiplan.lfyou have more columns than rows 
in the Clipboard data, Chart will create series from the rows, not 
the columns that you have seen here. Thus, if you have five 
columns and only three rows of data, Chart will form the series 
windows by rows. Since this is rarely what you want to happen, 
you must be careful when you make your Multiplan seledions. 

Linking a spreadsheet to a Chart file lets you get the most 
current data from your Multiplan documents each time you 
create a graph. Since this is a feature of Chart, it is discussed in 

detail in Chapter 5. 

Creating Records for File 

Multiplan Microsoft File 

As you saw at the beginning of the 
chapter, Multiplan can create many 
kinds of records for File. There are two 
situations in which you might use this 
capability: 

• You want to create a new File database from information in 
Multiplan. This is often done if you use Multiplan extensively 
for financial data and inventory. After passing data to File, 
you can use File's sorting, seleding, and reporting capabili­
ties on the information. 

• You want to modify the data in a File database with Multi­
plan's math and logic fundions. This involves copying data 
in File, pasting it in Multiplan, moving columns, creating 
new calculated columns, copying the spreadsheet, and past­
ing the records back in File. Using almost identical steps, you 
can also create a new database with the values from a pre­
vious database. 



Creating New Databases 

The most common type of File databases that you will create in 
Multiplan are summary databases. These often contain totals from 
rows or columns of Multiplan data. Remember t hat you should 
perform w hatever calculations you can in File so that your totals 
always reflect the current data, unl ess, of course, your procedure 
is o nly to update your Multiplan spreadsheets, not your File 
databases. 

The rows you want to turn into records can form a database 
simply by copying them from Multiplan to the Clipboard and 
pasting them into a Fil e database. I fthere are columns that you do 
not want in your database, eithe r remove them or copy all the 
ones that you do want to a free area of the spreads heet and 
arrange them as you wish. 

If you are selecti ng many rows in you r Multiplan spreads heet, 
you may run out of memory on your Macintosh. Of course, the 
more memory you have, the less likely this is to happen. But even 
if you have e nough RAM to copy the rows to Mult iplan's Clip­
board, you may not have enough space on disk to write the 
records out as you switch app licatio ns. If this is the case, select 
fewer records, write them into you r File database, switch back to 
Multiplan, select more records, and so o n. 

Modifying Existing Databases 

The steps for using Multiplan to add o r change a field in a File 
database are quite straightforward. If you are modifying an ex ist­
ing database, you must cut the File records to t he Clip board, 
modify them in Mu ltiplan, and copy them back to the C lip board 
for File. If you are creating a new database w ith different informa­
tion, you do not need to cut the o ri ginal records. Since cutting 
informatio n to the Clipboard p ermanently removes it from your 
database, it is wise to make a complete backup of your datafil e 
before following the steps below. 

Before you start the process of moving dat a back and forth, 
~~>J iew the following list and be sure you are prepared for e ach 
step. The first three steps are covered in mo re detail in C hapter 4. 
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1. Back up your File database. 
2. Select the File records you want to modify. Remember that 

you cannot move more than 255 rows at a time, since that is the 
limit oft he number of rows in Multiplan . Many versions of Multi­
plan have a bug that causes Multiplan to go into an endless loop if 
you move a large amount of File data into Multiplan. 

3. If you are creating a new database, use the Copy command 
from the Edit menu to put the records from the database into the 
Clipboard. If you are modifying an existing database, usetheCut 
command. 

4. Quit File. When you are prompted to save formatted or 
unform atted values in the Clipboard, select Unformatted. Be sure 
that only the Save Unformatted Records button is checked. 

5. Run Multiplan. Be sure that cell R1C1 is selected and give 
the Paste command from the Edit menu.lfyou have copied many 
records, it may take Multiplan up to15 minutes to store them all in 
the spreadsheet. 

6. For safety's sake, imme diately save the spreadsheet with 
the Save As command in the File me nu. 

7. If you are going to create a second database from the first, 
remove any rows that you do not want. 

8. Create the derive d cell in the top of the columns where 
you want it to appear in the database. Copy it downward with the 
Fill Down command in the Edit menu. 

9. Select all the rows and give the Copy command. 
10. Save the new spreadsheet and quit Multiplan. Again, save 

the Clipboard as unformatted. 
11. Run File. If you are adding the new records to your data­

base, select that database in the initial dialog box. If you are 
creating a new database, select New Datafile. 

12. Sele ct New record at the end of the displayed records and 
give the Paste command. It may take File several minutes to create 
the new records. 

13. Verify that the computed cells translated the way you 
expected. 

14. Save the new database with the Save command. 



Multiplan Spreadsheets 
In Word 
Chapter 2 described many of the ways 
that Word can present Multiplan out- ~ 
put as formatted tables. There are a ~ 

few more issues that you should con- Multiplan Microsoft 'w'ord 
sider before you pass Multiplan data 
to Word for display. 

Since much ofyourwork with Multiplan is meant to be viewed 
on the Multiplan screen, you will want to adjust column widths so 
that text labels can be seen completely; and you probably will 
want to put short text in labels to save space on the screen. Of 
course, once you transfer a spreadsheet to Word, you can change 
the labels any way you want; you can use multi-line labels or 
labels with different fonts and styles. Because of this, you do not 
need to copy the labels when you move your data: simply fill in 
what you want after you have pasted the data in Word. 

Word also gives you the flexibility to annotate Multiplan data 
in a fashion that is not available in Multiplan. For example, you 
may have an annual report spreadsheet that shows net income. 
However, if this income is altered because your company is buy­
ing its own stock, you should annotate that when you present the 
spreadsheet. Even though you can't do this in Multiplan, you can 
in Word; Word's footnoting capability works very well here. 

When you get a feel for the types of data that Multiplan can 
pass to other Microsoft applications, you can see how powerfu I it 
is. Its math capabilities allow you to prepare records for File that 
you would normally have to do by hand (or, as you will see in 
Appendix B, with a programming language). It is much easier to 
enter data in Multiplan than it is inC hart, and you can experiment 
with different types of calculations and see the results quickly. As 
you saw in Chapter 2, Word can help display Multiplan's results in 
a text document and spruce up the looks of the spreadsheets you 
produce. 
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Before Apple introduced the Macintosh, database software 
for business microcomputers had a reputation for being 

clumsy and hard to use. The instructions you used to tell the 
software about your data file res em bled a programming lan­
guage, and you needed to remember the names of fields if you 
wanted to sort or select records. Using the Macintosh's standard 
user interface, Microsoft was able to make File much simpler to 
use than the old-style database management systems (DBMS's). 
Although more limited in scope than some other database sys­
tems, File can handle many routine record-keeping functions, 
and its usefulness is enhanced when it is integrated with the 
other Microsoft products. File stores data in a simple format; so 
like Multiplan, it can be used for customer lists, inventory, gen­
eral ledger bookkeeping, and similar applications. Used with 
Multiplan's calculating capabilities, File can improve your busi­
ness record-keeping. With Chart you can graph your File data 
and see summaries of your databases. File can also store infor­
mation generated by Word for use in customized form letters, 
reports, and memos. 

Microsofi File 
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The Elements of File 

FHe form 

Like other databases, File works with information ordered as 
fields and records. 

Each field in File can have almost any length (it can co ntain 
more than 32,000 characters), each record can have more than 
1000 fi e lds, and a datafile can have more than 65,000 records In 
other words, you can create a d atabase with File for almost any 
applicat io n you ca n think of. 

=D Customers 
Name Compem.1 I 

1 Robin Preston American Photomics 
2 Roger Vaunts KLC, Inc. 
3 Celie Eiger Lincoln Mfg. 
4 Linde Neely American Photomics 

"\ 
Records 

.-/ 

Creating Forms 

To show File how you want your data organized, use the Show 
Fo rm command in the Fo rm menu. Yo u use this fill-in tem plate to 
give a name to each of your fi e lds and to te ll File where to show 
the fi e lds o n the screen. Whe n you give a definition for a field, 
you also specify the type of data that will go into that fie ld and any 
special form atting characteristi cs. (Data types are discussed later 
in this chapter.) 

There are two types of File forms, List He lper forms and the 
forms you create and customize yourself. List He lper forms 
always show as many of each record's fi e lds as possible along 
o ne line. The name of each field is show n at the top of the 
datafile display. 

The following is a form fo r a sales database. Part of its data­
fil e window is shown in Figure 4-1. 
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0 Customers 
Name Companu Last order Amount 0 

Ro-bin Preston American· Photomi cs 3/2/85 $3,517.00 
2 Roger Vaunts KLC, Inc. 7/6/85 $230.75 
3 Celia Eiger Lincoln Mfg. 8/18/85 $827.00 
4 Linda Neely Ameri can Photomics 6/9/85 $2,050.00 
5 Skip Vasquez Fuller Parts 5/4/85 $720.50 
6 Greg Bianchi Haselton Computer s 7 / 18/85 $4,900.00 
7 Jennifer Mahler KLC, Inc. 7/6/ 85 $1,400.00 
B S. Shell National Service, Inc. 4/30/85 $5 12.75 
9 Marty Davis KLC, Inc. 1/24/85 $2,805.00 

l--::;--l~~-;:-:-------+.--:--"--:-~:-;-------;-;:;-;-:-:;::-~;:---t-------=~~+-f1!1l!l 

~~~~~~~--~~~----~------~~~--~~~~HI 
Figure 4-1. - ------------- - - ----------­
Datafile w indow for a List Helper form 

Without List Helper, you can arrange fields so they appear 
on a form much like a paper form. You can have many fields on 
a line, and some of the fields can be more than one line tal l. For 
instance, you may want to set up a form like this one: 

Using su ch a form makes data entry easier, or at least more 
pleasant, for most people. The datafi le w indow for this form is 
shown in Figure 4-2. 

You can keep as many forms for a datafile as you w ant. If 
you want to save a form for future use, open the Form window 
and give the Save Form command in the File window. 

Displaying Records 

When you begin working with a data­
base, all of the records are shown in 
the datafi le window; you can view ~S 
them all by scrolling. The actions that 
affect recor ds (except those involv- Report... ~R 
ing the Clipboard) affect all records in the datafi le window. I f 
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!Robin Preston 

Company: !American Photomics 

Contact: I Roger Younts 

Company:~IK_L~C,~I_n_c. ________ ~ 

Contact: !Celia Eiger 

Company: !Lincoln Mfg. 

Date of last order: l3/2/e5 

Rmount: ~ .517 .00 I 

Date of last order: 17 / 6/e5 

Rmount: I $230.75 I 

Date of last order: 

Figure 4-2. ------------------------­
Datafile window for a general form 

you want to work with less than the full set of records, you 
display just those records with one of the commands in the 
Organize menu. 

The Find command is generally used to make a subset of the 
records in the datafile window. The Find command lets you 
specify which records you want by establishing a condition, 
such as " all records whose Amount field is greater than 1000." 
You can easily create complex display criteria such as "every 
record that has a Stock field below 25 and the Purchase Date 
field before 8/ 1/ 85." 

When you give the Find command from the Organize menu 
(the shortcut is COMMAND-F), File displays the Find window: 

The window consists of two buttons, Find and Clear, and a form 
identical to the form for your database. To specify the display 
you want to see, you fill in the fields in the Find window and 



click the Find button. The Clear button clears all of the display 
criteria you have entered in the window. 

To find all records with a field equal to a specific value, 
simply enter that value in the Find window field. For example, 
to find all customers whose last order was on 7/ 15/ 85, enter this 
in the last Order field: 

When you click the Find button, File searches through the 
entire file for records with that date. The number in the lower­
left corner of the window shows the number of records in your 
display subset and the number of records in the datafile. 

l17/17l 

You can also find records based on whether the fields are 
greater or less than a particular value. To do this, put an opera­
tor in front of the value in the Find window. Table 4-1 lists the 
operators you can use. For example, to find all records whose 

Table 4-1. 
Find Operators - -------------- ----

Operator 

<> or >< 

> 
< 
>= 
<= 

Meaning 

Exact value 

Not equal to 

Greater than 

Less than 

Greater than or equal to 

Less than or equal to 

In a range 
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Amount field is greater than or equal to 275, enter 

You can also use operators with text fields. For instance, " > N" 
in a text field means find all records whose first letter starts with 
a letter in the alphabet after "N" . 

You can specify more than one field criterion in you r Find 
command. For example, to find records with last Order before 
7/ 15/ 85 and Amount over 1000, enter 

File will find all records that meet both criteria. 
After you have given a Find command, if you want to display 

all the records again, give the 5 how All Records command in 
the Organize menu. You can also choose, one by one, which 
records to show in the display, by clicking in the record~ 

number bar of each record. It may be faster to select the 
records you do not want to appear in the display and give the 
Hide Records command (shortcut: COMMAND-H) in the Organ­
ize menu. 

Sorting 

Find... stf 
llid l' llt~I:O I'd~ :•:11 
Show All Re cords 

------------····--···----'t·-···········--
Report... stR 

Once you have chosen the records 
you want to display, you may want to 
sort them in a particular order. File 
normally stores the records in your 
datafile in the order you entered 
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them, which is not very useful in most situations. You w ill 
probably want to view the records in sorted order based on 
one or more of the fields, such as by date or by name. 

To specify the fields on w hi ch you want the displayed 
records ordered, give the Sort command in the Organize menu 
(shortcut: COMMAND-S) . File brings up a Sort window, w hich is 
similar to the Find window: 

This window also uses the current form. 
Instead of filling in values in the fi e lds, you click o n the box 

at the left of the field to specify that you want to sort on that 
field. For example, to sort the displayed records by the Last 
Order fi eld, click on its box: 

File automatically fills in "1-9", which indicates that the fi e ld 
will be sorted in ascending orde r. Click the Sort button to see 
the result. 

You can also sort in descending order. To switch the sort o rder, 
give the Sort command again and click o n the "1-> 9" portion of 
the field. The field changes to "9-> 1". File uses "A-> Z" and 
"2-> A" in text fie lds to indicate the sort order. 

You can sort by more than one field if you wish. Sorting on 
two fields means that if there is more than one record with the 
same valu e for the first field, those records will be put in o rder 
for the second field. If you had a field for first name and a fie ld 
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I 
File Index 

for last name, you would sort all the people who have the same 
last name also by first name, as in the phone book. The field 
that you sort by first is the primary field; the second sorted field 
is the secondary field, and so on. You can sort on as many fie lds 
as you want. 

You would probably use the Company field as the primary 
field and the Name field as the secondary field to sort the 
customer list in the sales database example. In addition, you 

. would probably want to sort both fields in ascending alphabeti­
cal order. To tell File you want this sort order: 

1. Give the Sort command. 
2. Click on Company. 
3. Click on Name. 

The Sort window will show: 

Notice that Company has a value of 1 in its box and Name 
has a value of 2; as you might guess, this is the sorting order. 
You can edit these boxes if you want to change the sort order. If 
you decide not to sort a field that you have already selected, 
select it and press the BACKSPACE key. 

Indexed Fields 

When File reads or sorts records, it accesses the disk often. 
Since the Macintosh floppy disks are somewhat slow, the Find 
and Sort commands can take a long time to execute. If you 
know that you are often going to use certain fields {or finding 
or sorting, you may want to index those fie lds. 

Indexing a field causes File to store a special table on disk 
that lists all of the records and the values of the indexed fields 



(sometimes called keyed fields). File can read through the index 
file much faster than it can read through the records, which 
makes the Find and Sort commands work much faster. The trade­
off is that the index file takes up room on the disk. 

To index a field, click anywhere in one of the field's input 
boxes. This makes the Format comn:tand in the Form menu 
available (it will say "Format Text Field", "Format Number 
Field", and so on). Give the Format command in the Form 
menu, and File presents a dialog box with many formatting 
choices; these are discussed later in this section. For example: 

Format TeHt Field 0 lndeH fi OK u 
Nome: 
~~ 

Align 
®Left 
0 Center 
0 Right 

Style - --, 
0 llonler 
0 Underline 
0 Bold 
0 Italic 

(Cancel) 

A square check box near the top right of the box is labeled 
"Index". Click this box and then the OK button. File will then 
sort the records as it creates the index file. 

After a field is indexed, you will notice that sorting or find­
ing values in that field is much faster. If your database is on a 
standard Macintosh disk, sorting will probably take less than a 
third of the time it took before the field was indexed. 

Reports 

The main reason for choosing records and sorting them is to 
organize them for use with other programs or for a report. 
File's report facility lets you set up a report form that can be 
used on any subset of your database. Setting up a report is 
almost as easy as setting up your input screen to create a form. 

Reports are most often written to summarize the data in a 
database. Fo r example, you may want to know how many con­
tacts you have at each company. After sorting the records on 
the Company field, File's report facility will start reading the 
records, looking for the first company's name in that field. 
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When the value in the Company field changes (meaning that 
there are no more records that contain the first company's 
name in the Company field), File prints out a summary showing 
the number of records with that Company value. These steps 
can be repeated for each value you specify. You can then tell 
File to show a grand total, which is a summary of all the sum­
maries, at the end of the report. 

To set up a report, give the Report command from the 
Organize screen. File opens a Report window similar to the List 
Helper form window: 

The three horizontal portions of the window correspond to 
the possible ways of presenting the fields: 

• Sorted-Move any fields that you want to sort into this 
area. Like the Sort command, the Report command lets 
you decide the order in which the fields will be sorted. 

• Not Sorted-If you want to show values for fields other 
than those that are sorted, move the fields into this area. 

• Not Shown-These are the fields that you do not want to 
show in a report. 

You can choose to show all the records in a report or just 
the summaries. For example, assume that a l ist of clients is 
sorted by state (primary) and city (secondary). If you print a 
summary report, File will print one line summarizing all the 
records for each city. A general report would include all the 
records between each summary. 

To specify the type of summary you want, select the field 
name and give the Format Summary Field command in the 



Form menu. You will see the fo llowing dialog box: 

Format Summary Field 

Summary of "Name" by 
"Name" 

Function- [ , 
o -ro tal OK 

D Count (Cancel ) 
D UuNaiJP 
0 Minimum 
O MtHtimum 
D S1d. [I{W . 

If the field is a text field, your only choice is Count. The 
types of summaries are shown in Table 4-2. You can select more 
than one type of summary for the records (such as Total and 
Average). 

You can see a report on the screen by clicking the Preview 
button. To print a report on your printer, keep the Report win­
dow open and give the Print Report command. If you want to 
save the report as a text file that can be read by Word, give the 
Save Report command instead. 

Table 4-2. 
Types of Summary Fields ----------------

Type 

Total 

Count 

Average 

Minimum 

Maximum 

Std. De"ll. 

Meaning 

Sum of all the values 

Number of records 

Average of the values 

Smallest value 

Largest valu e 

Standard deviation of the valu es 

File 79 



80 Macintosh Pape rwork: Integrat ing Micro soft Produ cts 

For example, assume you want a report on your contacts by 
company and a count of the companies. You would specify the 
following: 

Figure 4-3 shows part of the report. 

Types of Data 
File can handl e four types of data: numeric, text, date, and pic­
ture. You can have any mix of these data types in your data­
bases. When you enter data into your database, you type text, 

Compony 
Americen Photomics 
Den Fenster 
Elliot Motors 
Fuller Parts 
Hese lton Computers 

Contocts 
2 
1 
2 

KLC, Inc. 3 
Lincoln Mfg. 2 
Linotest 2 
Netionel Ser vi ce, Inc 
Peul Thomes 
Telecomp 

Figure 4-3. - ------------------­
Sample File report 



dates, and numbers into the fields. You can edit fields just like you 
edit in Word or MacWrite. Picture data must be pasted into fields 
from theCiipboard.lt is likely that you will also use the Scrapbook 
if you use picture fields. 

Each type of data is formatted in different ways. The formatting 
you use will affect the way in which File displays records on the 
screen. However, before you pass information to other Microsoft 
programs, you should remove the formatting so that numbers are 
not mistaken for text fields. When you save records to the Clip­
board, File will ask whether you want to save the records with or 
without formatting: 

[1!J Sauing large clipboard 

~ Saue Formatted Ualues 

D Saue Unformatted Ualues 

(Cancel ) 

Be sure to check only the Save Unformatted Values button. Text­
only files will have the same formatting as the current form. 

Remember that the formatting you specify is the display for­
matting only. You are not required to enter formattin g characters 
such as commas when you are adding or changing formatted data. 
If you have a number in dollar format, you do not need to add the 
dollar sign; File adds it for you when you have finished the entries 
in a field. 

Numbers, dates, and text have two formatting characteristics 
in common: alignment and style. Alignment can be left, center, 
or right, the same as the tab alignment in Word. If you want to use 
a special type style, you can choose underline, bold, or italic. If 
you are not using the List Helper form, you can choose whether 
the field has a border around it (so you can see where to enter 
data). 

The data and headings in a form are not limited to one type 
font and size in File: when you give the Set Font command in the 
Form menu, File presents a window listing four fonts and sizes: 
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Set Font ~ OK l 
Font Nome: (Cancel ) 
Chicago 

i~ New Yorl< Font 
Size: . 

1 HW~ 111"1 Monaco 14 

The following sections describe the types of data that File 
handles and the formatting you can apply to each type. You need 
not be concerned about how File handles the data on your disks, 
on ly how you enter and produce reports. 

Numeric Data 

Any data on w hich you want to perform calcu lations must be 
numeric. You can enter numbers in t heir regular form or in 
scientific notation (such as "4.2E7"). File sorts numeric data from 
negative to positive. 

There are two types of numeric f ields: data and calculated. 
You enter numbers into a data field just like a text field. A calcu­
lated f ield, however, never accepts data from you. Instead, File fil ls 
in the field w ith the results of a formu la that you entered when 
you set up the form. For instance, you can have a field called Tax 
calcu late the sales tax on the values in an Amount field. If the tax 
rate is 5.2%, your formula in the database form would be 

Amount *.052 

Both the formatting and formu la are entered in the Format 
d ialog box: 

Format Number Fiel d 0 l n!le11 

Name: 

Display 
0 General 
@ Dollar 
0 Percent 
0 Decimal 
0 Scientific 

OK J) 

[ Concel ) 
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Table 4-3. 
Numeric Display Types 
With Decimals Set to Two Places ---------------

Display 

General 

Dollar 

Percent 

Decimal 

Scientific 

Example 

723.9 

$723.90 

72390.00% 

723.90 

7.24E+02 

The possibl e types of displays are shown in Table 4-3. As you can 
see in the illustration, you can specify the number of places after 
the decimal point (although File always reme mbe rs more if neces­
sary). The additio nal style choice, Commas, inse rts commas in 
numbers. 

Your formulas can use additio n, subtraction, multiplication, 
and division, and can group calcu latio ns with parentheses. Ju st a 
few of the uses for calculated fie lds are 

• Tax, commission, or other rates based on a field. 

• Totals of other fields. Fo r example, if a record has quarterly 
sales, a computed fie ld might calculate annual sales. 

• Difference between fields, su ch as net profit or amount le ft. 

Text Data 

Text fields can be sorted but not calcul ated. Names and addresses 
c.re commo n text fie lds in databases. You may want to store 
numeric ite ms that you will never use in calculations, such as part 
numbe rs, t e lep hone numbers, or ZIP codes, in text fields as well. 

The only formatting you can se lect for text fi e lds is alignm ent 
and style : 
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Dates 

Format TeHt Field D lndeH [ OK D 
Name: ~~~~!11!!!11!!!!!! 

Rlign 
@ Le ft 
0 Center 
0 Right 

Style---. 
D Bonl(~l' 
D Underline 
D Bold 
D Italic 

(Cancel) 

File's date fields make it easy to store time-based information. 
Dates can be entered in conventional formats (such as " 12/ 14/ 84" 
and " December 14, 1984") an d can be correctly sorted w ith the 
Sort command, which often is not the case in other DBMS's. The 
form atting for dates is 

Format Date Field D lndeH ( OK » 
Name: 

Display 
@Short 
OMedium 
0 Long 

Rlign 
@ Left 
0 Center 
0 Right 

(Cancel ) 

Style---. 
D Bord(~l' 

D Underline 
D Bold 
D Italic 

Table 4-4 shows examples o f the three display formats. 
When entering dates, you can use a shortcut if you are enter­

ing the current year. I fyou just enter a number between 1 and 31 , 
Fil e assumes that you are entering the current day and supplies 
the month and yearforyou. lf you ente r two numbers with a slash 
(example: 12/31), File assumes that you are entering a date in this 
year and supplies the year for you. 



Table 4-4. 
Date Formatting-------------------

Format 

Short 

Medium 

Long 

Picture Data 

Example 

11 / 2/ 85 

Nov 2, 1985 

November 2, 1985 

File's use of picture fields is novel. A picture field can hold a 
picture created with Chart, MacPaint, MacDraw, or some other 
program that can store pictures in the Clipboard. You cannot sort 
or find records based on a picture field. 

As you might imagine, the formatting for picture fields is 
different from the other data types. The Format dialog box looks 
like this: 

Format Picture Field 

Name: 

Display 
@Clip 
0 Scale 

[ OK » 
(Cancel) 

If the picture in the record is larger than the display field in 
your form, File must decide whether to clip the picture (show only 
a portion of the whole) or scale the picture to fit in the field. You 
may enlarge the field in the Form window to show the whole 
picture, if you like. 

If you copy records into the Clipboard or save them as text­
only, File will eliminate the picture fields. Thus, they are not of 
much interest to people who use File in conjunction with other 
products that do not use pictures. 
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Moving File Records 
Into Multiplan 

Microsoft File Multiplan 

As you saw in Chapter 3, Multiplan has 
more mathematical capabilities than 
File. You can transfer records from File 
to Multiplan for processing and then 
move them back to File. 

Since Multiplan cannot read a File text-only datafile, you must 
transfer records through the Clipboard. You should not transfer 
too many records at a time, however, since Multiplan reads them 
in very slowly, and some versions of Multiplan have bugs that 
make them stop if they are reading too many File records from the 
Clipboard. Transferring about 100 records at a time seems to be an 
acceptable level. 

The records from your database are stored in the Clipboard in 
the order in which they are selected. Thus, if you are going to 
produce column totals in Multiplan, you must sort the records 
before pasting them into the Clipboard. 

Moving File Records 
Into Chart 

Chart will accept File records just as it 
& accepts Multiplan rows. The only prob-
~ lem is that you need to set up your 

Microsoft FHe Microsoft Chart forms to contain only the information 
that you want to display in Chart. This 

usually means you must hide all of the text fields and the number 
fields that you are not interested in. 

To set up a special form for transferring records to Chart, 

1. Open the Form window. 
2. Give the Save Form command in the File menu to copy the 

form you were already using. {Unfortunately, there is no New 
Form command.) 

3. Hide all of the fields that you do not want by dragging them 
into the shaded area of the form. Rearrange the other fields to be 
in the order in which you want to pass them to Chart. A label field 
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for numeric data should be in the first column. 
4. Give the Save Form command in the File menu. When you 

later want to transfer data to Chart, you can reuse this form instead 
of having to re-create it. 

When you paste the records into Chart, it will open a series 
window for each column of numbe rs. Like Multiplan data, if the 
first field is text, the first series window will be for the text field and 
the first numeric field. 

You can transfer summary reports to Chart for graphing, but 
you must use a somewhat roundabout method. First, save the 
report as a text-only file, as described in the next section. Quit File, 
run Word, and open the file. Remove all the headers so there is 
only data in the file. Select all the data and copy it to the Clip­
board. Quit Word, run Chart, and paste the data into the series 
windows. The step of editing out the headings in Word is, unfor­
tunately, not automatic, but it is necessary so the data will be 
transferred correctly to Chart. You should also be sure that your 
numeric fields are not formatted so that Chart knows that they are 
numeric, not text. 

Transferring File Output 
To Word 

Word can handle many kinds of File 
output. Since File can put text-only -+ 
files as well as records into the Clip-
board, you can use either method to Microsoft FHe Microsoft Word 
transfer data to Word. For reports, 
however, File will only write to a text-only fil e, not to the Clip­
board. 

The simplest kind of data to transfer from File to Word is plain 
records. For instance, you may want to show a group of records in 
a Word document. This is done with the Save Records command 
in the file menu or by copying the records to the Clipboard. Word 
can format the records with the table features, which is similar to 
formatting Multiplan output. 

Word can also read a text-only report file. Any report can be 
saved as a text-only file and opened in Word. To save a report as a 
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text-only file: 

1. Open the Report window and select the fields you want to 
report on. You can display the report with the Preview button. 

2. W ith the Report window open, give the Save Report As ... 
command in the File menu. Word presents a dialog box: 

Saue Report As: Hard Dislc 

[[ '>!WI' n Eject 
0 Specification 
® TeHt Output [ Cancel l nrim~ 

Click the Text Output button, give the report a name, and click the 
Save button. File then runs the report. 

3. I f you wil l want to use this same report form in the future, 
give the Save Report As ... command again and click the Specifi­
cation button. This saves the items in the Report window. 

4. Quit File and run Word. Open the report file and add any 
formatting you want, such as new tab rulers. 

You can also save records in a text-on ly file for use with Word's 
merge faci lity. To save space, remember to hide any fields that you 
do not need to use in your merge letter. Chapter 2 suggested ways 
you can creatively use numeric fields in your form letters. 

The Save Records As .. . command in the Fi le menu saves all 
the records in the datafile window in the order of appearance 
(remember to sort them first) . The command's dialog box looks 
like this: 

Saue Records As: 

Q Normal 
® TeHt (Microsoft Print Merge) 

Hard Dislc 

([ '>nut~ D j [ Eject 

[ Cancel J I [ Orillt' 

Click the Text button, give the file a name, and cl ick the Save 
button. Remember that this fi le w ill have a header containing the 
field names so that Word can use this fi le by itself. 



As you have seen in this chapter, File's record-storing capabil­
ity is a good match for the other Microsoft applications. It can be 
used with Multiplan to get the latest resu Its from a static database 
or it can produce its own reports. Like Multiplan, File can pass data 
to Chart so you can see drawings of your numeric data or summa­
ries of your databases. It can also be used as a mailing list for form 
letters in Word. You will find that File is an easy-to-use data 
handler for many of your business needs. 
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_______________________________ Chart 

N umeric data from File and Multiplan often needs to be pre- ~ 
sen ted in a clear, easy-to-read format. InC hapter 2 you saw 

how Word could help with this task by arranging numeric data 
Microsoft Chart 

into tables. To turn numbers into graphs, however, you need 
Microsoft Chart. 

Chart is based on the "data as pictures" concept to which 
many Macintosh owners have become accustomed. If you 
haven't used any computer other than a Macintosh, you may be 
surprised to discover that almost all other computers do not 
support graphics as a standard feature.lfyou also have Chart, you 
can produce a wide variety of sophisticated graphics on your 
Macintosh. To make graphs like those of Chart, users of other 
computers often need to spend hundreds or thousands of dollars. 

Chart's Advantages 
Chart produces graphs that can be used in Word documents or by 
themselves. The previous two chapters discussed many of the 
methods used to transfer information to Chart. Chart's greatest 
asset when used with File and Multiplan data is the speed with 
which you can produce results. Once you have run Chart, pasting 
the data from the Clipboard or the Scrapbook goes very quickly, 
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and selecting the kind of graph to produce usually takes less than 
a minute. The most tedious part is usu ally getting the labe ls, 
legends, and other text on the drawing in exactly t he right way, 
but you' ll see in the next chapter how MacPaint and MacDraw can 
make this much easier. 

Making graphs with Chart is so easy that you can feel freer to 
make mistakes, since correcting them does not take long. Fo r 
example, if you accidentally include an extraneous piece of data 
(su ch as a total in a totals column) , you can qui ck ly remove it after 
you see that your drawing is incorrect. If a pie c hart is lopsided, 
you can quickly fix it w ithout leaving Chart. You can also fix 
problems and do touch-up work in MacPaint or MacDraw. 

Design Considerations 
When you make a graph of your data with Chart, the type of graph 
you use will affect how the viewer sees the information you are 
presenting. If you show the data in only one way, the vi ewer may 
not think of othe r relationships that a differe nt kind of graph 
might have s hown. For example, two seri es graphed in a column 
or bar chart show comparison and contrast mu ch more dramati­
cally than the same series shown as two line graphs, which are 
better for showi ng trends over t ime. 

In addition, certain kinds of charts are based o n assumptions 
that your data may not share. For instance, pie charts present data 
as adding up to 100 percent of a certain valu e, while line graphs 
don't assume that data is added together. Thus, choosing o ne type 
of graph can hide some potentially useful interpretations of the 
data or be inappropriate for the data. 

Still another consideration is that graphs can hide a poor 
selection of data or can present data that is not really related. A 
combinatio n chart, for exampl e, may look correct even though 
the data fro m which it is created may not be re lated at all. 

The fo llowing guidelines may help you choose the types of 
charts best suited for your data; you' ll look at each type in de tail 
later in the chapter: 

• Line graphs are often used to show trends over time in data 
such as physical measurements, temperatu res, an d percent-



ages. This kind of chart can also illustrate the relationship 
between two or more series, such as advertising expenses 
and sales, by graphing them together. 

• Scatter charts illustrate the distribution of individual data 
points. 

• Pie charts show the contribution of each part to the whole. 
Like any type of graph, they shou ld not be used for series 
whose values are not related to each other. 

• Bar, column, and area charts are used to compare informa­
tion such as sales, inventory, or population growth. By stack­
ing bar and column charts, you can present the cumulative 
total of each series, whereas comparative bar and column 
charts (side-by-side) can illustrate the differences between 
series or present several different series of information for 
contrast. 

Entering Data Into Chart 
The previous two chapters showed you how to transfer data 
from Multiplan and File into Chart through the Clipboard. As you 
saw, Chart simply transfers each field of data into a series w indow. 
You can, of course, also type the data into Chart directly. You can 
edit the series windows using the standard Macintosh editing 
techniques. Once the data is entered, Chart's advanced features 
let you format it in many creative ways, which you' ll read about in 
the following sections. 

Paste and Link 
From Multiplan 

Chapter 3 showed the simple way to ~-··. ~ ~ 
transfer data from Multiplan to C hart: """? 
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Chart docume-nt 

copy a portion of a spreadsheet to the 
C.\ipboard, run Chart, and paste the Multiplan Microsoft Chart 

valu es into series windows. You nor-
mally save this chart and its data for future use. If the Multiplan 
spreadsheet used for the graph chan ges, you will need to go 
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through the procedure again to get the most recent results. 
If you know in advance that the spreadsheet you are using is 

going to be updated and that you will always want its most current 
data, you can use the Paste and Link command in Chart's Edit 
menu to tell Chart to go back to the original spreadsheet for the 
data each time you open that drawing. When you give the Open 
command on a Chart document whose data was created with 
Paste and Link, Chart reads the cells in the original spreadsheet to 
create the series windows. 

Use the following steps to paste and link a spreadsheet to a 
chart: 

1. Select the series data from your Multiplan spreadsheet and 
give the Copy command from the Edit menu. (If you have just 
created the spreadsheet, you must save it before copying the 
selection to the Clipboard so that Chart will know the Multiplan 
spreadsheet's name.) 

2. Quit Multiplan and run Chart. 
3. Give the Paste and Link command from Chart's Edit menu. 

This will create series windows just as the Paste command does. 
4. Make the drawing by clicking on the Plot Series buttons in 

the order you want. 
5. Give the Save As command in the File menu to save the 

drawing and series information. This will also save the information 
about the Multiplan spreadsheet that the series came from. 

You should be sure that the Multiplan spreadsheet from which 
you are reading data is on the same disk as the Chart document. If 
it isn't, Chart will present a dialog box: 

Con'.t re-estoblish link: "Pfrl test" 
not found on this uolume 

Hord Disk 

OK Eject 

Cancel 
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Insert the disk with the Multiplan spreadsheet and click the OK 
button. Chart will then read the data. 

Types of Chart Data 

Before you create series windows in Chart, you can assign a series 
type to the data. If you are not creating text series, such as a 
selection with text labels in the left column, you should select the 
series type in Chart before pasting in the data to prevent Chart 
from breaking your data into separate series windows. You specify 
the type of data for a window with the Sequence, Date, Text, and 
Number commands in the Data menu. 

The sequence, date, text, and number data types tell Chart 
how to format the category column (the left column) in the series 
window. The four commands also let you change the labels fort he 
series, the category column, and the value column (the right 
column). 

Sequential data must be numeric} and each category must be 
incremented by a preselected amount. You can set the initial 
value and the increment that each category will have: 

Sequence Series 

Series Name: 

Category Name: I H 
:========i 

Ualue Name: ._I Y _________ --' 

First Category: It 
L-----r=====i 

1 ncrement Each Category By ._It ___ ____. 

OK ( Cancel 

The defaults are for starting the categories at 1 and increasing by 1. 
You can also specify the same settings for date series: 

~ 
Chart document 
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Date Series 

Series Name: 

Category Name: 

Ualue Name: 

First Category:! L-A....:.p_r_8....:.,_1_9_a_s _________ __. 

Increment Each Category By 

® Years 0 Months 0 Days 0 Weekdays 

OK Cancel 

In a date series, you also specify the time increment. This is the 
unit oftime and the amount by which the time is to be increased 
for each value. 

If you specify a text or number series, Chart does not assume 
that the data is in a specific order or has incremental values. If you 
plot a text series first and then plot incremental series, Chart will 
assume that the incremental series corresponds to your text se­
ries. (You saw this in Chapter 3 when you plotted Multiplan data.) 

Chart's initial assumption is that the data you are entering is 
sequential starting with 1; if you paste other data into the New 
Series window, the windows that Chart forms will not be correct. 
For instance, assume that the following is data from a scientific 
experiment: 

.:? ......... : 
....... ~~.:? ,~ .. : 
.. .. ... ~~.:? ,4 .. : 
...... M.~,E? .. : 
...... M .E! ,I;l .. : 

If you p aste rows 2 through 5 of columns 1 and 2 into a drawing, 
Chart will form two windows: 



Series 2:21 :25 PM 
Order: 
D Plot Series 

X y 

12 
14 
15 
18 

Since the data in the first column is numeric, not a sequence, 
give the Number command in the Data menu before pasting the 
data. When you then paste the data into the New Series window, 
Chart will correctly associate the data in the first column with the 
data in the second: 

If you specify a type of data for the series window and try to 
paste in a different type of data, Chart will make its best guess and 
change the data type. For example, if you tell Chart that the New 
Series window will be numeric and then paste in text, Chart will 
change the window type to text. This may not be what you want, 
so you may have to experiment before getting Chart to accept the 
data correctly. 

Sorting Chart Data 

When you enter sequential and date data, Chart sorts the data in 
ascending order by category. This makes the categories in the 
resulting drawings appear from left to right (or top to bottom) in 
ascending order. 
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Number ... 

Rnolyze ..•. 
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If you are using data from Multiplan or File, you can bring it 
into Chart and sort it there. The Sort command in the Data menu 
lets you sort data in a variety of ways: 

• You can sort numeric and text series by categories. 

• You can sort any type of category in ascending or descending 
order. 

• You can sort the values in a series. 

When you give the Sort command, Chart presents the following 
dialog box: 

Sort 

®By Category 

0 By Uolue 

®In Ascending Order 

0 In Descending Order 

OK Cancel 

Choose the appropriate column to sort on and the order you 
want. 

Sorting numeric and text categories is usefu I if you are prepar­
ing a graph for use in a report written in Word. Long tables of 
equivalent rows are often sorted so that the reader can quickly 
find specific information. For instance, if you are showing both a 
sorted File table and a graph from Chart, it is good to show the 
graph in sorted order as well. 

It is uncommon to sort data series by values. The resulting 
drawing will have steadily increasing or decreasing slope, but the 
category values will be jumbled. This option is only useful for 
numeric or text pie charts. A pie chart whose values are sorted 
looks better than one in no apparent order. For instance, compare 
the following two charts: 



The sorted chart on the left presents the data in a more logical 
order. 

Analyzing Data Series 

As you saw inC hapter 3, Multiplan has many fu net ions for making 
calculations on rows or columns of data. Chart has many of the 
same capabilities. The Analyze command in the Data menu lets 
you create new series windows based on the data in other win­
dows. The types of analyses you can perform are listed in the 
command's dialog box: 

Analyze Series 

® nuerage 

OTrend 

0 Growth 

0 Cumulatiue Sum 

0 Difference 

0 Percent 

0 Statistics 

OK Cancel 

The series windows created with the Analyze command are 
usually used in combination charts with the original data. For 
example, if you have a bar chart of weekly sales, you may want to 
overlay it with a line graph showing the trend of sales from week 
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to week. You can also generate a series window of statistics to use 
in graph labels. 

The choices you have for analyzing data are shown in Table 
5-1. The most common uses for the Analyze command are to 
show trends, an average line, and the differences between incre­
mental values. You should remember that just as with the com­
puted data in Multiplan and File, the series windows created with 
the Analyze command are derived values, not actual data. 

It is easy to find uses for such derived values. For example, 
assume you have a graph like this one: 

50 

45 

40 

35 

30 

Amount 25 

20 

15 

10 

5 

0 

Daily sales 

9/9 9/10 9/ 11 9/12 9/13 9/1 6 9/17 9/18 9 / 19 9/20 
Date 

It may be hard for a viewer to figure out on which day sales were 
above or below average in this drawing. You can simplify the 
viewer's task by creating a series of the average of the values: 

Doily soles 
Order:cc:=:::J 
18:1 Plot Series 

Date 

9/10 
9/11 
9/12 
9/13 
9/16 
9/17 
9/18 
9/19 
9/20 

Amount 

36 
28 
39 
42 
22 
32 
36 
22 
50 

~0§ Aueroge of Doily soles § 

Order: 12 . I IQ 
18:1 Plot Senes 



Table 5-1. 
Types of Analysis in Chart -----------------

Type 

Average 

Trend 

Growth 

Description 

Series of identical points that are the average 
of the data 

least-squares approximation of the straight­
line trend of the data 

Exponential growth-curve approximation of 
the trend of the data 

Cumu lative Sum Sum o f each member of the series. Each value 
of the new series is the previous value plus the 
data from the original series 

Difference 

Percent 

Statistics 

Differences between each pair of values from 
the series 

The percent of the total of the original series 

A compilation of statistics on the series, 
including number of values, maximum, 
minimum, average, median, standard 
deviation, and correlation coefficient 

Click the Plot Series button; then click on t he chart. Give the 
Overlay C hartType command in the Chart menu to set the type of 
the overlay chart to a line chart. The result is this: 

50 

45 

40 

35 

30 

Amount 25 

20 

15 

10 

5 

0 

Daily sales 

9/9 9/10 9/11 9/12 9/13 9/16 9/17 9/18 9/19 9/20 
Date 
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~ 

If your data is supposed to show a linear tre nd, use the Trend 
button in the Analyze command to create a tre nd series. O verlay 
th at series o n your origin al data. For example : 

50 

45 

40 

35 

30 

Amount 25 

20 

15 

10 

5 

0 

Daily sales 

9 / 9 9/10 9/11 9/12 9/1 3 9/16 9/17 9 / 1 B 9/19 9 /20 
Date 

Types of Charts 
In the Gallery 

Chart docum~nt 

As me ntione d be fo re, the type of chart you choose can affe ct the 
relatio nships a viewer sees in the data. Since you may be transfer­
rin g complex data from File and Multiplan, it is important to 
determine w hat type o f chart you want to use based o n th e kind of 
data you have and the kind of comparisons be ing made. 

The fo llowing discussion covers the charts that can be selected 
with the commands in the Gallery me nu. Each type of chart has a 
number that is displayed in t he galle ry. 

For Simple Data 

Most o f C hart's grap hs are appro priate for use with simp le row or 
column data, o r for series t hat are parts o f a whole, such as 
mo nthly sales in a given year. Depending o n your applicatio n o f 
the d ata, t he re are many graph styles to choose fro m. 

The most commo n simple graph is t he pie chart. All types of 
pie charts are useful for graphing simp le row or co lumn data, as 
lo ng as that data adds up to a total. The viewer of a pie chart 



compares the data by comparing the pieces of the pie. Thus, pie 
charts are especially useful when there are a few categories of data 
with wide-ranging values. If the values are close toget her, a bar or 
column chart w ill probably show the differences better than a pie 
chart. 

For exam ple, assume you have the following data: 

A pie chart of this data wou ld look like this: 

Because the values are so close, it is hard to te ll the difference 
between th e pieces of the pie. However, a column chart of the 
same information would look like this: 

400 

300 

200 

100 

0 
2 3 4 
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Although the bars are almost the same height, it is easier to see 
which is tallest, shortest, and so on. You could make it much easier 
to see by using smaller intervals in the chart. 

Table 5-2 lists the types of charts appropriate for simple row or 
column data or for series that are parts of a whole. Basically, all 
charts that use data that can be thought of as adding up to 100 
percent will work. 

For More Complex 
Array Data 

All of the chart types (except for pie charts) are useful with 
two-dimensional (array) data and for graphing several unrelated 
series together. The specific type you use in any given situation 
should depend on 

• The relation of the elements in each series 

• Whether or not the series represents a total 

• The importance of a particular series in the data. 

The easiest way to decide which type of chart you want to use is 
simply to experiment with them. 

Table 5-2. 
Types of Charts Appropriate 
For Simple Row or Column Data -------- -----

Type 

Area 

Bar 

Column 

Line 

Pie 

Scatter 

Appropriate Types 

1, 3, 4, 5 

1, 2, 4, 6, 7 

1, 2, 4, 6, 7, 8 

1, 2, 3, 4, 5, 6 

All 

1, 2, 3, 4, 5 



Some of the chart types assume that the series you are using 
are additive. For instance, someone viewing bar chart type 5 (100% 
stacked) will assume that the value of each complete bar is the 
same; if it isn't, the viewer will be quite confused. The additive 
charts are area type 2, bar type 5, and column type 5. 

Scatter drawings are generally used with number series, since 
they have nonincremental columns and rows. These are espe­
cially useful in scientific research for showing points of data and 
are rarely used in business and finance. 

As you saw earlier, Chart lets you combine chart types if you 
have more than one series. This can be useful not only for sum­
mary data generated by Chart, but also for summary data that you 
may have included in your data. If you are reading information 
from Multiplan, you can generate the statistics beforeyou transfer 
the data to Chart. 

You can use overlaid charts to emphasize the difference 
between series. For instance, if a column chart shows the expendi­
tures of a company over the year, you can show the intended 
budget for the same period as a line graph: 

Quarterly sales 

500 

400 

300 

Amount 

200 

100 

0 
Oct , 1985 Jan, 1986 Apr, 1986 Jul , 1986 

Starting 

Using a different type of chart makes dissimilar data much more 
understandable. If you had simply used another column, the 
comparison would not have been as clear: 
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500 

400 

300 

200 

100 

0 
Jul, 1985 Oct, 1985 Jan, 1986 Apr, 1986 

The Combination command in the Gallery menu gives you 
four suggestions for common combinations of charts. If you are 
creating your own combinations of charts, experiment with the 
formatting choices in the Main Chart and Overlay Chart com­
mands in the Format command menu. 

Transferring Graphs 
From Chart to Word 

Unless you simply print out your charts, 
& -+ it is likely that you will want to include 
~ them in your Word documents with 

M;crosoft Chart M;crosoft 'w'ord the data they were derived from. As 
you might guess, it is fairly easy to 

transfer a graph to Word through the Clipboard. Simply select the 
graph and give the Copy command to put it in the Clipboard. 
Word cannot read a Chart document directly. 

As you will see in Chapter 6, you will probably want to transfer 
Chart's drawings to MacPaint or MacDraw before you put them 
into your reports. Since some of Chart's commands for placing 
text labels and legends can be awkward to use, it is easier to add 
your text in MacPaint. 

Chart's ability to take data from File and Multiplan makes it 



easy for you to create graphs. You will find that they are a useful 
aid in presentations and reports. You can include tables of figures 
in Word documents and can also include drawings of that data 
just as easily. You can graph data quickly as you work with it, seeing 
for yourself the trends and tendencies of the numbers you're 
working with. Chart provides a wide variety of graphs and allows 
you to experiment easily with the different types and formats. 
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Using MacPaint and MacDraw 
With the Microsoft Applications 

B ecausethe end result of integrating Word, Multiplan, Fi le, and 
Chart is often a report or memo, you will want your work to 

look as good as possible. Although the Microsoft appli cations 
create high-quality output, you can use MacPaint and MacDraw 
to add embellishments, such as labels and highlights, with very 
little effort. 

Introduction to 
MacDraw's Features 

Since MacPaint comes with the Macintosh, you are probably 
familiar wit h its use and basic features. MacDraw, on the other 
hand, was not released until more than a year after the Macintosh, 
and fewer people have used it. This section is a quick introduction 
to the features of MacDraw that make it useful with the Microsoft 
applications. 

Many of the drawing concepts of MacPaint are used in Mac­
Draw, so a MacPaint user can probably start using MacDraw fairly 
quickly. The most significant difference is that MacDraw is object­
oriented. MacDraw treats each pixel, which is the smallest part of 
a picture, as an object that can be manipulated. While this is 

MacPaint 

MacDra'Vt 
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similar to the selection concept in MacPaint, it differs in that 
MacDraw always remembers the boundaries of each object with­
out your having to specify them. 

Objects can be enlarged or shrunk in MacDraw without the 
jagged edges that appear when you enlarge selections in Mac­
Paint. For instance, assume you are working with a shaded 
rounded rectangle : 

In MacPaint, when you enlarge the shape a little, the pattern 
inside the rectangle enlarges unevenly: 

In MacDraw, the pattern remains constant, and only the object 
gets bigger: 

When you type text into MacDraw, the program remembers 
that it is text and does not turn it into pixels as MacPaint does. You 
can type in some text, add a picture to another part, and then 
come back to the text and change the font and size. This feature is 
especially useful for adding or changing labels on Chart graphs 
and File or Multiplan tables that you are going to use in Word. 

MacDraw can read large images from the Clipboard. If you 
copy an image from Chart with the Copy Chart command, it may 
be larger than the MacPaint window. Although you can get 
around this (as shown later in the chapter), you don't need to 
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worry about it in MacDraw, since you can paste in a picture as 
large as MacDraw's page. MacDraw can also scale pictures to be 
larger than a fu II screen, so that you can scale a chart that is almost 
a full page and paste it into Word. 

When you paste a Chart graph into MacDraw, each element in 
the graph is stored as an object. You can move labels one at a time 
and easily change the pattern of each section of the graph. All text 
is movable, and the axes can easily be modified. 

I fyou are usingMacPaint to prepare images that you will use in 
Word documents, you should definitely consider buying Mac­
Draw. The tools that you can access in MacDraw make editing and 
revising drawings mu ch simpler than in MacPaint. 

In general, you will find that you will use both MacDraw and 
MacPaint to touch up and add to the output of Microsoft applica­
tions. MacDraw gives you many features that MacPaint doesn't; 
some of the following suggestions, however, will only work with 
MacPaint. 

Pasting Chart Output 
Into MacPaint and MacDraw 

If your Chart graph uses the standard- & 
MacPaint 

sized Chart window, you can copy it ~ -+ 
into the Clipboard and paste it directly Microsoft Chart ~ 
into MacPaint.lfthe window is larger, ~ 
pasting the graph into MacPaint may MacDraw 

cut off its edges. Pasting into MacDraw always works just fine, 
however. 

A Chart graph becomes large r when you include a legend and 
text labels. As you will see in this chapter, it is usually just as 
convenient to add these with MacPaint and leave the Chart draw­
ing at its original size. Chart limit-s the size of your drawing, not 
including text and legends, to 21/2 inches by 41 /2 inches (6.3 em 
by 11.4 em) . This will always fit into the MacPaint window. 

In case you want to save a larger area instead of using the 
Clipboard, press COMMAND-SHIFT-3 to save the screen image as a 
MacPaint document and edit that. You can easily remove the 
unwante d screen borders with MacPaint by sele cting them and 
giving the Clear command in th e Edit menu. 
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Editing and Augmenting 
Chart Graphs ~ 

~ Once you are running MacPaint or 
~ MacPaint MacDraw, all of its features are avail-

~ ~ ~ able for changing or adding to the 
Microsoft Chart · · ·. · graphs you create with Chart. Of 

MacDraw course, you can do almost anything to 
the graph with MacPaint; the limits are mostly your imagination 
and patience. The following are suggestions about the most 
common uses for MacPaint and MacDraw with Chart images. 

Adding Text 

MacPaint and MacDraw give you much more freedom than Chart 
in adding text to graphs. On the simplest level, Chart restricts you 
to the Geneva, New York, and Chicago fonts, while MacPaint and 
MacDraw let you use any available Macintosh fonts. MacPaint and 
MacWrite also provide more sizes of fonts. The fonts you use for 
graphing may be stored in the System file or attached to MacPaint 
or MacDraw with a utility like the Font Librarian. 

In MacPaint, you can move text around your graph by select­
ing it with either the marquee or the lasso and dragging it. In 
MacDraw, you select the entire text object by selecting anywhere 
on it and dragging it around. If you want the text to be turned 
sideways, you can rotate it after typing it in. Remember to use the 
various text styles (such as bold or underlined) to differentiate the 
different types of text on the screen . 

40 

35 

30 
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20 
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/"/on til 
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Cleaning Up Drawings 

It is often useful to touch up rough edges in a Chart graph using 
MacPaint's FatBits mode. Jagged lines or rough edges can easily be 
touched up pixel by pixel. You may even want to add some small 
anomalies to make the chart look slightly less "sharp." 

If you realize after producing a drawing that you included 
extraneous information, you can use MacPaint or MacDraw to 
remove it from the drawing. For instance, assume you want to 
remove the third bar from the following drawing: 

45 

40 

35 

30 
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20 

15 
Aug , 1985 Sep, 1985 Oct, 1985 Nov, 1985 Dec, 1985 

Use the marquee to select the fourth and fifth bars, hold down the 
SHIFT key to constrain the movement of t he selected area, and 
drag the selection to the right. 
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Aug , 1985 Sep, 1985 Nov, 1985 Dec , 1985 

The same procedure can be performed in MacDraw by elimi­
nating the bar object with the Clear command, grouping together 
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all of the e lements to the right of the bar, and moving them left. 
A more important MacPaint application is to highlight the 

differences between the heights oft he columns or bars in column 
and bar charts. This is done by changing the scale of the columns 
or bars. Chart normally draws the values of a series with 0 as the 
minimum value. 
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You can change the minimum value with the Axis command in the 
Format menu, but the results can be mislead ing. 
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The viewer may not notice that the data does not start at 0. 
To make this clearer, copy the graph into MacPaint and add a 

jagged edge to the bottom of the axis and bars: 
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9/9 9/10 9/11 9/12 9/13 9/16 9 / 17 9/18 9/19 9/20 
Datl' 

On a line chart, you only need to indicate t he break at the axis : 

30v y 
25 . 

201 

0 
9 / 9 9/10 9/11 9/12 

This is the standard of indicating a nonzero minimum value. 
Using Chart to create a legend may give unsatisfactory resu lts. 

The Add Legend command creates legends that show only the 
name of each series and its associated pattern. Instead of making a 
legend in Chart, you can usually create a more informative legend 
in MacPaint. You can copy the patterns from the chart and add the 
legend text you want. You can also place the text for the legend 
beneath o r to the leh of the pattern. 

Borders 

In any long report, you need to e mphasize important material to 
make it stand out from the rest. You often do this when you write 
by using more forceful words and phrases or by using italic or 
boldface type. To emphasize a drawing (or parts of a drawing) you 
can surround it with a border. 



116 Macintosh Paperwork: Integrating Microsoft Produd s 

The e asiest way of adding a border in MacPaint or MacDraw is 
w ith the rectangle tool. Sim ply start at one corner and drag to the 
opposite one. Once the border is drawn, you may need to move 
the image to center it properly. For a softer effect, use a rectangle 
with rounded corners. 

A thin border is useful for separating a picture from text; a 
heavier border adds emphasis. To draw a heavy border, select the 
thicke r line styles in MacPaint or MacDraw. The usual practice is to 
surround the chart title with a thin border and use the heavy 
border for the entire chart: 
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There may be times when you do not want your work to look 
plain or conservative, and it doesn' t have to. MacPaint and Mac­
Draw give you plenty of ways of adding interesting borders to any 
e lement in your chart. For instance, compare the following chart 
with the previous one: 
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Many Macintosh clip-art packages, such as Mac t he Knife from 
Miles Comput in g o r C lickA rt fro m T /Maker, include deta il e d 
deco rat ive borders. 

Borders can give a variety of impress ions, so you should 
choose your bo rde rs carefully, co nsidering the context of the 
report and the data's re lative importance. For example, compare 
these light decorative bo rde rs 

to these heavie r designs: 

In many cases, th e fact th at you are including a graph is enou gh 
to draw the read er's att ention. Howeve r, if you are preparing 
many graphs for a report or many overhead tr ansparencies for a 
presentation, conside r usi ng borders to emphasize the charts. 

Enhancing Tables 
With MacPaint 

Word's adv anced formatt ing features 
are very handy for tables from Fil e and 
Multiplan. However, a report w ith 
many tabl es can eas ily seem du ll and 
hard to read even if th e tables are for-

Microsoft File Multiplan 

· --) ~ 
Microsoft \v'ord MacP aint 
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matted well. To highlight important data, you can transfer the File 
and Multiplan tables into MacPaint. (This is not easy in MacDraw, 
since text is handled in one large chunk.) 

For example, you might have a table like this in your Word 
document: 

1985 Sales by Region 
Q 1 Q2 Q3 Q4 Total 

Pacific 12593 16200 15467 16850 61 110 
Southwest 8300 16825 13690 15303 54118 
Mountain 7231 14293 13994 12089 47607 
Central 10173 14872 10842 14220 50 107 
South 4219 9024 10429 7757 31429 
Northeast 9311 11554 8333 10632 39830 
Total 51827 82768 72755 76851 284201 

You can add vertical and horizontal lines and move the heading 
up a half line to create a more readable table: 

1 985 Sa 1 es by Region 
Q 1 Q2 Q3 Q4 Total 

Pacific 12593 16200 15467 16850 61110 
Southwest 8300 16825 13690 15303 54118 
Mountain 7231 14293 13994 12089 47607 
Central 10173 14872 10842 14220 50107 
South 4219 9024 10429 7757 31429 
Northeast 9311 11554 8333 10632 39830 
Total 51827 82768 72755 76851 28420 1 

later in this chapter you'll see other ways you can enhance your 
tables. 

Adding lines to a table is simple, once you get around the 
Clipboard' s inability to transfer a formatted table from any of the 
Microsoft applications to MacPaint. You need to turn your Word­
formatted table into aMacPaint docume nt, modify it in MacPaint, 
copy the MacPaint-enhanced table to the Clip board, and transfer 
it back to Word as a MacPaint image. 

To enhance a formatted table, fo llow these steps: 

1. Create the table from File or Mu ltiplan data and save it to 
the Clipboard. 
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2. Quit File or Multiplan, run Word, and p aste the data into a 
docume nt. 

3. Format the data as you please using Word's tabs. Th e table 
must be narro w eno ugh to fit in the MacPaint window, which is 5.7 
inches wide by 3.2 inches high (14.5 em by 8.1 em). 

4. Create a MacPaint document of the current screen by 
pressing COMMAND-SHIFT-3. Be sure that the 1-beam pointer and 
the insertio n point are not in the table when you do this. 

5. Quit Word and run MacPaint. Open the MacPaint docu­
ment called Screen 0. This is an exact copy o f t he Word screen 
when you pressed COMMAND-SHIFT-3. 

6. Position the MacPaint window over the table, select the 
t able with the rectangular marquee, and give t he Copy command 
in the Edit me nu. 

7. C li ck the close box of the w indow to close the Screen 0 
document. Select New from t he Edit me nu; then give the Paste 
command to put the table into this unnamed document. 

8. Add lines to the table with the lin e or box tools (this is 
detailed in the following discussion). 

9. When you are finished, select the e nti re table with the 
lasso. Give the Copy command to put the new table in the Clip­
board. Quit MacPaint (you can savethe M acPaint document oft he 
new table if you wish) and run Word. 

10. Paste the new table into your Word document. 

The line and box tools allow you to add lin es to your tables 
easily. To draw horizontal o r ve rtical lin es, ho ld down the SHIFT key 
whil e you draw. In FatBits mode, check that t he ends of t he new 
lines are lined u p. You can also do this by selecting the jagged 
edges of the lines with the marquee rectangle and giv ing the 
Clear command in the Edit menu. 

If your table has a row of text as column headers, you may want 
to move that t ext up a few pixe ls and in sert a thicker lin e between 
it and the othe r text. Select a thicker line from the lin e-w idth 
selectio ns at the lower- left corne r of the MacPaint screen. 

Future versions of Word may allow you to paste formatted text 
into the C lipboard as pictures. In this case, you would simply paste 
a copy of the formatted table into the C lipboard, qu it Word, and 
then run e ither MacPaint or MacDraw. 
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Other Embellishments 
For Word Documents 

Just as there are many ways you can 
~ ~. ·. enhance Chart graphs, MacPaint and 

~ MacDraw can enhance text in a Word 
Microsoft 'w'ord MacPaint MacDraw document to add emphasis or just to 

make it more pleasant to read. 
As described earlier in this chapter, the only way to move 

formatted text to MacPaint or MacDraw is by saving the screen 
with COMMAND-SHIFT-3. If the text you are embell ishing is not 
formatted, you can type it in while in MacPaint or MacDraw. 
Transferring such unformatted text through the Clipboard from 
Word to MacPaint or MacDraw is clumsy and often produces 
unusable resu lts. 

In a Multiplan or Fi le table, there may be pieces of data that 
you want to emphasize. A simple rectangular box around the 
element in the table will do th is. For example: 

1985 Sales by Region 
q 1 Q2 Q3 Q4 Total 

Pacific 12593 16200 15467 16850 61110 
Southwest 8300 16825 13690 15303 54118 
Mountain 7231 14293 13994 12089 47607 
Centrel 10173 14872 10842 14220 50107 
South 142191 9024 10429 7757 31429 
Northeast 9311 11554 8333 10632 39830 
Total 51827 82768 72755 7685 1 28420 1 

You might want to box a column or row in t he same manner. You 
can even emphasize an already boxed item in a box with a 
double- line box: 

1985 Sales by Region 
Q1 Q2 Q3 Q4 Total 

Pacific 12593 16200 15467 16850 61110 
Southwest 8300 16825 13690 15303 54118 
Mountain 7231 14293 13994 12089 47607 
Centrel 10 173 14872 10842 14220 50107 
South 4219 9024 10429 7757 3 1429 
Northeast 931 I 11554 8333 10632 39830 
Total 51827 82768 72755 76851 284201 

As you saw before, you can produce interesting borders with 
MacPaint. These borders, of course, can also be put around tables, 
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and it is common to use borders around headings and on the title 
pages of reports. Figure 6-1 shows more border d esigns that you 
may want to use. 

A slightly less dramatic variation is simply to use corners 
around a table. The process of creating corners is the same as for 
borders. A corner works well around small tables w here a border 
may seem like too mu ch: 

Pacif i c 
Southwest 
Mountain 
Central 
South 
Northeast 
Total 

01 
12593 
6300 
7231 

10173 
4219 
9311 

51627 

I 965 Sales by Region 
02 03 04 

16200 15467 16650 
16625 13690 15303 
14293 13994 12069 
14672 10642 14220 
9024 I 0429 7757 

11554 6333 I 0632 
62766 72755 7665 1 

Tota l 
6 1110 
54116 
47607 
50107 
3 1429 
39630 

~~.~;;~s~s~ 

Figure6-1. --------------------------­
More border designs 
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It is not necessary to surro und text complete ly in orde r to 
emphasize it. You can also use rules, horizontal lines that set off 
text fro m other text. In Word, a rul e is treated just like a text 
paragraph, and you can copy o ne rule to many pl aces in your 
reports. A rule can be as simple as a sin gle line o r it can have a 
pattern. Since you are not affecting the text that the ru le goes 
around, you can des ign a rule in MacPaint, paste it in the Clip­
board, and insert it above and below a text paragraph. 

Fo r example, you can design a simple rul e su ch as this: 

:ass SS3B35SE8888885655688ECF 555 Be eSFF85 8F 

Instead of boxi ng entire tables, p lacing the rule above and below 
the table ca n set it off almost as well as a border: 

Pacific 
Southwest 
Mountain 
Centra l 
Sou th 
North eas t 
Tota l 

383::5855 :;cs:ssu::;:ea== == =sss=s==s==ss=s=sssss 

0 1 
12593 
8300 
723 1 

10 173 
42 19 
93 11 

5 1827 

1985 Sa l es by Region 
0 2 03 04 

16200 15467 16850 
16825 13690 15303 
14293 13994 12089 
14872 10842 14220 
9024 1 0429 7757 

1 1554 8333 1 0632 
82768 72755 7685 1 

~s:s::sc ss 888a3:as:s= ss =aasesssessaasesesess::: 

Tota l 
6111 0 
54118 
47607 
50107 
3 1429 
39830 

28420 1 

MacPaint and MacWrite ca n make C hart graphs and tables 
fro m Wo rd, File, or Multiplan look more attractive. They can also 
be used to enhance headings, t itle pages, me mo d istri but io n 
boxes, and text in documents you create w ith Word. The various 
tools in MacPai nt and MacD raw let you easi ly add d etail to (or 
subtract data fro m) your drawings and tables. You can also add 
decorat ive borders to text and drawings to e mphasize part icu lar 
e lements. 



Part II ____ _ 



________________________________ Exampl~ 

The fo llowing seven chapters show many typi cal situat io ns 
w here you want to integrate the functio ns of Wo rd, Mu ltip lan, 

File, and C hart. The examples cover a wide range of uses of th e 
Microsoft applicatio ns and come fro m many areas o f business. As 
you read throu gh the procedures used in these chapters, t hink 
abo ut how these exampl es might apply to your work and your 
uses o f theM icrosoft app lications. 
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Tbt t otlwina t"<) plans ladic&Le Lbt arctutKft lruthJ aodeh for lb.t 
Uyoul ollbl pro~tiu Tbe eo~U for lbt two plant dllftr, 11 ladJcllf'd i.e 
lbe l!ltl'l NCtloft 

PJuA 

PIID I 

Dy!ldlt!t puu •!!d l ul!uttd pmt 

Dtpend.IAa oc lbt buildlfll ptu Chow.!. lbt CCitU d buUdl.tta fdtboa t 
Oudtu will bt bttvtta UMN ud SZ.SMN, ud lbt t lt pHd Umt for tbt 
pro}tc1 II I.C to 16 CD.ODt hl . WtUir Cttltlbll l.btN tttJmu .. 1.1W ti'Jtutt lh t t 
Ult protfC1 1.1JU bt finandllly l uccttalul. Tbe t lapttd tlmt, whl.lt Joflatr llli.O 
IVtr&lt for de'VttopmtDII IUch II lbll , &\'It \ht crmll&dal IDOUih tJICt 
tJmt dutlnl ll'lt rtlny tUIOft to tiW bt completed O:lliCht GIIIt . 

Sl1t pnp 
Pllut l 
PhiM2 
Plluo J 
Wovt4 ia 

BuUdJ.AICCittt 
Plt.r:l A C:Ot ll Moalht 

I I 00,000 l-' 
l l2l.OOD i 
16Jl,OOO ).) 
1690,000 • 
17~.000 I 

Plan I 
SJ2o,ooo 
1&10,000 
16n.ooo 
un.ooo 
17~.000 

Tou1 12.on.ooo 
CcoVmoolll 11 H ,6H 

l i 12,)0~.000 

l !l6.~6) 

Moow 
1J 

' JJ 
~ 
I 

16 



---------------Real Estate 
Development Report 

Microsoft File Multiplan Microsoft Word MacDraw 

W eller Real Estate Co. wants to develop a small parcel of 
industrial land into a multi-unit townhouse project call ed 

Fairhome Gardens. The block now has three warehouses and 
many occupied and abandoned single-family houses. The town­
house project would have 14 units, including a pool and gardens 
in the common area. 

Weller's financial backers want a report on the various costs of 
developing the land. The considerations are the range of costs of 
purchasing the land and the expected cost of building the town­
houses. Weller's architect has two layout plans that affect the 
building costs of the units; both of these plans must be included 
in the final report . 

1. Collect the data for the current land in a File database. A 
portion of that database is as follows: 

127 
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I nttod uction 

Development Report for 
Fairhome Gardens 

Weller Real Estate Co. 
and 

Fairhome Equity Associates 

Weller Real Estate Co. proposes to build a modern townhouse 
community on the 3200 block of DeSoto Street in North Fenton. The homes 
will be plush, high-quality living areas that share a common pool and garden 
area. These attractive units should sell well in the up-and-coming North 
Fenton area. 

We propose to buy all of the residential and commercial property on 
that lot and finance the development through the Fairhome Equity 
Associates limited partnership. The land is currently under-utilized, and this 
development will add a great deal of class to the neighborhood. We have the 
full support of the city council and the board of adjustments in our plans. 

Purchasing the land 

The block to be developed currently consists Qf occupied and 
abandoned single-famlly dwellings, three warehouses, and two easements. 
The unoccupied houses and easements are currently over-valued, and can 
probably be bought at below the market prices. 

Because of the nature of the property values in North Fenton, Weller 
believes that there is potentially a 251 variability in the land values for the 
occupied houses and the warehouses. There is probably only a 101 
variability in the values for the abandoned buildings and the easements. 

The following data on the buildings was obtained from the North 
Fenton Oty Assessor in OCtober, 1985. The low and high estimates or the 
costs for buying the property were generated b'y Weller. 
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:0 Current Lond 
Po reel • Tl.lPe Occ. Volue Notes lQ 

1 G4302 H N $20,000 
2 G4595 H v $38,000 Orig. owner 

/!ill! 3 L7200 w v $ 15,500 Frome onl y, berely used 
4 G3722 H N $ 18,000 

ij!li' 
5 L9774 w v $80,00 0 Chemi ca l storage 
6 G0024 0 N $8,300 T iny vec ent lot 
7 G4304 H N $24,900 lQ 

16/1610 1 I~ ~ 

The fields of the database are 

• Parcel t! - The city's identification of the parcel 

• Type-Current use of the property (values are " H" for 
home, "W" for warehouse, and "0" for other) 

• Occupied-Whether or not the building is in use (values 
are "Y" and "N") 

• Value-Assessed value of the property 

• Notes-Other information on the property 

2. Design a File report so that summary information can be 
passed to Multiplan. If a building is in use, more costs w ill be 
associated with it than if it were unoccup ied. Thus, the report 
must be a summary of the types of property, broken down by 
whether the buildings are occupied. 

Since the data will be used by M ultiplan, remember to use 
general format with no commas or dollar signs for the total of the 
values. The File report fo rm looks like this: 
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Land costs 
Type Occupied Value Low est. High est. 
House y $136,100 $102,075 $170,125 
House N $157,100 $141,390 $172,810 
Other N $9,300 $8,370 $10,230 
Warehouse y $231,700 $173,775 $289,625 

Total: $425,610 $642,790 

OVerview of the Building Site 

The following two plans indicate the architect's initial models for the 
layout of the properties. The costs for the two plans differ, as indicated in 
the next section. 

Plan A 
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3. Open the Report window and then select Save Report 
As ... from the File men u. Name the text-only file and then click 
the Text Output button. File saves the report on disk. 

4. Quit File and run Word. Open the file you just created: 

_o Untitled 

Land costs 
Type Occupied Value Low est. High est. 

$170,1 25 
$tn,a t o 

$ 10,230 
$2a9,625 

House Y $ 136, 100 $102,075 
House N $ 157,100 $141,390 
Other N $9,300 $a,370 
Warehouse Y $2 31,700 $17 3, 775 

Total: $42 5,610 $642,790 

Select the e ntire file; then select Copy to put it in the Clipboard. 
(This step is necessary because Mu lt iplan can't read a text-only 
file, and File can' t write a report directly into the Clipboard.) 

5. Quit Word and run Multiplan. Select Paste to bring the data 
into a new spreadsheet. 

Untitled 
I 2 I 3 I I 

J_ ~~~;~::::::::: )~~~~~~~~~:::: ) ~;:~~~~~~~::::): :::::::::::: ::i 
3 H :y : 136100 : : ......><--- .... . . " .. . .... " ....... . ........ "" ... ..... "" ...... " ...... . 
4 H :N : 157100 : : -::-- ........ ....................................................... . 
5 0 :N : 9300 : : 

6 w::: :::::::::: :y:::: ::::::::::::::: ~~:(?i:i9::::: :::::::::::: :; 

Row 2, the unde rlines, is not usefu l, so remove it by selecting it 
and then selecting Cut. 

6. Create columns for the high and low estimated costs of the 
property. We ller's assumption is t hat the cost of the occupied 
property may vary 25 perce nt from the assessed value, while the 
cost of the unoccupied property will vary o nly 10 percent. These 
formu las go in columns 5 and 6. For example, the formula in cell 
R3C5 is " = 0.75*RC([- 2)". 

To make the spreadsheet look better, chan ge the text in the 
Type column to " House", "Other" , and "Warehouse". Since the 
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Plan B 

Building Costs and Estimated Time 

Depending on the building plan chosen, the costs of building Fairhome 
Gardens will be between $2MM and $2.5MM, and the elapsed time for the 
project is 14 to 16 months. Weller feels that these estimates will ensure that 
the project will be financially successful. The elapsed time, while longer than 
average for developments such as this, give the contractors enough slack 
time during the rainy season to still be completed on schedule. 

Building costs 
Plan A costs Months Plan B Months 

Site prep. $100,000 1.5 $120,000 l.S 
Phase 1 $525,000 4 $810,000 s 
Phase 2 $635,000 3.5 $675,000 3.5 
Phase 3 $690,000 4 $825,000 5 
Move-in $75,000 1 $75,000 1 

Total $2,025,000 14 S2,SOS,OOO 16 
Cost/month $ 144,643 StS6,S63 
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goal of this spreadsheet is to determ ine the amount that w ill need 
to be spent, make totals for columns 5 and 6. Format all of the 
amou nts as dollars with no decimal places but with commas. The 
spreadsheet should then look like this: 

2 3 4 5 6 

. . . . . . . . . . . . . . : . . . . . . . . . . ... . . .. :~~n~ .99~.~-~ ... ... . . . .... . . . . ... .. . . . . . . .. . ........ . .. . . 
!.YPL .. .. . ;Q,qQyP.i~.~ .. . .. .. :Y.~ 1.4L .... ...... .. ..... .. . .. .. . : ~~-~- ~.~\ ........... : t~.i9.~ .~~ !, .. ... ... . 
tl.~~~~ ....... ; ........ Y ...... .. : .... $.1.~!'! . ! QQ.. .. ... ........ .. . ; ...... $.1.Qii:.9!:::; .. ; ..... . $.1.7Q,! ;::s .. 
tl.~~~~ .. ' .. ' ': ' ' .. ' ' ' .J:I. ' ' ' .... : . .. . $.1,::;!,! QQ.. .. ....... ...... . : .. .. ' .$.1.1.1 .• ~~Q. ': '.' .. . $.1.7ii:.fi1.1.Q .. 
9.t.~~r . ... . . : .... .. .. J:I .... . ... : .•. . .•. $~.~QQ. . . .. ... . •. .. .... . ; .. .. .... . $!'l .~i:Q . . : .. .. ... ~! Q.~~Q .. 
Y(~r.~~9~.~~ .: ..... ... Y ....... . : .... $ii:~.1 .• 7QQ.. .. . .. .. .. .. ... . . : .. .... $.1.7~ .n::; .. : .. .... $;::~~ .~;::::; .. . . ' 

' . :::::::::::: :~ ::::::::::::::::: ~ : ::: ::::::::::::: ~ i~i~i : : : : : : : : :::: : : :: ::$~~~;~):9:: ~ :: ::: :$~~~:7~9: : 

7. Select t he active area of the spreadsheet (rows 1-8 and 
columns 1-6) and select Copy to put it in the Cli pboard. Save the 
spreadsheet; if the data on land use changes, re membe r to 
change the records in Fil e, run the report again, and re-create the 
spreadsheet. 

8. Quit Multiplan and run Word. Paste the spreadsheet into a 
new document and fo rm at the table. The result could look like 
this: 

0 

Type Occu pied Value 

H 
H 
0 
w 

y 
N 
N 
y 

136 100 
157100 
9300 
23 1700<> 

You can, of course, format the information however you please. 
After it is writte n, position the b eginning of the report around the 
table. 

9. You also want to add the arch itect's p lans that were drawn 
in MacDraw. Qu it Word, run MacDraw, and open the docume nt 
containing the first p lan. 
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Select the entire plan with the Select All command in the Edit 
menu; then select Copy to put it in the Clipboard. Open the 
Scrapbook desk accessory and select Copy again to put the plan in 
the Scrapbook. Close the Scrapbook and the document, open the 
document containing the second plan, and copy that into the 
Clipboard. 

10. Quit MacDraw and run Word. Move to the position in your 
document where you want to put the second plan (since that is 
what is in the Clipboard) and select Paste. Move to the position for 
your first plan. Open the Scrapbook, select Cut, close the Scrap­
book, and select Paste. Fill in the text around the two plans. 

11. Quit Word and open the Multiplan spreadsheet again. Add 
the data for the building costs and times of the two plans. Include 
totals for the columns and average cost per month for the 
projects . 

. . . . . . . . . . . . . : . .. .............. : . . . . . . . . . . . . . . . . . !3.4i.l~.i!l.9 .c<l?~~~- . . ..... ............ . 
:Plan A costs :Months Plan B Months 

~i~~: i>:~~p:. ::::: ::$j:oq;oqo::: ::::::::::: i~:: ::: i1:~q;oqo:: ::::::::::::::.: ;~:: 
P.l!~~!" .. 1 ..... : .. .. $~:?~.QRQ .. : ..... ......... ~ .. .... $!'!1 R.QRQ .... ............ .. :? . . 
P.l!m. A ... . : .. .. $~~~.QRQ .. : ...... ...... M ...... $~?~.QRQ ............... . :?,:? .. 
P.l!i! ~!". ~ .. .. : .... $~~R.QRQ .. : .............. ~ ...... $!'!:?~.QRQ .... ..... ...... .. . !? .. 
M9X~:-)(l .... : ..... $.?~.QRQ .. : .. ....... ... .. 1 ... .... $.?~.QRQ ......... ... ...... 1 .. . . . . 
r:Q\~i : : : :: :::: $.~~Q~~;oqo:::::: :: :::: ::: j:4:: : $.~jo~;oqo:: ::::::::::::: ::1:~:: 
(:.<!~~lm<!ll~~: .............. ... : ... .. H~.9~~- . ................... . .. ... 1.:?~.!?~~-. 



Real Estate Development Report 135 

Select the new data in the spreadsheet; then select Copy. Save the 
spreadsheet again, quit Multiplan, and run Word. 

12. Paste in the new data and reformat the table with tabs. Fill 
in any other text that is necessary for the report. 
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______________ Sales Report 

A & A o~/;, 
~~~~~~~/,~~ 

MuHiplan Microsoft Chart MacDraw Microsoft Word 

Hewes and Benson, a large book publisher, keeps regional 
sales records in a Multiplan spreadsheet. A report on the 

regions is prepared for upper-level management every quarter. 
The report includes both figures and graphs of sales results. 

In addition to keeping sales figures, Hewes and Benson has 
recently begun to make predictions of how many books will be 
sold in any given month based on the previous year's sales, 
number of books available, the general book market, and so on. 
The current quarter's report must include comparisons between 
expected sales and actual sales. 

The final report includes tables as well as charts. The charts you 
need are 

• Three-column charts for the monthly sales and expected 
sales in the three months of the quarter 

• A column chart for the total quarterly sales and expected 
sales. 
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Hewes and Benson 
lloot Pub llshers Since 1921 

Sales figures for the 

Second Quarter. I 986 

Hewes and Benson had an excel lent second quarter this year, with sales above 
predictions in every month. Our new lines are selling especially well in the chain 
bookstores. The cookbooks did not do as well as the "Great Gardens· series, but 
Individual titles In the "Chef's Choice· series were strong se llers. 

Our expectations for this quarter were low due to the usual soft market for games 
books before the summer, but we were pleasantly surprised by sales in all other 
categories. The sates departments everywhere except the Mountain region beat their 
goals and produced splendid resul ts. The Southem region deserves special 
commendation. 

The monthly sales by region are shown here (the expected sales are shown as a tine 
connected with diamonds): 
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1. Yo ur data fo r the report is already in Multiplan. The spread­
sheet covers the mo nt hs of April, May, and june. 

6 
?.~~-~~ ......... : . .. ........ .. .. : ............... : ...... .. ..... .. : .... .. .... ..... : ... .... ....... . 
.. . . . .. . .. . . . . . : ~P.r!l. .... .... :M~Y. .......... : ,J.~Q~ .......... :?n<! .Q~.~~l~r .. : .... .. .. ...... . 
t>.~~m~ ....... : ..... - ~~o.t.~ .. : ..... .'H\ 1 ~o .. : ...... ~.t.?n .. : .... .t.~~~~? .. : ...... .. ..... .. 
?.C!~!~:'-l'~.~~ .. . : ...... ~!l~!l1 .. : ..... . 1~1~1 .. : ...... ~n~~-.: ... .. 1.?f!'1f!l? .. : ...... ... .. ... . 
!'19!-l.~\~iQ ... .. : .. .. .. 1 ~0~0 .. :_ .. ... ?~! .1 .~ .. : .... .. ?~1?~7 .. : ...... 1?~~.1 .? .. : .... .. .. .. .... . 
(:.~ Q !r~.l ..... . . : .. . .. . ?~~~~-. : .... .. 1 .1 .1?~1 .. : ...... :?R~~-1 .. : .... .t.?.t.?!l? .. : .... .. ........ . 
?.<:! ~!~ ......... : ...... ~f!O~? .. : ...... 1~F'1 .. : ...... 1!'!~~~-.: ..... 1.?1'!1~1? .. : .............. . 
l'l.C!~!~m!.. .. : ...... ?~?.1.~ .. : ..... -~~~R? .. : ..... -~~~! .. : ...... '1~'1~ ! .. : .... .......... . 
T.C!\~1.. ....... : .... .t .?f!~f!? .. : .. .. ~~R1W .. : .... ~1?~'1n .: .... f!?~?~'1 .. : ..... ......... . . . . . . . . . . . 
··························· ····· ············ ·· ··········· ······ ···· ·· ···· ······ ············· ··· 
~XP.~~-~-~<! ..... ; ........... .. . _: ........... . ... ; ....... ........ : ............... ; ... . .......... . 
l;'.~~iH~ ....... : ...... 1!l0!l0 .. : ...... 1~0!10 .. : ...... 1f!ORO .. : .... .t.?~QRO .. : .... ... .. .. ... . 
?.C!~!~:>l'~.~~ ... : ..... -~~ORO .. : ..... -~~ORO .. : ... ... 1f!ORO .. : .... .1.! ~ORO .. : ...... .. .... .. . 
!19!-ln\~iry ..... : .... . . ?~ORO .. : .... .. n OQO .. : ..... . ?!'!ORO .. : ..... noRO .. : ...... ... .... .. 
(:_~ry!r~.l ....... : . . .. . -~~ORO .. : ..... -~~ORO .. ; ...... 1RQRQ .. : ..... 1.0!'!Q!l9 .. : .. .... ........ . 
?.C!'!!~ ... ...... : ...... ~!lOQO .. : ...... ~f!ORQ .. : ...... 1RQQQ .. : ..... 1.0f!OQQ .. ; ............. .. 
~-C!~l~ml .... : . ..... ?!lO!lO . . : ...... ~RORQ .. : ..... -~~ORO .. : ... .. -~~ORO .. : .. ...... ...... . 
T.C!\~ 1 ......... : .... .l.?~QQO .. : .... ~~ORO .. : .... ~~~O!lO .. : .... f!?.t.ORQ .. : .... .... ...... . 

The upper half of the spreads heet s hows actual sales; the lower 
half shows expected sales. 

2. To dr aw the three monthly column charts, select rows 3 
through 8 and colum ns 1 thro ugh 4. Co py this regio n into the 
Clip board and the n to the Scrapbook. Now select rows 12 thro ugh 
17 of colum ns 1 through 4 and copy the m into the Cli pboard. Q uit 
Mult iplan and run C hart. 

3. Se lect Text from the Data menu to tell C hart th at your 
categori es are text (the names of the regio ns). Sele ct Paste, and 
Ch art creates three series windows of expected sales. 

I New Series 
~0~ Series 8:23:33 AM ~ 

r- Order: 
ror D Plot Series 

~ 

u;;;;_ 

I ~ 
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Regional Analysts 

We became quite concerned in April, since only South exceeded the expected sales, but 

we were gratified with the excellent results of May and June. The leaders of t he 

regional sales conference on May 4 reported that many regional managers felt that 
AprtJ was a fluke and that sales wt ll be more consistent to the future. 

The only region that perf ormed below the expected sales was the Mountain region. 

This was partially due to the change In regional directors that occurred in April, and 

partially due to the warehousing probl ems that we experienced there. The latter 
problem has been taken care of with the repair of the new computer system that was 

installed in March. 

Dan Rappaport, regional manager ror Northeast, noted that many or the new gardening 
t itles were aimed at the Midwest and Pacific regions, and that very few re lated to 

New England. On reflection, this turned out to be true, and Acquisitions has told us 

that they will sign more Eastern gardening books f or publication in the third quarter. 

The f inal sales f igures for t he regions are: 

April May June 2nd Quarter 
Pacific 38015 46150 5 1227 135392 
Southwest 30804 43434 52728 126966 
Mountain ·19040 23 11 5 25657 67812 
Central 29528 41634 50544 121707 
South 36062 43779 48595 128436 
Northeast 229 13 32307 3922 1 94441 
Total 176362 2304 19 267973 674754 



4. Ope n the Scrapbook and cut the data with the sales fig­
ures. Select the New Series Window and paste the data into Chart; 
you now have six data windows. 

5. Select list from in the Data menu to get a list o f the six 
windows: 

Series list 

Show Plot 

~ 0 Series 8:33:33 PM 
~ 0 Series 8:33:38 PM 
~ 0 Series 8:33:39 PM 
~ 0 Series 8:35:21 PM 
~ 0 Series 8:35:23 PM 
~ 0 Series 8:35:25 PM 

OK Cancel 

Deselect al l the windows except the first and fourth (t he sales and 
expected sales for April}. Click th e OK button. 

6. Select Combination from the Galle ry me nu and choose 
type 1. C lick the Plot Series button for the sales series (the seco nd 
one you pasted into Chart} and then the Plot Series button fort he 
expected sales series (the first one you pasted). This makes t he 
actual sales come out as bars and the expected values as a line: 

Series B :25 : 1 6 AM 
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Summary or the Quarter 

The totals, with the expected sales, were indeed Impressive: 
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Pacific Southwut Mounb in C•nlral South Northpast 

In numbers, this translates to: 

Pacific 
Southwest 
Mountain 
Central 
South 
Northeast 
Total 

Sales 
135392 
126966 
67812 

121707 
128436 
94441 

674754 

Expected 
128000 
117000 
77000 

108000 
106000 
85000 

621000 

Congratulations are in order to the entire sales starr. 



7. In your written report, you wantto have the three monthly 
charts on the same line; therefore, they must be smaller than 
normal. Give the Sele ct Chart command in the Chart menu to 
se lect the plot. Point at the square in the lower-right corner of the 
selection and drag it until the plot is about 2 1/2 inches wide: 
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8. Sele ct Copy to put this drawing on the Clipboard. Transfer 
the drawing to the Scrapbook. 

9. Repeat steps 5 through 8 for the data in the second and fifth 
windows and the n for the data in the third and sixth windows. You 
now have three small overlaid charts in the Scrapbook. 

10. Quit Chart and run MacDraw. Cut and paste the first chart 
from the Scrap book into a new document; then cut and paste the 
other two into the document. You can easily group the charts and 
move them around so that th ey line up and fit together well: 
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Make new labels for the axes and titles. 
11. To improve the report's appearance, add rules above and 

below the charts. Select Turn Grid Off from the Arrange menu. 
Create a rectangle four pixels high (the height between two grid 
dots, including the dots) by about three inches. Select Fill, select­
ing the pattern in the middle column of the third row: 

:~ 

Copy this above and below the charts, and save a copy of the rule 
in the Scrapbook for the othe r charts in the report. 

12. Select everything in all three charts and the rules with the 
Select All command in the Edit menu and copy it to the Clipboard. 
You maywanttosavethis MacDraw document for future use. Quit 
MacDraw and run Word. Open a new document and select Page 
Setup from the File menu; change the right margin to 0 inches. 
This is necessary so that Word does not try to squeeze the charts 
into the default margins; otherwise, the charts will come out 
distorted. 

13. Select Paste to copy the three charts into the document. 
Enter the introductory text about the monthly sales before and 
after the charts. Set the right indent of the text paragraphs to 0.75 
inch to make up for the changed page margin. 

14. Quit Word and run Multiplan again. You now have to select 
the data for the table that goes with the monthly charts. Select 
rows 2 through 9 of columns 1 through 4; then select Copy. Paste 
these into the Scrapbook. 

15. Select columns 1 through 5, rows 3 through 8. Copy this 
selection to the Clipboard and paste it in the Scrapbook. Next, 
select columns 1 through 5, rows 12 through 17. Copy this selec­
tion to the Clipboard and paste it in the Scrapbook. 

16. Quit Multiplan and run Word. Ope n the Scrapbook and 
retrieve the table from step 14. Paste this into Word and format the 
table with tabs. 



April May June 2nd Quarter 
Pacific 380 15 46150 51227 135392 
Southwest 30804 43434 52728 126966 
Mountain 19040 23 11 5 25657 678 12 
Central 29528 4 1634 50544 12 1707 
South 36062 43779 48595 128436 
Northeast 229 13 32307 3922 1 94441 
Total 176362 2304 19 267973 674754 

17. Quit Word and run Chart. Sele ct Combination chart type 1 

in the Gallery menu for the c hart; then select Text from the Data 
menu. Open the Scrapbook and cut the first selection (the total 
sales) to the Clipboard; then paste this into a new series window. 
Close the first three windows {the monthly sales), leaving only the 
Total Sales window open. 

18. Open the Scrapbook again and cut the total expected 
sales, select the New Series window, and paste this data into a new 
series window. Again, close the first three windows, leaving only 
the Expected Totals window open. 

19. Plot the sales data first and th e n the expected sales. Select 
the entire chart and copy it to the Clipboard. Modify the labels 
and fill pattern in MacPaint or MacDraw; then copy the chart back 
to the Clipboard. 

Total Sales vs. Expected Sales 
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20. Run Word and paste this chart into your report. Copy the 
rule from the Scrapbook and add it above and below the pasted 
chart. Fill in the text around the chart. 

21. Quit Word once again and open your Multiplan document. 
Create a new area oft he spreadsheet that copies column 1, rows 3 
through 9; column 5, rows 3 through 9; and column 5, rows 12 
through 18. To get the numbe rs in the second and thi rd columns 
to appear as data, you must first copy the selections to the Scrap­
book and then copy them back to the Clipboard again. 

f.~<r in~ . ........... .1 .~~~n .. : ... . .1. :?~oRo .. : 
?.q~~~~~~-~~ ... : .... .1.:?~';'~~-. : .... .1.! l QRQ .. : 
M9ll.l'!~ ~i'l ... .. : .... .. ~l~.t.:? .. : ..... . 7lQRQ .. : 
~-~'l~r~.l .. ..... : ... . .1.:?.1.797 .. : .... .1 .Q~QRQ .. : 
?.q~~~~- ........ : .... .1.:?~4~t? .. : .. .. .1 .Q~QRQ .. : 
!'l.Qr: ~~~-~~~ - .. . : ...... 'i'~4~ ! .. : ..... -~~ORO .. : 
T.q~~1 .. ....... : .... ~7~7~4 .. : .... ~:?.I. ORO .. : . . . . . 
········· ···················· ······ ·········· ··· 

Select these cells and copy them to the Clipboard. Quit Multipl an 
and run Word. 

22. Paste the table into your document and format it with tabs. 
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_____________ Loan Application 

Microsoft File> Multiplan MacPaint Microsoft Word 

A growing word processing firm is requesting more capital 
from its bank. BestWords currently has nine employees; the 

pres ident, Dianne Carter, wants to expand the staff to 15. Best­
Words is requesting a $250,000 loan for five years to cover the 
expansion. 

The current staff consists of Carter, a sales representative, an 
office manager, a word processing leader, and five word proces­
sors. Carter wants to add a second leader, a second sales position, 
a new training specia list, and three word processors. 

The proposal to the bank must include BestWords' current 
income and expense report, an organizat ional chart of employees, 
and a plan for the use of the new capital. 5 ince each new word 
processing employee needs a computer to work on, the capitali­
zation report must include the costs of adding salari es and buying 
new equipment. 

1. The income and expense report is kept in Multip lan. 
Financial transactions are entered in the spreadsheet each week. 
The totals for the various categories are l inked to the new 
spreadsheet: 

149 
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This proposal represents BestWords' request for a 5-year loan of $250,000 

to help us expand our business. We are Clifton's biggest word processing 

firm, but with an increase in personnel and equipment, we can nearly double 

our expected sales in one year. 

Background 

Bestwords provides word processing and typing services to the 

business community in the Clifton area. We are welt known in the 

community and have be~n in business since 1981 . 

Most of our services consist of word processing using 

microcomputers. BestWords provides our customers with report-quality 

documents as well as light typesetting services. Our office has recently 

begun training local secretaries in how to use word-processing equipment. 

Income and Expenses 

Bestwords is a privately held firm. we have been profitable every 

year that we have been in business. We have always been ahead of our 

competition in buying the newest eQuipment; this has consistently paid off 

by bringing In new customers. 

Our 1984 income and expenses were as follows: 

BestWords Bank Proposal, page I 
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!1')9!'.11".~ .<11')~ . ~XP.~fl.~~ nP.q(~.;. . .. ... ... . .... . . ... .... . . .. . . 
f9r. .1.'?~~ ..... : ......... ...... : .. .... ... ...... ... ...... .. ... . . . 
. ..... ..... .......... ..... ................... ..... ...... ..... . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Wf'. ~.~(Y.i~.~~.: . .. ~:?!'!;!,~:?~ : ?.~l.~r:i~? ....... .. ~:?.1 . 1 -~9Q 
!l')~~m~ ... ... : ......... $~1~ : N~~ .~Q\IJP .... . ..... $.1.7 ,;"!:?!' 
\J.~~~. ~R4i.P. .... : ...... ~1 ,!'~R : ~.lli')! /.P.I)9fl.~ ....... $.1.V.~~ 
T.t:<!il')il')q ..... . : ...... ~9-~QR : MY../~r.~rn9, .. ... $~9-~'?R 
.. .... ....... .. : .. ..... ........ J~.9<! 1.... .. ... . ..... ~V.9R 
.. . .. .•. . .. . .•• : •......... . .. .. : qm~.ll .~I!PP .......... ~~-~:?.1 . 
. ..... .. .. .. ... : ............ .. .:!'1i~9 ........ .... ..... ~9-~'?~ 

J:<i,~i:::::::::::: j~~QjQ~ j·:<i,~i::: :::::: ::: ~~i~~~~~ 

2. Select this data and copy it to the C lipbo ard. Quit Mu ltiplan 
and run Wo rd. Paste the data into a new docum e nt, fo rm at it, and 
add an exp lanation for the balance above o r be low the table. 

3. The organizational chart can be created in MacPaint or 
MacDraw. In MacPaint, select Grid fro m th e Goodies me nu to 
make it easie r to align the rectangles. The chart looks li ke th is: 

Dianne Carter 
President 

Jean Henderson 
Mark Purdy 
Ruth Sweeny 

Louise Thornton 
Chri s Vee 

Select the chart w ith the lasso, co py it to t he C lip board, and q uit 
MacPaint. Run Wo rd and p aste th is chart into the re port. Center 
the chart in the text a rea by selecting it and dragging on its right 
borde r. 

4. S ince the orga nizatio nal chart does not te ll mu ch about t he 
employees, th e requ est sho ul d include a table of e mp loyee 
informatio n. BestWords keeps this information in a File database: 
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1984 
Income Expenses 

WP services $278,-428 Salaries $211,600 
Interest $248 New equip. $17,527 
Used equip. $-4,730 Rent/phone $H,134 
Training $6,800 Adv./Promo. $20,290 

Legal $2,100 
Office supp. $3,821 
Misc. $6,392 

Total $290,206 Total $275,86-4 

Company Organtzatton 

BestWords starr consists or the president, orrlce manager, sales 

representative, and the word-processing starr. our company structure Is: 

I Dianne Carter I 
Pres1de nt 

I Sell y Leeds I 
Sales I Nancy fields I 

Office Mgr. 

I 
Suzanne Robertson 

WP Leader 

I 
Jean Henderson 

Mark Purdy 
Ruth S"'leeny 

Louise Thornton 
Chris Yee 

The staff has grown steadily since our founding in 1981 . BestWords salaries 

are based on job description and length of time with the company. The 

salaries and beginning dates of employment are: 

BestWords Bank Proposal, page 2 
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m BestWords Staff 
Nome Position Soloru Started 

I JeBn Hender son WP $19,600 9/22/83 
2 Mark Purdy WP $19,600 9/22/83 
3 Dianne Carler President $35,000 2/ 1/8 1 
4 Ruth Sweeny WP $18 ,300 1/8/85 
5 Sally Leeds Sales $31 ,200 1 1/5/84 
6 Lout se Thornton WP $18,500 6/12/84 
7 Nancy Fields Orrl ce Mgr. $27,500 B/30/6 1 
8 Suzanne Robertson WP Leader $23,400 4/20/ 8 3 
9 Chri s Vee WP $ 18,500 B/1B/B4 

New 

Sort the records on the Position fie ld. Copy the records to the 
Clipboard (retaining the formatting) and paste them into the 
Scrapbook; they will be used in the report. Copy the same records 
to the Clipboard without the formatting and also paste them into 
the Scrapbook; this will be used in Multiplan. 

5. Q uit File, run Word, open the report, and cut the table with 
the formatted amou nts into the Clipboard. Paste the table into the 
report and format the results. 

Nancy Fi~tds Offic~ Mgr. $27.500 8/30/8 1 
Dianne carwr President $35,000 2/ 1/81 
Sally Leeds Sales $31,200 11/5/84 
Chris Y~~ WP $1 8,500 8/ 18/84 
Louis~ Thorn ton WP $18,500 6/ 12 /84 
Ruth Sw~~ny WP $18,300 1/8185 
Jean Hend~rson WP $19,600 9/22/83 
Mark Purdy WP $19,600 9/22/83 
Suzanne Robertson WP Leader $23,400 4/20/ 83 

6. O f course, the bank is most concerned with the use of the 
loan; so make a spreads heet showing how the loan would affect 
income and expe nses. Quit Word, open the Multiplan spread­
sheet, cut the unformatted records from the Scrapbook, and 
paste them into the spreadsheet beginning at row 22. Remove the 
Name and Started columns: 

2 

~-4~r~_q\ ........... ....... .. . 
9.m~.~ .1":1.9~ ,.. . .. ~~~.~QQ .. 
!'r.~~~~n\ . . . . . .. ~~;'i ,QQQ .. 
s.~l.~~ ... .. . ... . .. ~~.1 .• ~QQ .. 
Y!'... ...... ... ... !W~.:?QQ .. 
Y!' .. ............ . !W~.~Q .. 
Y!' ............... ~Ht~ .. 
Y!' .. .. ........... fi! ~.~QQ . . 
Y!' .. ............. fi!~.~QO .. 
W!'. ~-~~ ~~r. ... ... ~~~.~QQ .. 

r:~'~c :: :: :: ::$~i:~: :~!io:: 
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Nancy Fields 
Dianne Carter 
Sally Leeds 
Chris Yee 
Louise Thornton 
Ruth Sweeny 
jean Henderson 
MarJe Purdy 
Suzanne Robertson 

Office Mgr. 
President 
Sales 
WP 
WP 
WP 
WP 
WP 
WP Leader 

Purpose of the Loan 

$27.500 
$'35,000 
$31,200 
$18.500 
$18,500 
$18,300 
$19,600 
$19,600 
$23,400 

8/30/81 
2/1/81 
11/5/84 
8/18/84 
6/12/84 
1/8/85 

9/22/83 
9/22/83 
4/20/83 

Our staff of six word processing employees are now working at full 

capacity. BestWords has been In the enviable position or turning away work 

for the last eight months. We propose to add rour new positions to the word 

processing starr (one leader and three operators). 

The Increase in staff will let us accept more new business. Thus we 

will need to add a new sales representative to bring in new clients and to 

interest our current clients in new services that we offer. We also want to 

add a full-time training specialist to the staff to cover the new demand for 

word processing training. 

With the additlon of new starr, BestWords will, of course, need new 

word processing equipment and a proportional Increase In rent and office 

supplies. The total new needs are shown here: 

BestWords Bank Proposal, page 3 
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Add a total to row 32. 
7. Copy columns 1 and 2, rows 22 through 30, to columns 3 

and 4. This wil l be the proposed new staff. Add the new workers 
into column 3. Increase the pay levels for the current positions 
and add a total. The spreadsheet now appears as follows: 

(:.4~r~n~ .. .... : ...... ... ...... :Pr.<?P~.~~9 ..... : . ... .. ........ . : 
9.~~i9.~ .1':1.9~ , .. : ... ~?l,:?RQ .. :9m9.~ .1':1.9~ , .. : ... ~:?R ,QRQ .. : 
P.r:~~!9~n~ .... : ... ~~~.QRQ .. : Pr.~~!9~n~ .... : ... ~4R,QRQ .. : 
?.~~.~~ ......... : ... ~~.l .• ?RQ .. : ?.~1.~~ ......... : ... ~~~.QRQ .. : 
WP ..... ... ... . : ... ~ 1 ~ .:?RQ .. : ?.~ 1.~~ ..... .... : ... ~~~ ,QRQ .. : 
WP ....... .. ... : ... ~ 1 ~.:?RQ .. :J.r:{lilliiJq .. .... : ... ~ P.:?RQ .. : 
WP .. .. ... . .... : ... ~1 ~.~RQ .. :rw. ... .. ...... : .. . ~ 1 ~ .~RQ .. : 
)~f' ......... ... : ... ~1~.~RQ .. :WP ... .. ....... : ... ~1 ~.:?RQ .. : 
WP .. ... .... .. . : ... ~ 1 ~.~RQ .. :WP .... .. .. .... : ... ~?R.~RQ .. : 
WP. !-.~{19~r. . .. : .. . ~?~.4RQ .. :Wf' . ..... .. .... : ... ~?R .~RQ .. : 
............... : . .............. :WP ..... ....... : ... ~ 1 ~ .:?RQ .. : 
T.<!~{l] .. .... ... : .. $71.1 .• ~RQ .. :WP ..... .. ..... : ... ~1 ~ .:?RQ .. : 
...... .. ....... : . .............. :WP ... .. ... .... : ... ~ 1 ~ .~RQ .. : 
............... ; ......... .. .... :WL ......... : ... ~ 1 ~.~RQ .. : 
.. .. ........ ... : ..... .... ...... :wP. !-.~{l~~r. ... : ... ~?'\ ,'?RQ .. : 
............... : .. ............. :wP. !-.~~9~r. .. . : ... ~?'\ ,'?RO .. : . . . . . . . . 
:::::::::::::: :~ ::::::::::::::: ~ r:~'~i ::::: :::::: :$~~:1: :799: :~ 

8. Start a new area of the spreadsheet for expected new 
expenses on row 40. The major new expense is salaries for new 
employees. The total of the new expenses for 1986 is the differ­
ence between the two previous totals (R38CS- R32C2) . For 1987 
and 1988, estimate an increase of15 percent for current employees 
each year (R42C2•1.15 and R42C3•1.15). The result is as fo llows: 

!'1.~'\'1: .~>:<P.~I)~~.~ ............ ... : ............... : ............... : : 1 985 : 1 986 : 1 987 : 
~:~1~~;~~:::::: ~: i1:~ii: i 99:: ~: :h?~i1:~:: ~: i1:~~ :~97: : ~ 

9. Copy the Expense categories from column 3, rows 7 
through 12, into column 1 beginning at row 43. The estimates are 
based on the costs of equipment for t he new word processing 
employees and a doubling of the advertising and promotion 
budget for the new sales representative. Use row 50 for yearly 
totals: 
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New expenses 
198:5 1986 1987 

Salaries $150,100 $172,615 $198,507 
New equip. $15,000 $3,000 $2,000 
Rent/phone $4,000 $4,000 $4,000 
Adv./Promo. $20,000 S20,000 S20,000 
Lesal so so so 
Office supp. S3,000 S3,000 S3,000 
Misc. S4,000 S4,000 S4,000 

Total S196,100 S206,615 $231,507 

This will result in significant new income for BestWords. With our 

new capabilities, our three-year projections for income added by the new 

staff and equipment are: 

New Income 
198:5 1986 1987 

WP services $200,000 S225,000 $250,000 
Interest so so so 
Used equip. S4,000 $2,000 $2,000 
Training S-40,000 S-45,000 S50,000 

Total $244,000 S272,000 $302,000 

As you can see, we feel that the $250,000 Joan can t>e easily pal<! off 

In the five-year tlmeframe, given that we will continue to make a profit 

each year. With other expansions that are currently un<lerway, BestWor<ls 

shoul<l be able to meet the goals of the Joan In three to four years. 

BestWords Bank Proposal, page 4 
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N~'ll: .~>:<P.~I)~~-~. ........ . . . . . . . . . . . . . . . . . . . . . . .. . ... ... .... . 
. . . . . . . . . . . . . . . : ! .~?.~ . . . . . . . . . ! .~?.~ . . . . . . . . . ! .~?.'? ... ..... . 
$.~1-~~i~~- . .... : .. $.1.~Q, 1 QQ ... . $.1.?~.1?.1.~ .. .. $.1.~!L~Q7 .. 
N~'ll: .~Q\IiP ..... : ... $1 ~ ,QQQ.. .. ... $~ ,QQQ ....... $~ ,QQQ .. 
~-~l)t(P.~9fl.~ .. : ..... $~ ,QQQ ....... $~,QQQ ....... $~,QQQ .. 
MY../~r.<!rnC?,: ... $:?Q,QQQ ..... $:?Q,QQ9 ..... $:?Q,QQQ .. 
~!".9~1 ......... : .......... $9 ........... . $9 .. .. ........ $9 .. 
9.((i9.~ -~~PP .... ; ..... $~,QQQ ...... . $~ ,QQQ ....... $~ ,QQQ .. 
Mi~9 ........... : ..... $~ ,QQQ ....... $~,QRQ.. .. ... $~ ,QQQ .. 

:,.:~\~ i :::: ::: :::: 11:~~: 1 !:io:: : :$~o~:~:1:~:: : :$~~:1: :~!:i? :: 

10. Copy the labels in column 1, rows 6 through 9, to column 1 
beginning at row 54. Enter information about the expected 
increase in sales due to the doubling in size of the sales staff, the 
fu ll-time training position, and the increased capacity for new 
word processing work. Add totals for each year: 

................. .. .. .... ....... ................. .... ........... 
N~':Y: .lra.~qoo~ .. : ............... : .. .... .... .. . .. : .. ....... . ..... : 

: 1 985 : 1 986 : 1 987 : 
wP. ~~~Y:i~~~ ~ ~ :f~'Qq ,'QqQ. ~ ~ :f~~~ ,'QqQ. ~ ~ t~~q :QqQ. ~ 
lntt>rt>st : $0 : $0 : $0 : 

~:~~~: fi4iP. .::::: ::: :$~:o!:io::::::: :$~ :o!:io::: :::: :$~:o!:io::: 
rr.~il) i i)Q .. .. .. : ... $1R.oRo .. : ... $4~.oRo .. : ... $~R.oRo .. : 

11. Select rows 40 through 59, copy them to the Clipboard, and 
quit Multiplan. Open your Word document and paste the tables 
from the Clipboard. Format the tables and add explanations for 
the new costs and expected income as follows. 

New expenses 
1985 1986 1987 

Salaries $150, 100 $172,6 15 $1 98,507 
New equip. $ 15,000 $3,000 $2,000 
Rent/ phone $4,000 $4,000 $4,000 
Adv./Promo. $20,000 $20,000 $20,000 
Legal $0 $0 $0 
Office supp. $3,000 $3,000 $3,000 
Misc. $4,000 $4,000 $4,000 

Total $196, 100 $206,615 $231,507 

New Income 
1985 1986 1987 

WP services $200,000 $225,000 $250,000 



10 
Comparison of investments 

lOi r-------------------------------

---------------------- ..... ••m 

., 
"'-tV. ~ ~ ,.....,.. ··~ 

.... Ndt '*" aJ'l 

Table I. Investment rell&nC:O lor I 9&\lnd I 985. 

TU ptiUloo f11D4 ror Aaerk::&.a Fooch bqhl Cl.(n lcaa·Ltta bood1 m 198) 
&a IS IJq1UdaLed IOCit dOW bold.lqt ln &hort•tftll bocdl. Out to Ita tci'lat1t ltl 

lilt eul aad Jbof'Htrc CD •utttt, "' t1to put D«t rttilf!Cit oc blue-ca.lp 
tltld: l. 

Percent investment 

o cw. 
8 I• rn,.CD5 
0 $c)KulaU-wt stc<ks 

a Oiut~IO StocU 

o Lroo· ttrm ocros 
• Shott •1 tnn DOMS 

Toblo 2 Coolportooncl tnvOSimOnl mil: lor I 984 and t98S 

Whllt tl.IPUy i6at&Ji~l OM 1.0tal amount i.fr,lt.ad In bOGdl, AmttiCU Foo4t' 

Pf:JU.OO f uod ll'ufl.ed t.bt bcM eeplw il from tbort-l..rrm LO looJ ·t«ll boadt 

BtiH ·ehlt~ ttoc:t.t aJto play.<~ a blatt rolt an the port(Olto LD 111) 



____________ Business Presentation 

Multiplan Microsoft Chad MacDraw Microsoft 'w'ord 

Jim Rothstein is giving a presentation on the holdings of the 
American Foods pension fund to the board of directors. The 

board has copies of the graphs that he is discussing, but he wants 
to make his presentation more interesting by using overhead 
transparencies. 

The pension fund has grown by almost ten perce nt over the 
year, and although the data is fairly simple, it is important that the 
board see how the mix of investments has contributed to the 
fund's growth. Jim uses Chart to make two transparencies: 

• A simple column chart showing the percent reliance on 
each type of investment in each year 

• A 100 percent column chart showing the mix of investments 
in the two years. 

Since the board of directors already has copies of the data, Jim 
decides to make graphs more informative by adding descriptive 
captions. He also wants to use MacDraw to improve the appe ar­
ance of the labels. His finished charts are presented throughout 
this chapter. 

159 
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Comparison of investments 

8 198-4 
-----------------------------

. 1985 

201 

101 

01 
Sllorl-l.erm Long-term 8lue-i:hlp Speculative I+ year Cash 

bonds bonds stocks stocks CO's 

Table 1. Investment reliance for 1984 and 1985. 

The pension fund for American Foods bought more long-term bonds in 1985 
and liquidated some of our holdings in short-term bonds. Due to the softness in 
the cash and short~term CD market9, we also put more reliance on blue-chip 
stocks. 
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1. The data is kept in a Multiplan spreadsheet: 

2 3 4 5 

. . . . . . ·· ··· ················· ···· ···································· ·············· ·· ........... . 
: 1984 : : 1985 ::::::: :::::::::::::::: :: ~~~:~~:~~:<i RoR>.: : ~:~~9~:~\: :: ::: : ~~~)~:~~ :<i RoR>.: ~~~9~:~i :: :: . . . . . . .... ... .... ...... ....... ... .. ... .... ... ......... ....... ..... ... ..... ....... ... ........ ...... . 

Short-term bonds 1 05820 : 
~~~9~~~,.:~ :~.;~~:~ :::::::: :::: j~~~~L : : ::::: ~::; .. ?.~ : ..... .. ~~~~~1 ......... ~? .. ~.~ 
~.1~r9~.i P. ~.~.<!~~~ ...... : ..... . .. . ~~0!!'1 .. : . ... .. . .1.7 .. ~.~ : ........ 1.1 ~·m .. ....... ~o .. !J.~ . 
?.P.~9~.1~.~ix~ .~!9~.~~ ... : ......... '1.1.7;l~ .. : ....... .. ~ .. ?.~ : ......... '1;l7!!0 ........... ~ .. !.~ : 
).+ .\1~.¥. .~P.·.~ ......... : .. ....... l?~'i'.l.? .. : ...... . .1.? .. ?.~ : ......... '1~7!!:? ........... ~ .. !l.~ : 
~.~~~ ............. . ..... : .. .. ..... ?~~;l~ .. : ...... ... :? .. ~.~ : ......... ?~~~ 1 ........... :? .. !l.~ : . . . . . . . . .... .. .. ................... ... ........................... ...... ............................... 
T.<!\~1 ... ... 0 ••• 0 •••• 0 •• : 0 • ••• " ;l! !!?~? .. : ....... .1.9!!~. : ....... ;ll?~~~:?. 0 • "." 0 .1 .0!!~ .: 

Since you are using Chart to graph the results, you do not need to 
use the headings or the totals. The percentages are necessary 
because the totals for the two years are different. Select columns 1 
through 5 of rows6 through 11 and copy the data to the Clipboard. 
(Be sure to save the cells as unformatted.) 

2. Quit Multiplan and run Chart. Select Text from the Data 
rr.enu to tell Chart that the first column will be your text catego­
ries. Don't worry about the column labels or the chart title; you 
will change these in MacDraw. 

3. Paste the data from the Clipboard. Chart opens four series 
windows. Select List from the Data menu: 

Series List 

Show Plot 
0 Series 4:20:00 PM 
0 Series 4:20:1 0 PM 
0 Series 4:20:12 PM 
0 Series 4:20:14 PM 

OK Cancel 
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100 
90 
80 
70 
60 
so 
40 
30 
20 
10 
0 

1984 

Percent investment 

1985 

D Cash 
1111 1 + year co·s 
D Speculative stocks 
Ill Blue-chip stocks 
~Long-term bonds 
IIDJShort-term bonds 

Table 2. Comparison of investment mix for 1984 and 1985. 

While slightly increasing the totaJ amount invested in bonds, American Foods' 
pension fund shifted the bond emphasis from short-term to long-term bonds. 
Blue-chip stocks aJso played a bigger role in the portfolio in 1985. 
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Deselect the first and third windows, since these are the dollar 
amounts, not the percentages. 

4. The first chart is a bar chart for the two years. Select column 
chart type 6 in the Gallery menu. Click the Plot Series box for the 
1984 data first; then plot the 1985 series: 

Series 4 :20 :10 PM 

y 

Shor t - Long-term Blue-chip Speculativ I+ year Cash 
term bonds bonds stocks e stocks cD·s 

X 

Don't worry about the poorly formed labels; these are easy to 
change in MacDraw. 

5. You want to emphasize the 1985 bars, but the current 
arrangement makes the black {1984) bars look more important. 
Select one of the 1984 bars; then select Patterns from the Format 
menu. Change the area pattern to 50 percent gray (the third from 
the left). The chart now looks like this: 

Series 4 :20 :1 0 PM 

y 

Short- Long-term Blue-chip Speculativ 1 + year Cash 
ter m bonds bonds stocks e stocks cD·s 

X 
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6. Select t he enti re chart; then select Copy. Paste this chart 
into t he Scrapbook. 

7. The second grap h is much harder to make. Since Chart 
does not let you paste in a spreadsheet that is wider than it is tall, 
you can not set u p the six seri es windows easi ly. Therefore you 
must type the data series into C hart by hand. Before beginning, 
select List from the Data menu and deselect the showing or 
plott ing of a ll four series. 

8. Start addin g data to the New Series window fo r the short­
term bonds. The category column w il l contain "1984" and " 1985"; 
the valu es column w ill contain "20.7" and "15.6" (don't worry 
about the series name): 

0 Short-term 
Order: a::==J Q 
~ Plot Series 

Yt>ar 

1984 i 
19851 

. 

9. Create a new series for long-term bonds, then for blue­
chip stocks, and so on. After you have created all six windows, 
select column chart type 5. Click the Plot Series button for the first 
window, then the second, and so on. Change the pattern in the 
top rectangle to d iagonal stripes. Select Add Legend from the 
Chart menu (you wi ll change the names in MacDraw). 
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Short- term 

100 

90 

80 
~ Series 4 :28 :40 PM 

70 
0 Series 4:28 :12 PM 

60 
lilill Series 4 :27 :20 PM 

y 50 

40 
lllll Series 12 :21 :46 PM 

30 
111111 Series 12 :21 :03 PM 

20 
• Short-term 

10 

0 
1984 1985 

Year 

10. Copy this chart to the Clipboard and quit Chart. Run Mac­
Draw and paste this chart into a new document. Add a new title to 
the top of the drawing and change the lege nd, patterns, and axes. 
Separate the columns and add lines between them: 

Percent investment 
100 
90 
80 0 Cash 

~ 70 fa 1 + year co·s c 60 <1> CJ Specula t ive stocks v ... 50 <1> Ill Blue-chip stocks 0.. 40 
30 

~ Long-term bonds 
~Short-term bonds 

20 
10 
0 

1984 1985 
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11. Select the entire chart, copy it to the Clipboard, and paste it 
into the Scrapbook. Copy the first chart from the Scrapbook into 
the Clipboard, move to an unused part oft he chart, and paste the 
chart into MacDraw. 

12. Change the column and axis labels to show the proper 
names, change the title of the chart, and make the chart larger. 

20~ 

1 0~ 

0:& 

Comparison of investments 

fl 1984 
------------ 11 1985 

Short- torm Lonq-torm Blue- chip Speeula1ive- 1 +ye-ar Cash 

13. Select the chart and copy it to Clipboard. Quit MacDraw 
and run Word. Set the right margin to 0 inches. Paste the chart into 
a new document; then add the caption at the bottom. Save this 
document and print it on overhead transparency material. 

14. Start a new document and retrieve the second chart from 
the Scrapbook. Add its caption, save it, and print it. 
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____________ Market Research 

MacTerminal Multiplan Microsoft Chart MacPaint Microsoft 'w'ord 

Samuelson Products has recently developed two snack foods 
that it wants to market on television. 0 ne product, Devonshire 

cookies, is mostly aimed at adults; the second product, Snappy­
Zaps, will have wider appeal among kids. The marketing director 
wants you to find the best shows to advertise the two products. 

The audience data for many TV shows is available through a 
database that you can access with a modem. After receiving the 
data, you can set up "optimum viewer profiles" and compare 
them with the actual show audiences to find the one that best 
meets your criteria. 

Your report for the marketing director (illustrated at the end of 
the chapter) should include both the television show data and 
charts showing the match with your optimum models. By using a 
spreadsheet, you can perform what-if calculations to see the 
effects of changing your models. 

1. Use MacTerminal to access the remote database. After dis­
playing the information on the screen, select it and copy it to the 
Clipboard with the Copy Table command in the Edit menu. This 
command turns the spaces between columns into tab characters. 

2. QuitMacTerminal and run Multiplan. Paste the table into a 
new document: 

2 3 4 5 6 

169 
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To: Sylvia Lloyd, MarKeting IJirec:tor 
From: Chris BaKer 
Re: Television advertising for Devonshire and SnappyZaps 

Our research of the television viewer datasets produced some interesting 
results and indicate that there are some excellent shows for us to use as 
advertising vehic les. We have found shows with audiences that are very 
close to our hoped-for audience mixes. 

Determining the optimal audience mix 

Introducing two products as different as Devonshire cookies and SnappyZaps 
at the same time w i 11 certainly require that Marketing use two very 
different campaigns. Our meetings last month helped us to determine 
exactly who we are se 11 ing to and how we want to approach the consumer 
for these products. 

It was agreed that the target audience for Devonshire cookies was primarily 
adults and that children will not have much effect on the market. We threw 
in a few teens Into the mix to cover those who have buying power. We also 
down-played the seniors, who have traditionally been wary of new snack 
products. 

For SnappyZaps, we decided to go for a broad appeal concentrated on the 
lower age ranges. We feel that half of the potential market will be in the IS 
to 35 range, with children influencing the buying decisions in another 20~ 
of the market. 

The optimal mixes that we finalized on, categorized by television rating age 
groups, are as follows: 

~ Q:l2. U:..l..9. 2.0.::J.5. .J.fr::5.5_ ~ 
Devonshire cookies 011: 1511: 45% 3511: 511: 
Snappy Zaps 2011: 2511: 35% 1 011: 1 0% 

Television data 

Five television shows approved by the Marketing Acceptance Board were 
compared to the optimum mix. or these five, good matches ror both 
Devonshire cookies and SnappyZaps were both found. Given an even larger 
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Row 1 shows each age group; columns2-6 give the percentage of 
the audiences in each age group for the five shows. 

3. Determine the best possible audience for each product. 
For each age category, you shou ld consider the interest in the 
product and the ability to buy or influence a buying decision. The 
result is a desired audience mix: 

Save rows 1 through 11 to the Clipboard and then to the Scrap­
book for use in the written report. 

4. The best way to determine the fit of the show's audience to 
your optimum audience is to find the differences for each cate­
gory and select the show with the smallest cumulative differences. 
You must use the absolute values, or the sum of the differences 
will always equal 0. 

For Devonshire cookies, make a second chart that contains the 
absolute-value difference between the audience percentage and 
the optimum percentage. 

For example, cell R15C2 contains the formula 

=ABS(R 1 OC2-R [- 13)C) 

Copy this formul a down to rows 16 through 19. In R15C3, change 
the formula to 

=ABS(R 1 OC3- R[- 13 )C) 

Copy it down, and so on. 
5. Make a similar chart for SnappyZaps: 

2 3 4 5 6 
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sample of shows, we could probably f ind many other shOws that suit our 
needs. 

The data for the five shows were as follows: 

Ages: 0-12 13-1 g 20-35 36-55 56+ 
My Home is My Castle 5% 10% 31% 29~ 25~ 

Here Goes Nothing 41 ~ 29% 11% 15% 4% 
Top ShOts 24% 18% 24% 20% 14% 
Looks like Rain 4% 15% 43% 29% 9% 
The John Hoyt Show 17% 30% 26% 17% 10% 

The cost per viewer for each 9f the shows was about the same. We looked at 
shows in different hours of the television evening to be sure we sampled t he 
widest possible range of viewers. 

After correlating the differences between the shows and the opt imum 
audiences, we found that Looks Like RaJo matched Devonshire cookies quite 
well and that The John Hoyt Show closely matched the desired SnappyZaps 
audience. 

The following charts show the correlati on for these two shows and the 
products. The lines with the filled-in diamonds are the desired mixes, and 
the l ines with the open diamonds are the shows. 

Devonshire and Looks Like Rain 

SO)C • Devonshi re 

40% 
QJ 
u 
c 
QJ 30~ 
'0 
:::: 

<1: 
20% 

~ o Looks Li ke Rain 

~~ 
~ 

10% 

0-12 13-19 20-35 36-55 56~ 

Ages 
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6. Use column 7 to create totals for the differences (use the 
SUM function) . The totals for the two products are 

6 7 
. 5<Jill . 

::: : ::: : :: :\ 9:~: :: ::: : :: :: : :: ::: 
; I ; 
:······ ··· ·· ···· ······ ·" · ·· ·· ··: 
: . . . . ... .. .. . . . . !. . . .. . .. . ...... : 
: !Total : 

::: : : :: : : : :o :?: : : :::: : :: : ::o:~:: : 

i : : : :: : ::~:g~: : l : :: :: : : : 9:':i1: : : 
: 0 .04 I 0.16 ; :::::::: :!J: ii~: : :::::: :: : !J:.j~:: : 
. I . .. .. .. . ..... . ... ... ... .. . . ... .. . . 
: I . 

: :: : :: : :: : ::::: : :J:~i~i . ::::::: : : 
: 0 .15 I 0.68 : 
;:: : : : : ::!l: ii~: : : : :: :: :: :::o:~: : : 
: 0 .04 I 0.36 : 
~:: : : : : ::O.iii: : : : :: :: : : : o..~~: : : 
: . . . . .. . . ... .Q . . ! ... .. .. . P.-~~-. ; 

Since you are looking for the smallest total difference (that is, the 
closest fit between the sample and optimum audiences), you can 
see that Looks Like Rain (row 26) is the best fit for Devonshire 
cookies and The john Hoyt Show (row 27) is the best fit for 
SnappyZaps. 

7. To create graphs in Chart, copy columns 2 through 6 of 
rows 5 and 6 to the Clipboard and then to the Scrapbook. Copy 
columns 2 through 6, rows 10 and 11, to the Clipboard. Quit 
Multiplan and run Chart. 

8. Paste in the data for the snacks; Chart will assume that you 
are using sequence data, which is fine for now. Use the Sequence 
command to change the series name for the first series to " Devon­
shire" and the second series to " SnappyZaps." Cut the TV show 
data from the Scrapbook and paste it into Chart. Re name the 
series Looks Like Rain and The john Hoyt Show, respectively. 

9. Select line chart type 1 in the Gallery menu. Click the Plot 
Series button for " Devonshire" and then for Looks Like Rain. The 
result is 

0 .5 

y 

2 

O.vonshlro 

3 
X 

4 5 
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Q) 

u 
c 

40% 

30!1: 

~ 20%• "0 I 

SnappyZaps and The John Hoyt Show 

• SnappyZaps 
o John Hoyt Show 

~ 1 o• ~L----+----+------+-··_-_-_-_-_~~o 
0-1 2 13- 19 20-35 36-55 56+ 

Ages 

It should be noted that the desired audience mix should be finalized and 
approved at all levels before these two shows are chosen by Marketing. As 
an experiment, we shifted the age ranges for desired mi.x of Devonshire 
cookies up and that of SnappyZaps down, and we found that two different 
shows matched better than Looks Like Rain and The John Hoyt Show. It 
would also be advisable for us to research many more shows for. the final 
sample. 
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The filled-in points are for the cookie and the open points are for 
the show. As you can see, this was a good match. Save this graph to 
the Clipboard and then to the Scrapbook. 

10. Deselect the two series; plot "SnappyZaps" and then The 
john Hoyt Show. Save this graph to the Clipboard, quit Chart, and 
run MacPaint. 

11. Paste the second graph into a new document. Change the 
title, add better labels, and add a new legend: 

SnappyZaps and The John Hoyt Show 

g :::1 
~ 20% ~ 

• SnappyZaps 
o John Hoyt Show 

~ 10< 1'-----+------t-----· .... · ---------_--"_ :;,.--;0 

0-12 13-19 20-35 36-55 56+ 

Ages 

Copy this to the Clipboard and save it in the Scrapbook. Copy the 
first chart from the Scrapbook, perform the same operations, and 
save it to the Clipboard. 

12. Quit MacPaint and run Word with a new document. Paste 
in the first chart and then copy the second chart from the Scrap­
book into the new document. Also copy the tables saved in step3. 
Enter the text around the drawings and tables to complete the 
report. 

13. To see the effect of changing the desired audiences, 
simply change the values in rows 10 and 11. For example, if you 
decide to change the Devonsh ire audience to be much older and 
theSnappyZaps audience to be much younger, you might use the 
following mixes: 

These results show that My Home is My Castle is better for Devon­
shire cookies and Here Goes Nothing is better for SnappyZaps. 
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____________ Laboratory Report 

Microsoft Filf? Multiplan Microsoft Chart MacPaint Microsoft 'w'ord 

Professor Ruth Williams is researching a nonlinear chemical 
reaction. The reaction has been measured by many other 

researchers, and her graduate students have also run the reaction 
with differing amounts of the reactant. She wants to compare the 
data to the theoretical equation for a paper she is writing. 

Since the literature on this reaction and Dr. Williams's labora­
tory data are considerable, she has kept the results in a database. 
She is preparing a short, informal memo with the results of the 
comparisons. The memo should include a chart of the data and a 
report of the standard deviation from the expected values. 

1. The three fields in the database are the sou rce of the data, 
the amount of the reactant chemical (whose acronym is EOTD), 
and the amount of the resulting chemical (whose acronym is 
EOSL). A partial selection of the data is shown on page 179. 

177 
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Interim memo on the transformation of EOTD to EOSL in solution 

Professor Ruth Williams 

Many literature references include the reaction: 

EOTD • heat--> EOSL 
According to Holland, this reaction follows the formula: 

t2·'+4I 

where I is the amount of EOTD. Mter studying 46 reactions, both from the 
literature and measured in the Jab, I have found that most of these reactions 

conformed quite closely to the equation. 

The data was collected from 3S literature reports and 11 experiments in our 

Jab. The data looks like: 

EOTO to EOSL 

3SE6 

30E6 t: • 
25E6 I. • • 
20E6 • 

EOSL .. ~ 
15E6 

10[6 ;-· 
5E6 • •flllt.,. 

0 ~4L~~ I I I I I 

0 100 200 300 400 500 600 700 800 900 1000 

EOTO 

The standard deviation of the data from the equation was O.OS8, which 
indicates a fair degree of inaccuracy in the literature and in the experiments. 
My group is studying the reaction further to find the edge conditions of 

Holland's equation. 
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Source EOTD EOSL 
1 L7B2 9. 1 OE+02 2.57E+07 
2 L690 3.60E+O 1 7.22E+03 
3 L429 3.56E+02 2.35E+06 
4 LB99 7.35E+02 1.5BE+07 
5 LB45 4.50E+O 1 1.2BE+04 
6 L609 B.09E+02 1.B5E+07 
7 LBBS 4.67E+02 4.47E+06 
6 L9B1 2.07E+02 6.40E+05 
9 E717 3.91 E+02 3. 12E+06 
10 L932 9.6BE+02 2.99E+07 

An "L" in the Source field indicates that this is a literature refer­
ence; an "E" indicates that it was an experiment in Dr. Williams's 
lab. 

2. Copy all of the records to the Clipboard and quit File. Run 
Multiplan and paste the records into a new document starting in 
row 2. Enter the labels in row 1. 

?.Q'!r~.~ ....... : ~QTR .. .. ... .. : ~Pi?~ ...... .. .. : 
q~~ .. ....... : .. ~-.1. 9.~"!-P:? .. : .. ~ --~:m"!"P? .. : 
~~'i!P ... ...... : .. ~-W~"!"P1 .. : .. 7 -.~?.~"!"P~ .. : 
k~:?~ ...... ... : .. ~-.:?9.~"!-P:? .. : .. ~--~~-~"!"P9 .. : 
~~'il~ ......... : .. U~.~ "!"P:? .. ; .. .1. --~~.~ "!"P? .. : 
~~~~ ........ . : .. ~-.:?9.~"!-Pl .. : .. .1.-.~~-~"!"P~ .. : 
~~9~ ... ...... : .. ~-9?.~ "!"P:? .. : ... 1 ... €!~.~ "!"P7 .. : 
~~~~ .... .. ... : .. ~-.P~"!"P:? .. : .. ~ -.47.~"!"P9 .. : 

9 ~~~.1 . ..... .... : .. ~-.07.~"!-P:? .. : .. ~ .. '!9.~"!-P~ .. : 
P17 ....... .. : .. ~--~m"!" P:? .. : .. ~ -.1. ?.~"!"Q9 .. : 

3. You want to compare the data in column 3 with the results 
from the reaction equation. In this case the equation is 

wherex is the amount ofEOTD from column 2.1n column4, enter 
the formula for th e reaction as 

=(RC[ - 2]"2.5)+(RC[ - 2]*4) 

Copy this formula down for all of the data. 
4. Column 5 should show the percent diffe re nce betwee n 

the data and the expected results. The equation for the ce lls is 

=(RC[ - 2]- RC[ - 1 ]) / RC[ -1] 
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Copy this equation down for al l of t he data. The new data looks 
like this: 

?.QI!r~.~ ....... JRTP. ......... ; ~Q!?~ ... .. ..... JQ.l!<!~iC? fl .... .. :~.iff .. .fr:, .~q , .. 
p~g ..... .. .. : .. ~·.1. 9.~-!-R? .. : .. g .. ::?f.~"!"R7 .. : .. g .. ::?9.~"!"R7 .. : ....... g .. ~~.~: 
W?R ......... : .. ~ .. ~9.~-!-R 1 .. : .. ~·.~!2.~-!-R~ .. : .. Ui2.~+Q~ .. : ...... :-!'!·.~9.~: 
k~?~ ... .... .. : .. ~ ,::?9.~-!-R? .. : .. g .. ~~.~"!"R9 .. : .. g .. ~?.~"!"R9 .. : .... .. :-.1.-.1~ !.~: 
~!'!'?~ ... .. ... . : .. ~ ·.~~.~+Q? .. : .. J ... ::?~.~"!"R7. .: .. J ... '!9.~"!"R7 .. : ...... .J..::??.~: 
~!'!~~ .... .. ... : .. ~ .. ::?9.~"!"R1 .. ; ... 1 ... ~~.~-!-R~ .. : .. J ... ~~.~"!"R~ .. : .. .... :-Ui2.~: 
~~Q~ ......... ; .. !'! .. Q?.~"!"R? .. ; ... 1J~~.~"!"R7 .. ; .. . 1.-.!~9.~-!-R? .. : .... .. :-Q .. ::? ~.~: 
~!'!~~ ......... : .. ~ .. ~?.~"!"R? .. : .. ~·.'!?.~"!"R9 .. : .. ~ .. (J.~"!"R9 .. : ... ... :-~ -.1. 9.~: 
~~~.1 .. ... ..... : .. g .. Q?.~"!"R? .. : .. ~ .. '!9.~-!-R~ .. : .. ~ .. 1.?.~-!-R~ .. : ... .... ~·.~~.~: 
P! ~ ..... .... : .. ~ .. ~J.~"!"R? .. : .. ~ -.1. !2.~"!"R9 .. : .. ~ .. Q;2.~+R9 .. : ....... ~·.~~.~: 

5. For the memo, you should also calculate the standard devi­
ation of the differences. In cell R2C6, enter the formula 

=STDEV(R 1 C5:R46C5) 

In this case, the re are46 data points. Give this cell a label in R1 C6. 

6 
:?.t ... 9~.~' ...... : 
: .Q ,Q~~R 1 ~~ .. : . . . . .. ........ .. .. . ... 

Copy it to the Scrapbook for th e me mo. 
6. Copy the data in co lumns 2 and 3 to th e Cl ipboard. Quit 

Multipl an and run Chart. Select Number from the Data menu to 
te ll Chart that the data is numeric. Label th e series "EOTD to 
EOSL" and the colum ns "EOTD" an d "EOSL", respectively. 

7. Paste the data from the C li pboard. Select scatter chart type 
1 for the results. Click the Plot Seri es button: 

EOSL 

EOTD to EOSL 
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EOTD 



Copy this chart to the Clipboard and quit Chart. 
8. Run Paint and modify the axis labels: 

EOSL 

EOTD to EOSL 

35E6 

30E6 

25E6 

20E6 

15E6 

10E6 

5E6 • • e<..,.~ 
Q ~ ...... .,. I I I 

• 

t: • ~. • 
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0 100 200 300 400 500 600 700 BOO 900 1000 

EOTD 

Save this to the Clipboard and quit MacPaint. 
9. Run Word and paste the chart into a new document for 

your memo. Paste the standard deviation calculated in Multiplan 
into the document and finish the report. 
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Brute llermM 
902 WillOw Ave 
Cambrldgt, M.A. 01139 

'Of , ,.ijbnt 1RIIHCI 

14 Oonnt r Squnf[ 
Aliso on , tl..l 02 128 

tlovt'l'lnff 21 , 1984 

011 records •no•catr that you have not PJid lhf balance on 'JW' acCOt.nt. 
$217 50, ooe o--ff 60da'ts • on 91SI8S we rfn'll~you ovtr lO cays ;,go 
on 10112/85, cut ha'Vt not nurd from yoJytt 

AS you know, our oft ice policy ts to aoo a~ ~arge to an o1.1tsunatng 
balances after 60 oays Thr total fClf tMse Sl..'ftt'larg!s on yoor KCOU"'t IS 
se 70: thUs, '1'0\1'" new ba1Mct ts 1'226 20. whiW 1s oayab lt •mmeo1:tt e1y H 
you nave any QU&s llons. please reel tree to call my orr1ce at yovr eariii!'SI 
conwenler.ce 

Sincerely, 

Dr Albert Tamer 



Letter for Delinquent 
Payment 

D r. Albert Tanner, a dentist in private practice, keeps an exten­
sive patient database in File. He uses the database for sending 

patient billings. If a patient does not pay in 30 days, he sends a 
reminder notice. After 60 days, he adds a 4% surcharge to the 
patient's account. 

Although the letters are created with a Fi le report, Dr. 
Tanner wants the reminders to sound friendly, so he uses a 
Word merge document to create them. He includes as much 
personal information as possible to make the letter seem more 
individual. Of course, he also wants the letters to convince his 
clients to pay their bil ls. A sample letter appears on the next 
page. 

1. Create the form letter for the delinquent notices with 
Word. The main document must include a DATA instruction for 
the datafile that you created {in this case, call it "Delinquent 60"). 
The field names in the main document must match the ones in the 
database. Since the datafile for this letter will be a subset of your 
main database, you will use the same field names. Figure 13-1 
shows the main document. 
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Bruce Berman 
902 Willow Ave. 
Cambridge, MA 02139 

oear Bruce: 

Dr. Afbert Tanner 
t 4 Donner Square 

AUston, n.A 02128 

November 21, 1984 

Our records indicate that you have not paid the balance on your account, 
$217.50, due over 60 days ago on 9/5/85. We reminded you over 30 days ago 
on I 0/ 12/85, but have not heard from you yet. 

As you know, our office policy is to add a 4% surcharge to all outstanding 
balances after 60 days. The total for these surcharges on your account is 
$8.70; thus, your new balance is $226.20, which is payable immediately. If 
you have any questions, please feel free to call my office at your earliest 
convenience. 

Sincerely, 

Dr. Albert Tanner 
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2. To make the letter look a bit more professional, add a 
letterhead to the top. You can create a letterhead in MacPaint or 
MacDraw with large fonts; many of these fonts are available from 
commercial manufacturers. 

«data Delinquent 60» 

Dr. ALbert Tanner 
t 4· Donner Square 

ALlston, :M-A 02128 

«set date=?Enter today·s date: » 

«first name»« last name» 
«address» 
«City», «State» «Zip» 

Oear «first name»: 

«date» 

Our records indicate that you have not paid the balance on your account, 
«amount», due over 60 days ago on «orig not ice». We reminded you over 30 
days ago on «30-day», but have not heard from you yet. 

As you know, our office policy is to add a 4% surcharge to all outstanding 
balances after 60 days. The tota l for these surcharges on your account is 
«surcharges»; thus, your new balance is «total due», which is payable 
Immediately. If you have any questions, please feel free to ca l l my office at 
your earl iest convenience. 

Sincerely, 

Dr. Albert Tanner 

Figure 13-1. --------- ----------------­
Main document for form letter 
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Copy the letterhead to the Clipboard, quit MacPaint or MacDraw, 
run Word again, and paste the letterhead into the main document. 

3. The patient database has more than two dozen fields, many 
that are not useful for this letter (such as denture type). Thus, you 
should make a subset of the database with only the fields that 
relate to the letter. Since this mailing is only for patients who have 
been sent a 30-day notice, you can simply select all records in 
which the field called "30-day" has a date that is more than 30 days 
ago: 

You should also sort the selected records by last name so they are 
easy to match with the envelopes that you will be printing: 

4. Create a form for these records. Since you are using this 
database only as input to Word, you can use the simple List Helper 
form. The subset database's form contains the fields shown in 
Table 13-1. Hide the other fields; then select Save Records from 
the File menu . Click the Text (Microsoft Print Merge) button in the 
dialog box, and name the file "Delinquent 60". Click the Save 
button to create the text-only file. Quit File and run Word again. 

5. Open the main document and select Print Merge from the 
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Table 13-1. 

Fields in the "Delinquent 60" Database - --------------- --

Field 

fil e # 
f irst name 
last name 
address 
city 
state 
zip 
orig notice 
30-day 
60-day 
amount 
surcharges 
total due 

Type 

Number 
Text 
Text 
Text 
Text 
Text 
Text 
Date 
Dat e 
Date 
Number 
Number 
Number 

Contents 

File identification number 

Date of original notice 
Date of 30-day notice 
Date of 60-day notice 
Amount owed in dollars 
Late fees (calculated from" amount") 
Sum of" amount" and "surcharges" 

File menu. The SET instruction will cause Word to prompt 

Enter today·s date: t OK D 
(Cancel) 

Type in today's date. Wo rd wi ll print each of the letters. 
6. You can use the same datafileto print names and addresses 

on the envelopes. Create a simple main document: 

«date Dellnquent 60» 

«first name» « lest nome» 
«address» 
« CitY>> , « S l Bl8 >> 

<> 

Select Print Merge again, but be sure to click the Cut Sheet button 
so that Word pauses between e nvelopes. 
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_______________ Appendixes 

The following two appendixes show you how the Microsoft 
products re late to the rest of the Macintosh world. Appendix 

A shows you how to manage your Microsoft disks and set up your 
applications with various Macintosh configurat ions. Appendix B 
covers many oft he other Macintosh applications that can use data 
from, or produce data for, the M icrosoft applications. 
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------------- Hints for Using 
the Microsoft Applications 

You can use a number of" housekeep; ng" p rocedu resto make [ 1111 ~ 
working with the Microsoft applications easier and more _ 

efficient. This appendix discusses these and suggests various ways 
M.acintosh you can use the applications if you have a nonstandard Macintosh 

setup. 

Backing Up Programs 
An important way of averting disaster on your Macintosh is to 
back up (make copies of) your disks regularly. Your Macintosh Micr-osoft Wor-d 
may crash (fail to work) despite your best precautions. If you make 
regular copies of your data and program disks, a crash will cause 
only limited damage. 

Almost every computer professional stresses the importance 
of regularly copying data onto another disk, known as a backup 
disk. The disk should be stored in a safe location. Safety is, of 
course, relative; if your office floods or burns down when your 
backup disk is in the office, it obviously won't be of much help to 
you. However, for most situations, simply backing up your files is 
an adequate precaution. 

If you use a hard disk with your Macintosh, it is especially 
important to back up the datafiles on it. Hard disks are known to 
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crash more often than floppy disks, usually making all of the data 
disk unreadable. If you use a hard disk, remember to back up your 
data often. 

You must decide what files you need to back up and how often 
you should copy them. These decisions are fairly simple: back up 
every file at least once, and back up every file that changes as 
often as you can afford the time to do so. 

Backing Up Data Disks 

Backing up your data is easy. In the Finder, simply copy all of your 
datafiles from your data disks to your backup disks. (You do not 
need to keep old backup copies .of data once you make new 
copies.) For instance, if you have a data disk that contains all of 
your File databases, you can simply copy all the files from that disk 
to your backup disk by dragging the data disk's icon to the backup 
disk's icon. When the Finder asks, 

OK 

Replace items with the same names 
with the selected Items? 

( Cancel J 

cl ick the OK button, since you can safely replace the old backup 
fil es with the new ones. 

Backing up from a hard disk is not as easy as from a floppy disk. 
In the Finder, you need to select files for backing up that wi ll fit on 
the destination floppy disk. This means that you cannot select 
more than 400K of files at a time when you copy onto a floppy 
disk. Some hard disks come with sophisticated backup programs; 
other hard-disk backup programs are available from software 
manufacturers. 

Backing Up 
The Microsoft Applications 

Most of the software you buy or that comes with your Macintosh is 
on diskette. Since diskettes wear out or become damaged, you 
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should always make a complete copy of each original diskette (the 
master} before you use the software. You should then store the 
master in a safe place and use the copy. If your working copy 
should later become unreadable because of wear or mishandling, 
you can simply copy the master again. 

Some software manufacturers, including Microsoft, prevent 
you from completely copying your master disks. These disks con­
tain special instructions that the Finder cannot copy. When you 
run one of t hese applications, the program looks for the special 
instructions on the disk; if it does not find t hem, it will not run. If 
your master copy is ever lost, destroyed, o r damaged, you wi ll not 
be able to ru n the program. 

Microsoft recommends that you copy all of the files from your 
master disks by dragging their icons to other d isks. You can then 
run the applications from t he other disks; however, the first time 
you run the application afte r turning on your Macintos h, you 
must insert your master diskette in the internal drive so that the 
program can check that you indeed have a master disk. Since all 
diskettes fail at some time, this situation is hardly desirable. 

You can also obtain programs that all ow you to make copies of 
copy-protected software like the Microsoft applicatio ns. With 
such a program, you can make a runnable copy of your master 
disks. One popular disk-copying program is Copy II Mac from 
Central Point Software, w hi ch backs up all of the Microsoft appli­
cations as well as many other programs. 

Of course, you shou ld not use one of these programs to make 
copies of software that otherwise might be sold. That is illegal, in 
the same way that it is illegal to copy a book on a photocopier 
instead of buying it in a store. It is legal, however, to make archival 
copies of your software to protect against your original disk 
becoming unusable. 

Managing the Clipboard 
And Scrapbook 

If you use o nly one system disk on your Macintosh, the Clipboard 
and Scrapbook fi les wi ll always remain on that disk. Most people, 
however, use different system disks for the different programs 
they ru n. W hen you switch system disks, the Finder copies the 

rn 
~ 

Clipboard File 

rn 
~ 

Scr apbook Fi1e 
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Diskette 

Clipboard file (but not the Scrapbook fil e ) from system disk to 
system disk. You do not need to copy the C lipboard fil e when you 
switch disks. 

There are many times whe n you want the Scrapbook file to 
move with you when you switch disks. For example, you may have 
o ne system disk for C hart and one for Word. If you create a few 
charts that you want to include in a Word document, you would 
save them in the Scrapbook. When you switch system disks, 
however, your Macintosh will access t he Scrapbook o n the Word 
system disk, not on the Chart disk. 

To make a Scrapbook file from a different disk ava ilable to you, 
you must copy it from the first system disk to the second. To do 
this, simply drag the ico n for the Scrapbook file from one disk to 
another, just as you would for any other fil e. 

Some people li ke to keep many scrapbooks on one disk, 
alt hou gh there is little use for this. Since each disk can have o nly 
o ne file with the n ame "Scrapbook Fil e", copy the Scrapbook fil e 
and give the copy another name (such as "Old Scrapbook"). To 
use that fil e as the Scrapbook again, simply delete the curre nt 
Scrapbook file and rename the one you want to use "Scrapbook 
File". 

Hard Disks 
The Microsoft applications work fairly well with hard disks. Since 
the Macintosh treats hard d isks as if they were large floppy disks, 
you can copy any of theM icrosoft applicatio ns onto them and ru n 
your programs from them. 

The main advantages of using a hard d isk with the Microsoft 
applications are that hard disks hold much more data and are 
faster than floppy disks. Most hard disks ho ld 5 or 10 megabytes, 
which is 12 to 25 times more than a single floppy disk. Starting 
Microsoft File from a floppy disk takes almost 30 seconds, while 
startin g from a hard disk takes about 15. Search ing t hrough a lo ng 
Word document with the Find command takes about one-fourth 
the normal time on a hard disk. 

When you use Microsoft app licatio ns on a hard disk, simply 
copy the fil es to the new disk. When you run your applications 
from this disk, you will still have to insert the master disk in the 
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internal floppy drive so the program can check that you have a 
master disk. 

Integrating With the MiniFinder 
And the Switcher 

Version 4 of the Macintosh Finder includes two features that help 
speed up your work, the Minifinder and the Switcher. Both of 
these features make moving between the Microsoft applications 
easier and quicker since you do not have to go through the Finder 
each time you leave an application. 

Using the Minifinder 

The Minifinder is used instead of the finder to move between 
applications. If you have a hard disk, theMinifinder is very useful 
because you can specify all four Microsoft applications in its 
selection window. Even if you are using floppy disks, the Mini­
Finder can be useful if you install it on each program disk. 

When you set up the Minifinder on a hard disk, you will 
probably want to include all of the Microsoft applications and 
MacPaint. If you are using MacDraw or other programs with the 
Microsoft applications, you should include them as well. 

On a Macintosh with no hard disk, install the Minifinder on 
each of your Microsoft program disks. When you want to switch 
from one application to another, simply click the Eject button in 
the Minifinder and insert the new disk. 

Using the Switcher 

The Switcher is different from theMinifinder in that it allows you 
to run many programs at the same time. With the Switcher you do 
not need to exi t from one program in order to run another one. 
For example, you can run Word and Chart at the same time; when 
you want to put a drawing in your Word document, you simply 
save it to the Clipboard, switch over to Word, and give the Paste 
command. 

The Switcher requires at least512K of RAM. When you start the 

n 
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MiniFind(>r 
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Switcher 
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Switcher, you can install up to four applications to switch 
between. For instance, you might install Word, Mu ltiplan, and 
Chart if you are writing a report that will require tables from 
Multiplan and drawings from Chart. 

While an application is running without the Switcher, t he 
information that the application stores on the Clipboard is in a 
format that only the application knows how to use. When you quit 
from the application, it converts whatever is on the Clipboard to a 
general format (such as to a MacPaint-like pictu re or to text with 
tabs between columns). However, ifyou arerunningtheSwitcher, 
you never "quit" the application; you simply switch to another 
one while the first one is still running. If you want to use informa­
tion that the first program put on the Clipboard, the contents of 
the Clipboard must be converted to the general format. You can 
do this in two ways: 

• You can press the OPTION key as you switch, which causes the 
Clipboard to be converted when you move between appli­
cations. 

• You can set a Switcher option to always convert the Clip­
board when you switch between applications. Th is is a bit 
slower than converting on demand, but you don't have to 
remember to convert when you need to. 

Generally, you will use the Always Convert option, which is set 
with the Options command in the Switcher menu. 
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Integrating 
With Other Programs 

Throughout this book you have 
seen how the Microsoft appli- Microsoft 'w'ord Multiplan Microsoft File 

cations can transfer data between ~ 

each other with the Clipboard and ~ 

text-only files. Many other Macin- Micr osoft Chart 

? 

tosh programs can produce and use this data, and they may 
have capabilities not included in Word, Chart, File, or Multi­
plan. If you use non-Microsoft programs on your Macintosh, 
you should investigate the possibility of integrating them with 
the Microsoft applications. 

This appendix discusses some of the programs that you may 
want to use with your Microsoft applications. Of course, new 
programs are produced every day, so this list will never be 
complete. You should use this list as a guide to some of the 
types of software in which you might be interested. However, 
keep in mind that not all software can read data from other 
programs. Some excellent packages, such as the Filevision data­
base manager, cannot read data generated by other programs 
and cannot produce files that other programs can use . Before 
you buy a package, be sure that it can produce or read data 
from your Microsoft applications. 
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Integrated Software 
Packages 

An integrated software package is a set of programs that per­
forms many functions without requiring you to switch from 
program to program. Although it is easy to transfer information 
among Microsoft Multiplan, Word, Chart, and File, they are 
considered stand-alone programs, not an integrated software 
package. However, many integrated packages included some of 
the basic features of Multiplan, Word, Chart, and File. 

Each program in an integrated package usually does not 
offer as many features as a stand-alone program. For instance, 
the charting portion of Jazz does not have as many features as 
Microsoft Chart. The tradeoff, then, is quantity of features for 
convenience. Integrated packages also usually cost less than the 
combination of Microsoft applications. 

Excel 

Microsoft's first integrated package, Excel, incorporates a spread­
sheet, a small file manager, and a graphics package. These are 
the same three functions provided in Lotus 1-2-3, which was the 
first successful integrated package for the IBM PC. 

Excel gives the user a medium amount of processing power 
for a low price. Excel's spreadsheet is simpler than Multiplan, 
and the database is less powerful than File; however, the draw­
ing portion is nearly as complete as Chart. Excel is meant to be 
a cost-effective application for people who would probably 
never buy the entire set of Microsoft applications. 

Since it is a Microsoft product, Excel can communicate with 
Word, Multiplan, Chart, and File quite easily. The spreadsheet 
portion can save files as text-only and can read data from the 
Clipboard. The database portion can also save and read text­
only files as well as use the Clipboard for data. The drawing 
program can save output to the Clipboard just as Chart can. 

Jazz 

One of the most advanced integrated packages is Jazz from 
Lotus Development Corp. Like the Microsoft applications, Jazz 
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is based around its word processor. It also includes a spread­
sheet, database system, chart maker, and telecommunications 
application. 

With Jazz, not only can you cut and paste information from 
one program to another, but a HotView feature also allows you 
to link the data used in the various parts of the program so that 
when you update the original data it is also changed in any 
other documents that are based on it. For example, assume you 
are writing a document that incorporates a chart based on 
spreadsheet data. If you change the data in the spreadsheet, the 
chart in the word processing document is updated. This means 
you don't have to go through the procedure of making a new 
chart and copying it into a word processing document each 
time you change your spreadsheet. 

Jazz can read data from all four Microsoft applications 
through the Clipboard. The jazz spreadsheet can also read 
SYLK fi les from Chart or Mu ltiplan, and the word processor can 
read text-only files from Word. jazz can also transfer data from 
some of the M icrosoft applications on the IBM PC. 

Database Management 
Systems 

Many Macintosh database products on the market have fea­
tures that make them more suitable for some business uses than 
File. Some of them can give you more flexibility in data report­
ing and can relate the information in one database with the 
information in a different database. Just like Fi le, most can read 
data from, and write data to, the C lipboard, so they can be used 
with Word, Multiplan, and Chart. There are more than a dozen 
database managers avai lable for the Macintosh; only a few are 
mentioned here to give you a flavor of the types of features you 
can expect to find in them. 

OverVUE from ProVUE Development Corp. is a relational 
database system that also includes a small subset of Chart. You 
can use OverVUE to analyze your database without having to 
leave the program. It also has an advanced macro capability 
that lets you specify a set of commands (such as sorting, search­
ing, and reporting) to be performed in a single step. It can read 
File data and write data to the Clipboard for use in the Micro-
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soft applications. 
Odesta's Helix is a user-friendly system whose features are 

often only found on advanced systems. The entire program is 
icon-oriented, so beginning database users who are familiar 
only with the Macintosh interface can use it easily. It can read 
and save data through the Clipboard. 

Programming Languages 
You can overcome some of the limitations of File and Multiplan 
by writing programs that manipulate the data produced by the 
other Microsoft applications. For example, assume that you 
have two fields in a File database, one for the ZIP code and one 
for the state. You cannot cause File to change the value of the 
state field in a record based on the value of the ZIP code field, 
even though you can determine the state from the ZIP code. 
However, you can write a program to read a File text-only data­
base and change the fields accordingly. 

Many people assume that it is necessary to learn a pro­
gramming language in order to use a computer effectively. This 
is not true. You should only learn a programming language if 
you need an unusual program; even then, you will probably 
find that such a program already exists. If no such program is 
available, you can always hire someone to write it for you. 

The more you use the Microsoft applications, the more you 
will think of features that you wish had been built into them. 
Some programming languages can give you these capabilities in 
a limited fashion by manipulating data that is in text-only files 
or in the Clipboard. For example, you may want to be able to 

• Change File fields based on other fields in the record 

• Perform a calculation on records in a File database (such as 
adding 10 percent to a numeric field) 

• Use scientific calculations that are not available in a Multi­
plan spreadsheet 

• Determine the number of words in a Word document. 

There are dozens of programming languages, although 
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many are only minor variations on others; only a dozen of 
them are understood by more than a few programmers. Most 
of these popular languages have been translated to the Macin­
tosh. Recently, some programming languages that run only on 
the Macintosh have been developed. 

The following list gives you a brief overview of the pro­
gramming languages available. Many others will be written as 
the Macintosh becomes more popular. 

• Pascal-Apple's first supported language on the Macin­
tosh was Macintosh Pascal. Apple felt that it was better for 
beginning users to learn a structured language like Pascal 
than to learn BASIC. Pascal has been adopted as Apple's 
preferred language on all of their computers, and it is 
being taught in many introductory computer courses in 
colleges. SofTech Microsystems also produces a Pascal 
compiler. 

• BASIC-BASIC is one of the most popular languages 
because it is easy to learn. Many computer professionals 
turn up their noses at BASIC, but it is a good way to learn 
some of the concepts behind programming. Microsoft's 
BASIC has many features of Pascal and can be used to read 
and write data in the Clipboard. 

• FORTRAN -Many scientific laboratories use FORTRAN 
for all of their computations. MacFortran from Absoft is a 
full implementation of FORTRAN 77, the latest standard 
version of the language. It includes many handy features, 
such as the ability to create your own applications that can 
be run from the Finder and the ability to use the Macin­
tosh's standard windows and menus. 

• COBOL-Although COBOL is not as popular as it was 15 
years ago, it is still used by many programmers. Mac­
COBOL from Micro Focus incorporates many of the fea­
tures of mainframe COBOLs as well as using the standard 
Macintosh interface. 

• C-The C programming language is the most popular 
language for Macintosh applications development. Al­
though learning C is not as easy as learning BASIC or Pas-
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cal, it is more powerful for the advanced program mer. If 
you are a beginning C user, the Hippo-C Level 1 from 
Hippopotamus Software is an excell ent way to learn the 
language without worrying about the intricaci es. Th ere 
are many full-functioned C compilers available, including 
those from Manx, Consulair, Hippopotamus, and MegaMax. 

• Modula-2-Aithough it is simil ar to Pascal, Modula-2 has 
many features that makes it more powe rful for advanced 
programmers. It was designed by the same person who 
originally designed Pasca l, an d many of Pascal's inconsis­
tencies have been successfully redesigned. 

• Forth -MacForth fro m Creative Solutions was o ne of the 
first languages available for Macintosh development. The 
Forth langu age is best suited for creating compact pro­
grams that run quickly. Most people find it hard to learn, 
although its ad herents claim that it is the most simple lan­
guage available. 

• Lisp-Most of the artificial intelligence programs that are 
being produced in the United States are written in Lisp. 
Like Forth, it is often hard for beginners to learn, altho ugh 
the und erlying structure of the language makes it very 
useful for applicatio ns that handle lists. Experlisp from 
Expertelligence is a good learning e nvironment for the 
Lisp language. 

• Neon - This new language, from Kriya Systems, is the first 
language that is available only o n the Macintosh. Neon is 
different from many programming languages because it 
uses data as "objects" that the program moves around; 
this makes programming in Neon more intuitive than lan­
guages in w hich you have to guess how the computer wi ll 
handle your data. 

Other Programs 

There a re hundreds o f programs for the Macintosh that are not 
listed here. You can find advertisements and reviews of many 
programs in magazines such as M acWor/d, A+ , and Macazine. 
Some of these Macintosh products work directly with th e 
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Microsoft applications and enhance their usefulness. 
Several of the Macintosh spelling programs work with doc­

uments created by Word. A spelling checker examines each 
word in your text file, looks up the words in its dictionary, and 
tells you which ones it does not recognize. It then lets you 
decide if you misspelled the words or if the program is just not 
familiar with them (for instance, acronyms and proper names). 
Since most of these programs are used primarily with MacWrite 
files, check whether a program works with Word before you 
buy it. 

If you invest in stocks or bonds, you can get current infor­
mation on your holdings with a modem and the Dow Jones 
News/Retrieval Service. If you use Dow Jones' telecommunica­
tions software, Straight Talk, you can also use its Spreadsheet 
Link package to read data from the service directly into Multi­
plan spreadsheets. Spreadsheet Link relieves you of having to 
give commands to read the latest data every time you dial into 
the service. The program will automatically update any of your 
Multiplan spreadsheets with data from the service. 



Trademarks---------------

The following italicized names are trademarked products of the 
corresponding companies: 

Apple Apple Computer, Inc. 

ClickArt T / Maker 

Copy II Mac Central Point software 

Dow }ones News/ Retrieval Dow Jones and Company, Inc. 

Excel Microsoft 

ExerLisp Expertelligence 

FileVision Telos 

Finder Apple Computer, Inc. 

Helix Odesta 

jazz Lotus Development Corporation 

Mac the Knife Miles Computing 

MacCobol M icro Focus 

MacDraw Apple Computer, Inc. 

Macforth Creative Solutions 

Macfortran Absoft 

Macintosh licensed to Apple Computer, Inc. 

MacPaint Apple Computer, Inc. 

MacWrite Apple Computer, Inc. 

M icrosoh Microsoft 

Multiplan Microsoft 

Neon Kriya Systems 

1-2-3 Lotus Development Corporation 

OverVUE ProVUE Development Corporation 

Spreadsheet Link Dow Jones and Company, Inc. 

Straight Talk Dow Jones and Company, Inc. 
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Integrating functions of Word, Multiplan, 
File, and Chart examples, 126-87 

LOOKUP function, 55 
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MacDraw 
adding text, 112 
cleaning up drawings, 113-15 
creating borders, 115-17 
enhancing text, 120-22 
features, 109-11 
moving formatted text to, 120 
transferring data from Chart to, 

111-12 
MacPaint 

adding text, 112 
cleaning up drawings, 113-15 
creating borders, 115-17 
enhancing tables, 117-19 
enhancing text, 120-22 
moving formatted text to, 120 
transferring data from Chart to, 

111-12 
Microsoft applications 

commands, 13 
hardware requirements, x 
use of programming languages with, 

202-03 
with hard disks, 194-95 

Multiplan 
creating new databases, 65 
creating records for File from, 64 
features, 8-9, 49 
modifying existing databases, 65-66 
spreadsheets, 50-52 
summarizing data, 52-56 
transferring data to Word from, 67 
transferring arrays to Chart from, 

60-64 
transferring rows or columns to 

Chart from, 56-60 

NEXT instruction, 40-41 

OR function, 55 

Paste command, 17 
Programming languages 

BASIC, 203 
c, 203-04 
Cobol, 203 
Forth, 204 
FORTRAN, 203 
Lisp, 204 
Modu la-2, 204 
Neon, 204 
Pascal, 203 

Scrapbook, the 
defined, 15-16 
filing, 19 
merging Chart and Word with, 43-44 
use, 16-18 

Selection commands, 12 
SET instruction, 40 
Standard user interface, 4-5 
Switcher, the, 195-96 

Text-only files 
defined, 6, 19 
format, 20-22 
when to use, 20 

Word 
creating glossaries, 30 
creating multi-columns, 30-31 
creating tables, 28-30 
features, 7-8, 26 
formatting tables from File and 

Multiplan, 44-45 
further applications, 41-42 
integrating other files, 37-39 



Word, continued 
mailmerge, 31-33 
merge instructions, 39-41 
multi-file editing, 28 
setting up a datafile, 33-37 
setting up a letter, 33 
split-screen editing, 26-27 
transferring data from, 45-47 
transferring drawings from Chart, 

42-44 
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MACINTOSH™ PAPERWORK . 
INTEGRATING MICROSOFT® PRODUCTS 

With your Macintosh™ computer and two or more software packages from Microsoft~ 
you can control a powerful integrated system that handles all your paperwork. 
Paul Hoffman, author ofthe bestselling Microsoft® Word Made Easy-Mocintosh!M 
Edition, shows you how to combine Microsoft® Word, Multiplan;"' Chart and File with 
Apple's MacPaintTM and Mac Draw™ to produce: 

• Sales reports 
• Laboratory results 
• Graphics presentations 
• Market research analysis 
• And more! 

This book also shows you how to integrate Microsoft applications with Jazz~' and 
several programming languages. Easy-to-follow instructions quickly show you how 
to integrate all this software: text to tables to figures to graphs. Then you 'll learn how 
to use it in ways you've never before imagined. Seven complex projects, each using 
three or more software products, illustrate practical and innovative business uses. 

For gr~ater office productivity, stop pushing papers and let Mocintosh'M Paperwork 
pull it all together! 

• Macintosh, MocPaintand MacDraw ore trademarks of Apple Computer, Inc. 
• Microsoft is a registered trademark of Microsoft Corp. 
• Multiplan is a trademark of Microsoft Corp. 
• Jazz is a trademark of lotus Development Corp. 

ISBN 0-07-881191 -; 0 




